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Chapter 1

Welcome to the KDE User
Guide

This User Guide aims to provide an overview of the entire KDE experience. We
assume here that you have a standard, working installation of a complete KDE
desktop environment, and the accompanying packages. This book should be
your first point of reference for any simple KDE configuration question, or to
find out how to perform a common task.

1.1 What this book aims to be

The first place to look and a one stop shop for all questions you have regarding
your KDE experience.

A Quick Start Guide to commonly performed tasks - In most cases, you do not
need to know the details of how to configure every option in an application, in
order to get down to work. You will find step-by-step guides which will work
in most common situations, along with links to sources of further information
in case you have any problems.

There are also some tips and tricks showing you the most useful and impres-
sive features of KDE, and ways to save you time and effort.

1.2 What this book is not

The User Guide is not intended to be a replacement for the application man-
uals. You should turn to the handbook for help with specific program config-
uration and troubleshooting issues not covered in this book. If the answer is
outside the scope of this book, we will tell you here precisely where to look for
further help.
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You may also have a variety of third party packages, and some of these applica-
tions are mentioned briefly here, but we normally cover only the applications
provided as part of a KDE release. This is not a judgment on the value of third
party applications, and in fact many of them are excellent.

The User Guide is not specific to a distribution, and covers a default KDE
installation. Your local installation may be customized by your distribution
provider, or by yourself, and so our advice here is generic. You may have to
adjust paths in order to locate the files that are discussed.

1.3 Conventions used in this book

We’ll use the following formatting conventions to make it clear what we’re
referring to:

Type of Text Style Example
Text appearing in the
GUI (on buttons, etc.)

Light gray
background Settings

Names of keys Bold font Ctrl

Menu entries ‘Menu
Name’->‘Menu Item’ File→Quit

Key combinations
(pressed
simultaneously)

‘Modifier
Key’+‘Action Key’ Ctrl+Q

Text you should enter Bold, fixed width font ls -al kde/
Text you should
replace as appropriate Italic green font user

1.4 System Locations

You may need to know the following system locations:

KDE prefix KDE installs into its own folder tree, which you can find by run-
ning the command kde4-config --prefix. This folder is referred to
by the environment variables $KDEDIRS and possibly $KDEDIR.

KDE user-specific settings The environment variable $KDEHOME points to the
folder where KDE should find user-specific settings. If it is not set, the
default value of /.kde is used.
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1.5 Overview, or ‘Where to look in the User Guide’

Here’s an overview of what’s in the User Guide:
Part II contains an introduction to the basic use of KDE, such as Section 2.3,
and the tools that you’ll be using in all KDE applications, like Section 4.3. If
you’re new to KDE or even computers in general, you will probably find this
section helpful.

Part III explains some important components of a KDE installation and how
they fit together: KDE’s multimedia and networking capabilities are extensive,
and not covered thoroughly here, but there’s a taster of both of them in this
part of the User Guide. At the end of this part, you’ll find a guide to tweaking
KDE just that little bit more, in chapter 16.

Part IV highlights KDE’s suite of Internet applications. KDE includes a power-
ful web browser, Konqueror, a full-featured email client, KMail, a news reader,
KNode, and many more applications to make your Internet experience easier
and more productive. This part of the User Guide contains information about
setting up these applications.

Part VI is a reference guide to some KDE features which will be useful to ad-
ministrators setting up multi-user systems. This part also has information that
may be useful to KDE users with single-user systems: where configuration
files are stored, what environment variables affect KDE, and so on. The KIOSK
framework is the KDE system which allows administrators to limit what users
can do in KDE. It is potentially useful in many situations, but especially for
running single-function kiosks with, for example, just a web browser, hence
the name.
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Part II

The Desktop
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Chapter 2

The Basics

The ‘desktop’ is just the name for the layout of the screen when you start KDE.
It looks something like this (on your own system, it might look slightly differ-
ent, but the main features should be the same):

Let us look at the most important parts:

• Most of the screen is taken up by the background. At the moment, there is a
picture making up the background. This picture is usually referred to as the
‘wallpaper,’ and you can change it to make KDE suit your taste.
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• In the top left-hand corner are two icons: Trash and Home. Clicking on
these will open your Trash folder and Home folder, respectively. You can
add more icons to the desktop so that you can open your favorite programs,
or access removable media, with just one click.

• At the bottom is the KDE Panel, also known as ‘Kicker’. The Panel con-
tains several useful ways of interacting with KDE. It houses the K menu,
from where you can open any KDE application installed on your computer,
it shows all the programs that are currently running, as well as the time, and
more. Take a look at chapter 3 for more information about the KDE Panel.

2.1 Logging In and Logging Out

Basic KDM & startkde stuff.
There are two ways to log into KDE: graphically and via the command line.
We’ll look at them both briefly:

2.1.1 Logging in Graphically

If you see a screen a little bit like the one below when you start up your com-
puter, then you are all set for logging in graphically. Just enter your username
in the Login text box and your password in the Password text box. Your pass-
word will not be shown as you type it; it will probably be shown as asterisks.
When you have entered that information, click on the Login button, and KDE
will start up. The KDE splash screen will appear, and keep you informed about
the progress of KDE startup, and when it is done, KDE will be ready to use.

2.1.2 Logging in via the Command Line

If you prefer using the command line, you can log in to KDE with the startx
command. Add the line exec startkde to the .xinitrc file in your home
folder (create it if it does not exist), save the file, and then run startx. KDE
should start in the same way as if you had logged in graphically.

2.1.3 Logging Out

Once you have finished using KDE for the moment, you will want to log out
until next time. The easiest way to do this is to click on the K menu at the
bottom left of your screen, and then select the Log Out... item. A dialog with
the text End session for username will appear. To confirm that you want to log
out, click on the End Current Session button. If you change your mind, and
decide to carry on using KDE for now, hit Cancel.

RELATED INFORMATION
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• The kdm Handbook has information about using and setting up the KDE
graphical login manager. You can read it in KHelpCenter or by entering
help:/kdm in Konqueror’s Location bar.

2.2 Getting Help

2.2.1 User Manuals

Most applications come with a comprehensive user manual, which you can
reach various ways:

• By pressing F1 inside the application.

• From the menu bar: Help→ Application name

• By browsing to it in KHelpCenter

• By using the help KIOslave in Konqueror. So, in the Location Toolbar, simply
type help:/Application name

• Online at http://docs.kde.org

2.2.2 Context and ‘What’s This’ Help

Many applications also provide context help in two forms: Tooltips, and ‘What’s
This’ help.

2.2.2.1 Tooltips

Tooltips are small informational windows or balloons that display when you
hover the mouse over an item on your screen without clicking.

KDE uses tooltips in many places to provide brief help or information about
an item on your screen. For instance, most toolbar buttons inside applications
will display their name in a tooltip if you rest or hover your mouse over them.

Tooltips have another function, which is not specifically tied to help. In the
Konqueror file manager and on your Desktop, tooltips can provide information
about files. This is commonly referred to as ‘meta information’.

You can find out more about meta-information tooltips in the section about the
Konqueror file manager.
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2.2.2.2 ‘What’s This?’

‘What’s This?’ help is usually more detailed than tooltips. You can access
‘What’s This?’ help in two ways:

• By pressing the ? button in the titlebar of the window.

• By pressing the key combination Shift-F1

The cursor will change to a pointer with a question mark next to it. Click on
the item you want to know about, and a small window will pop up displaying
information.

2.2.3 Mailing Lists, Newsgroups and IRC

2.2.3.1 Mailing Lists

KDE provides many mailing lists which can provide you with help and guid-
ance in using and configuring your Desktop.

Some of the lists you might find useful are:

The KDE User List This mailing list focuses specifically on OS-independent
questions and discussions regarding using KDE. Operating-system-specific
questions and discussion are off-topic here. For example, the question
‘How do I change the margin size for KWord documents’ is appropri-
ate for this list; whereas ‘How do I set up my printer using KDE under
UnixOS X.Y’ is not. Questions asked and discussions here should apply
to all KDE users using the applicable KDE software, not just those using
the same operating system.
You can subscribe to this list at https://mail.kde.org/mailman/listinfo/-
kde.
You can find archives at http://lists.kde.org/?l=kde.

The KDE-Linux R© List This mailing list focusses specifically on questions and
discussions regarding using KDE on Linux R©. Questions and discus-
sions can involve any issue confronting desktop users who run KDE on a
Linux R© system. Hence, questions such as ‘How do I setup a networked
printer for printing from KDE on LinuxDistro X.Y’ are appropriate here.
If you prefer a list limited to OS-independent questions and discussions
concerning KDE, please use the general KDE mailing list.
You can subscribe to this list at https://mail.kde.org/mailman/listinfo/-
kde-linux.
You can find archives at http://lists.kde.org/?l=kde-linux.
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2.2.3.2 IRC

There is a #kde channel on Freenode (irc.freenode.net) for support and other
general talk about KDE. As usual, you can access this channel by using any
of KDE’s popular IRC clients which include konversation, KSirc, as well as
Kopete. For more information, check the Section 21.3 section.

2.2.4 More Resources

There are many other resources which you may found useful; some of these
are listed below:

dot.kde.org This website has a searchable KDE news resource where you can
find out about a superfluity of innovations in the world of KDE.

kde-look.org The paramount resource for KDE icandy, including themes, win-
dow decorations, wallpapers, mouse themes and icons for your KDE
desktop. Note also that the site contains a howto section on how to install
the most common of these.

wiki.kde.org The official KDE Wiki. From here you can have access to a
plethora of information ranging from frequently asked questions and
HOWTOs to tips and tricks. The wiki should never, however, be used
as a substitute for the respective application’s handbook or the official
KDE documentation.

2.3 Windows, How To Work Them

2.3.1 Basic Window Management

Each application running in KDE has its own window, and some applications
may use more than one window. You can manipulate these windows in many
ways to make your desktop work for you. Here is a normal window:
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2.3.1.1 Switching Between Windows

If you want to use a window, it must be active. A window automatically be-
comes active when you open it, so that the application you opened is imme-
diately ready to use. Only one window can be active at a time. The active
window is the one into which you can type, and can be distinguished from the
others because it has a different colored titlebar. (With the KDE default theme,
the active window has a light blue titlebar, and the inactive windows have
gray titlebars.)

When you want to work in a different window, you need to make it active.
There are two ways to do this:

• left mouse button-click on the window that you want to make active. The
window will become active and will be raised above other windows if it
overlaps them.

• Hold down Alt and press Tab (do not release the Alt key). A popup dialog
appears with a list of available windows, one of which is highlighted. You
can select a different window by pressing Tab again to move through the list,
all the time holding down Alt. When you release the Alt key, the window
which was highlighted is made active.

2.3.1.2 Moving Windows

The first way to organize the windows on your desktop is to move them around.
You can move windows so that they overlap other windows, or so that you can
see the whole window. There are three ways to move a window:
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• Click the left mouse button on the window titlebar and hold it down. Move
the mouse cursor and the window moves with it. Release the mouse button,
and the window remains where you left it.

• Open the window menu using the leftmost button on the window titlebar (as
displayed below), and select Move. The mouse cursor moves to the center
of the current window and by moving the mouse around, you can move the
window. Once you have moved the window to the position you want, click

the left mouse button to release it.

• Hold down Alt and the left mouse button when the mouse cursor is above
the window you want to move. The mouse cursor changes to a compass, and
by moving the mouse, you can move the window. Just release the mouse but-
ton to release the window. This method is particularly useful if the window
titlebar has been moved off the screen, so you cannot use the other methods.

2.3.1.3 Resizing Windows

You can make windows bigger or smaller, wider, or taller in one of two ways.
Just use whichever you are most comfortable with:

• Move the mouse cursor over the border of the window (it is light blue in the
screenshot above). The pointer will turn into a double-headed arrow. Click
and drag, and the edge of the window follows the mouse cursor, making the
window bigger or smaller. If you click on the borders on the top or bottom of
the window, you can adjust the height on its own. If you click on the borders
on the left or right of the window, you can adjust the width. To change both
at the same time, move the mouse cursor over the corner of the window.
When the pointer becomes a diagonal double-headed arrow, click and drag.
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• Use the leftmost button on the window titlebar to display the window menu.
Choose the Resize entry, and the mouse pointer will become a double-headed
arrow. Move the mouse cursor around to resize, and click the left mouse but-
ton when you are done to release the window.

• If you cannot see the window border or the button for the window menu,
you can use Alt and the right mouse button: Hold down Alt and drag with
the right mouse button. The window will resize. You just release the right
mouse button when you are done.

If you just want to make a window as big as possible, so it takes up the whole
screen, use the Maximize button, which is the second button from the right on
the window titlebar. Clicking with the left mouse button on this button will
make the window as big as possible in both directions; while clicking with the
middle mouse button or the right mouse button will increase the window’s
size in only the vertical or horizontal direction, respectively.

2.3.1.4 Hiding Windows

When you need to keep a program open, but you do not want it to take up
space on your desktop, you can minimize it or shade it. To minimize a window,
click the Minimize button, which is third from the right on the window titlebar.
The window will not be displayed, but the program is still running, and an
entry for it appears in the taskbar on the panel. To display the window again,
click on its entry in the taskbar. You can also use Alt+Tab: see Section 2.3.1.1.

Shading windows is very similar to minimizing them, but this time, only the ti-
tlebar of the window is shown. To shade a window, double-click on the titlebar.
To restore the window, just double-click on the titlebar again.

2.3.1.5 Cascading Windows

Sometimes you might have a whole lot of windows open and all over the place.
By selecting to cascade windows KDE will automatically line them up as a
succession from the top-left of your screen. To use this option use your middle
mouse button on the desktop, and then select Cascade Windows.

2.3.1.6 Uncluttering Windows

By selecting to unclutter your opened windows KDE will attempt to use the
maximum available space of the desktop in order to display as much of each
window as possible. For example, should you have four windows open and
you request that they be uncluttered, they will each be placed in a corner of
the desktop, regardless of where they were originally. To use this option once
again use your middle mouse button on the desktop and then select Unclutter
Windows.
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2.3.1.7 Closing Windows

When you finish using an application, you will want to stop the application
and close its window. Once again, you have the choice of a few options:

• Click on the rightmost button on the window titlebar. If you are editing
a document with that application, you will be asked whether you want to
Save your changes, Discard them, or Cancel your command to close the ap-
plication.

• Use the File→ Quit option on the menubar. You will be presented with the
same choice of Save, Discard, or Cancel.

• Right-click on the respective window in Kicker, the KDE panel, and then
select Close. You will be prompted with an option to save any documents
that were being edited.

• Press Alt+F4 . Once again, the confirmation dialog will be shown if you were
editing any documents.

2.3.2 Advanced Window Management

kstart

2.3.2.1 kstart

The simplest way to access the advanced window management facilities in
KDE is to use a little known utility called kstart, which is included in KDE
since version 2.1 kstart lets you control the way an application interacts with
the window manager. The command is usually used to define special behavior
for commonly-used applications, but it can also be useful for integrating non-
KDE applications into your desktop.

Using kstart is easy: you simply put kstart and some options before a com-
mand. To begin, let’s look at how we might use kstart to customize the be-
haviour of a KCalc window. The command we’ll use is as follows:

% kstart --ontop --alldesktops kcalc

With luck, the effect this command has should be fairly obvious - the kcalc win-
dow will stay on top of all the others and be visible on every virtual desktop.
A feature that is less obvious is that this command will work with any NET
compliant environment, not just KDE.

We can pass arguments to programs we invoke with kstart as normal, for ex-
ample:

% kstart
--skiptaskbar --desktop
1 xmessage ’Hello World ’
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This command displays Hello World with xmessage and ensures that the win-
dow will be shown on the first virtual desktop and will be omitted from the
taskbar. The fact that this program is written using the Xt toolkit rather than
being a native KDE application does not cause any problem for kstart, hope-
fully this illustrates how kstart can be used to integrate foreign applications
into your KDE desktop.

2.3.2.2 Other Special Window Settings

While you can use kstart to assign particular window settings, KDE also al-
lows you to alter these -- as well as other similar settings -- from the program
window itself. Simply select the leftmost button in the window titlebar (or just
hit Alt+F3 once the window is focused), and then go to Advanced→ Special
Window Settings.... As you can see, from here you change various things from
its geometry upon startup, to whether it should have a border or not.

2.3.2.3 The System Tray

Now that we know how to customize the decoration of a window let’s take a
look at another aspect of the desktop: the system tray. The system tray is an
area in which an application can display a small window. It is used to display
status information or provide quick access to commands. A window that has
an item in the system tray usually disappears from the task manager when
minimised with the tray icon providing a replacement. Normally tray icons
are specifically developed as part of an application, but as with window deco-
rations, KDE provides a tool for changing this: ksystraycmd.

To begin with, we’ll take the standard application KCalc and turn it into a
system tray application. This is acheived with one simple command:

% ksystraycmd --title ’kcalc ’ kcalc

The icon shown in the tray is the one specified in the window hints and will
be updated if the icon changes. The window title is shown as a tooltip if you
hold the mouse over the icon. ksystraycmd follows standard KDE behaviour
so the target window can be shown and hidden by clicking the tray icon, and
a standard context menu is available.
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2.3.2.4 More Complex Uses of ksystraycmd

To illustrate the other features of ksystraycmd, we’ll use a more complicated
example: a Konsole window tracking the .xsession-errors file (this is the
log file that records what’s happening on your desktop). To begin with, we’ll
simply look at how we can view this:

% konsole --icon
log --caption ’X Log ’ \
--nomenubar --notabbar
--noframe \
-e tail -f ~/.xsession -errors

The --caption and --icon arguments are provided as standard by KDE appli-
cations. You can get a full list of these global options by running an application
with the --help-kde and --help-qt parameters. Here we give our Konsole
window the title ’X Log’ and the icon ‘log’. You can use these options with any
KDE application and as mentioned above, ksystraycmd takes account of these
when creating the tray icon. The -e argument is specific to Konsole and tells
it to run the less command. Despite its complexity, we can easily move this
window into the tray with ksystraycmd:

% ksystraycmd
--hidden --title ’X Log ’ \
konsole --icon log --caption ’XLog ’ \
--nomenubar --notabbar --noframe \
-e tail -f .xsession -errors

In addition to being the most complex command we’ve used, this example
demonstrates the --hidden option which starts the command with only the
system tray icon visible. This example achieves our aim of providing quick
access to the log file, but we can do things a little more efficiently if we only
run the konsole process when it is visible. The command we use is

% ksystraycmd --startonshow \
--icon log --tooltip ’X Log ’ \

konsole --icon log --caption ’X Log ’ \
--nomenubar --notabbar --noframe \
-e tail -f ~/.xsession -errors

The addition of the --startonshow parameter tells ksystraycmd to start with
only the tray icon visible (like the --hidden parameter), and to wait until the
user activates the tray icon before running the target command. We’ve also
used the --quitonhide parameter which tells ksystraycmd to terminate the
target app whenever its window is hidden. Using both these parameters en-
sures that our Konsole tray icon doesn’t waste resources when we aren’t using
it. Creating and destroying the target window as we do here prevents the stan-
dard icon and title handling of ksystraycmd from working, so we now need to
specify the initial icon and tooltip explicitly too.
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2.3.2.5 Improving Reliability

In all of our previous examples we’ve relied on kstart and ksystraycmd to fig-
ure out which window we want to affect, and unless we say otherwise, they
assume that the first window to appear is the one we want. This policy is usu-
ally OK because we are starting the application at the same time, but it can fail
badly when lots of windows are appearing (such as when you log on). To make
our commands more robust we can use the --window parameter. This specifies
the title of the target window. The following example uses the --window pa-
rameter to ensure that a particular konsole window is affected:

% kstart --iconify --window ’kstart_me ’ konsole
--caption ’kstart_me ’ -e tail -f
~/.xsession -errors

Here we’ve used the tried and tested technique of specifying a title for both
kstart and the target application. This is generally the best way to use kstart
and ksystraycmd. The --window argument is supported by both kstart and ks-
ystraycmd and can be regular expression (e.g. ‘window[0-9]’) as well as a par-
ticular title. (Regular expressions are a powerful pattern matching tool you’ll
find used throughout KDE.)

2.3.3 Using Multiple Desktops

Sometimes, one screen’s worth is just not enough space. If you use many ap-
plications at the same time, and find yourself drowning in different windows,
virtual desktops offer the solution. By default, KDE has four virtual desktops,
each one of which is like a separate screen: you can open windows, move win-
dows around, and set backgrounds and icons on each of the desktops. If you
are familiar with the concept of virtual terminals, you will have no trouble with
KDE’s virtual desktops.

2.3.3.1 Switching Virtual Desktops

To move to a different virtual desktop, you can use Ctrl+Tab in the same way as
you would use Alt+Tab to switch between windows (see Section 2.3.1.1): Hold
down Ctrl and then press Tab. A small popup window appears, showing the
virtual desktops, with one highlighted. If you release Ctrl, KDE will switch
to the highlighted virtual desktop. To select a different desktop, press Tab re-
peatedly, while holding down Ctrl. The selection moves through the available
desktops. When the desktop you want to switch to is highlighted, release Ctrl.

2.3.3.2 Windows and Virtual Desktops

You can move windows around your virtual desktops with the To Desktop
item in the window menu: just select the desktop to which you want to move
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the window. You can make the window appear on all desktops with the All
Desktops item.

2.4 The File Manager

Konqueror with simple settings

2.4.1 Introduction

KDE includes a versatile and powerful file manager called Konqueror which
allows you to do everything you want with the files stored on your computer,
your network, and even the Internet. There are too many features of Kon-
queror to describe here, so we will just take an overview. If you want more de-
tails about what Konqueror can do, take a look at the Konqueror Handbook by
selecting Help→ Konqueror Handbook in the Konqueror menus; or, alterna-
tively, you can use the help KIOslave in Konqueror by entering help:/konqueror
in the Location Toolbar.
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2.4.2 Folders

When you first open Konqueror in file management mode, you can see two
panes: on the right is the folder view; on the left is the sidebar. The folder
view contains icons for each item inside the current folder. These items can
be folders or files. Many file types can be ‘previewed’ without opening a new
application to edit them in. To preview a file, hold the mouse cursor over the
name of the file for about a second: a popup window will appear, showing the
contents of the file and other some useful information, like file’s size and which
user owns the file.
You can open any item by clicking (just once – KDE does not use double-
clicking in its default settings) on the icon for the file. Folders will be opened
in the same window; files will either be opened in the appropriate program,
or the file manager will ask you what program to use. For instance, if do not
have a word-processor set up to open Microsoft R© Word documents, the file
manager will ask you what to do.

You can go back to the last-opened folder by clicking on the Back button or go
up one folder by clicking the Up button.

19



The KDE User Guide

20



The KDE User Guide

2.4.3 The Navigation Panel (aka ‘The Sidebar’)

The Konqueror sidebar
21
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Navigating through the folders by using the folder view can become impracti-
cal. The sidebar provides shortcuts and special functions that make it easier to
find what you are searching for.

On the left edge of the sidebar you will find a number of buttons, each with a
different icon:

Bookmarks As Konqueror (the file manager) also serves as a very powerful
web browser, it also has a bookmark functionality. Here you will find the
same structure as in your Bookmarks menu.

Devices Next the sidebar provides a list of all known devices on your com-
puter. These devices can be either physical drives — such as your hard
disk, CD-ROM drive, or floppy disk drive — or virtual ‘drives’ — such
as remote shares or hard disk partitions.

History Konqueror will remember the web pages you have visited and list
them either by date or alphabetically in a tree structure. You can select
the behavior by right clicking on the History item and selecting Sort by.
Left click on an item (e.g. www.kde.org) and Konqueror will show you
the documents you have visited. Left clicking on a document (e.g. in-
dex.html) will open the web site in the folder view.
Right clicking on a history item, like www.kde.org→ index.html, opens a
slightly different popup menu: you will also find the item New Window,
which makes Konqueror open the site in a new window.

Home Directory The Home Directory item is in the sidebar’s navigation panel.
You will find your home directory as the first entry. Below you will find
all folders of your home directory. Left clicking on any folder in this view
opens the folder in the folder view. Alternatively, you can also work with
the folders’ context menus, create subfolders, and so on.

Sidebar Media Player Try dragging a music file (like MP3, Ogg, or .wav files)
on the sidebar. The file will immediately be played.

Newsticker Newsticker will display a customisable list of news sources. Right-
click either on the Configure button or on one of the newssource buttons
(e.g. KDE News, which is usually predefined) to add a new newsticker
source.

Network Here you can browse the services provided by other computers on
the network. The Lisa-Daemon has to be started in order to work cor-
rectly. The network browser allows you to see a variety of services pro-
vided by a computer. You can easily browse SMB shares, HTTP sites, or
transfer files via the secure FISH layer.

Root Directory Everything on a UNIX R©-based system is organized in a file
system tree. This tree must have a root and here it is. The Root Directory
function is like the Home Directory function. The only difference is that
every folder is being displayed, not only your home directory.

Services This is somehow the "rest". Try browsing through the different items.
If an Audio CD is in your CD or DVD drive you will be able to find
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everything on it and even more in the Audio CD Browser item (you can
even compress audio files and save them on your hard drive with this
function).

2.4.4 Icons

To select only one icon hold down the Ctrl key and click on the icon you want to
select. If you want to select more than one icon, hold down Ctrl while you click
on each of the items you want to select. Once one or more icons are selected you
can do what you want with them. If you want to move or copy items, select
them and then drag them (with the left mouse button down) to the desired
location. When you release the mouse button a menu will come up offering
you to Move, Copy, or Link the selected items. You can also Cancel your action.

Many other actions can be applied to the selected items by right-clicking on one
of the selected items, and choosing the action from the menu which appears.
(The exact contents of this menu depend on the type of files selected, so it is
called a ‘context menu’).

2.4.5 Links and Shortcuts

As already mentioned above you can link files or folders anywhere. It means
that the linked folder will appear and behave just like the original in another
location without consuming additional space on your harddrive. So if you, for
example, have a number of documents, and only a few are used regularly, you
can easily group them in a folder and create links in it.

2.4.6 The Trash

Before a file is deleted in the KDE file manager it will be moved to the Tr-
ash folder to give you the possibility of getting it back if you deleted it by
accident. The trash bin will show all deleted items. You can select the one to
be recovered and move it to its original place as described in Section 2.4.4. If
you right click on the trash bin and select Empty Trash Bin the files in it will be
deleted permanently.

RELATED INFORMATION

• As mentioned in the introduction, the Konqueror Handbook has much more
information about the features available in Konqueror. You can read it in
KHelpCenter or by entering help:/konqueror in Konqueror’s Location bar.
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Chapter 3

The Panel and the Desktop

Philip Rodrigues

3.1 Kicker, the KDE Panel

Kicker is the application launcher panel of the K Desktop Environment. By de-
fault, it appears along the bottom of the screen, and takes up the whole of the
width of the screen, but this is configurable. Kicker is something of a one-stop
shop for (almost!) everything that you might want quick access to. Besides the
K icon Menu, where you can start applications, Kicker is also capable of run-
ning docked applets like the pager, the taskbar or the clock, and extensions,
such as child panels. With all these options, you will probably want to con-
figure Kicker so that it works best for you. The next section describes some
common ways to customize the panel.

3.2 Configuring Kicker

3.2.1 Customizing the icons on the panel

When you first start KDE, kicker displays some icons next to the K menu. These
can be used to start the applications that they represent. To see which appli-
cation is launched by each icon, hold the mouse cursor over the icon until a
tooltip (a small popup label) appears telling you the name of the application.

These default icons might not represent the applications you use most often, so
you can remove the ones you do not want and add icons for other applications
that you use. To remove an icon, right mouse button-click on the icon, and
select Remove application name Button in the popup menu that appears. To
add a new icon, right mouse button-click on an empty space on the panel, and
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follow the menu entry Add Application to Panel . This leads you to a copy of
the K menu, where you can find all of the KDE applications. For example, to
add an icon for the JuK music player, follow through the menus to Add Appli-
cation to Panel→Multimedia→ JuK (Music Player). The icon will appear on
the panel in the space that you right-clicked on.

3.2.2 Adding extras and applets

Kicker can add many types of items as well as application launch icons. You
can find these items using the same menu as before, but this time selecting Add
Applet to Panel... or Add New Panel. The items in the Add Applet window
are small programs that can reside on the panel. An example of an applet is the
Desktop Preview & Pager, which shows a small image of each of your virtual
desktops. (For more information about virtual desktops, see Section 2.3.3). You
can switch to a different virtual desktop by clicking on its image in the desktop
pager.

You can find information about the other applets available for Kicker in the
Kicker manual. Just enter help:/kicker in the Location bar in Konqueror.

3.2.3 The System Tray

The system tray is where programs that are run, but not directly needed are
kept. Some programs (like music players) are shown there, because you prob-
ably want to keep them open, but so that it does not take too much space on
your screen, it will put an icon in the system tray.

When you right click on such an icon, a popup menu will appear where you
can see some options of the program (like play, pause, stop, ... in a music
player).

When you left click on it, the main window of the program will appear. If you
hover your mouse above the icon, a tool tip will appear with some information
(in the music player case information like the current song). Programs that
normally support system tray icons are music players, IRC clients, organizers,...
In most of these programs you can configure if you want an icon to be shown
or not. For other tricks and tips with the system tray see the section on Section
2.3.2.3.

3.2.4 Removing Panel Items

You can remove applets and other special items from the panel using the arrow
on its handle on the applet’s left. Right click on the arrow, and choose Remove
applet name.
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3.3 The Taskbar

The taskbar is an item on the panel which displays an entry for each window
that you have opened. You can use the taskbar to switch between windows
by clicking on the entry of the window you want to activate. The taskbar has
entries for windows on each virtual desktop, including windows which have
been minimized.

3.4 Using the Clipboard

Very often, it’s useful to move some text, or an object in a program, from one
place to another. It’s also very common to need to duplicate some text, for
example, if you’re typing the same thing several times. The system used for
doing this is known as the clipboard. There are two slightly different ways to
use this system, known technically as the ‘selection’ and the ‘clipboard’. We’ll
look at them separately:

3.4.1 The Selection

This method uses the mouse to copy text from one place to another. The
method is:

1. Select the text you want to copy.

2. Click the middle mouse button at the place you want the text to be copied
to. This can be in the same program as you copied the text from, or in
another program entirely.

If you have three buttons on your mouse, this is easy, but if not, all is not lost!
If you have only two buttons, try clicking them both at the same time instead
of the middle mouse button.

3.4.2 The Clipboard

With this method, you can copy text, or ‘cut’ it (that is, remove it from one place
and move it to another). You can use either the mouse and the menu entries,
or the keyboard with this method. I’ll list both ways, with the menu entry to
use, followed by the keyboard shortcut which will do the same thing, like this:

Edit→ Cut (Ctrl+X)

MOVING (‘CUTTING’) TEXT

1. Select the text you want to cut.

2. From the menu, select Edit→ Cut (Ctrl+X), and the text will be removed
from its current location.
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3. Position the text cursor at the point you want to insert the text. This can
be in the same application you got the text from, or another application
entirely. Select Edit→Paste (Ctrl+V), and the text will appear at the point
where you placed the cursor.

Copying text from one place to another is very similar:

COPYING TEXT

1. Select the text you want to copy.

2. From the menu, select Edit→ Copy (Ctrl+C), and the text will be copied
in the clipboard.

3. Position the text cursor at the point you want to insert the text. This can
be in the same application you got the text from, or another application
entirely. Select Edit→ Paste (Ctrl+V)

3.4.3 More Advanced Clipboard Use

The instructions above describe the default clipboard behavior. The Klipper
application, which you can add as an applet in the panel (see Section 3.2 for in-
structions on how to do this), provides some useful clipboard-related features,
like a clipboard history, and the ability to change the behavior of the clipboard
and selection. Take a look at the Klipper Handbook for more information.

RELATED INFORMATION

• You can find more information about Kicker, the KDE Panel, in KHelpCenter
or by entering help:/kicker in Konqueror’s Location bar.

• The Klipper Handbook has information about the advanced clipboard man-
agement features in KDE. You can read it in KHelpCenter or by entering
help:/klipper in Konqueror’s Location bar.

3.5 Related Information

RELATED INFORMATION

• Though some information has been presented here, there is a lot more in-
formation on Kicker tips, options, tricks and hacks, in the Kicker handbook.
You can access it via the KHelpCenter or by simply entering help:/kicker
in the Konqueror Location toolbar.
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Chapter 4

Programs and Documents

4.1 Launching Programs

KDE offers a varying number of ways to launch programs. You may:

• Simply select the relevant item in the K menu.

• Run the program from Konsole, or by clicking the K menu and choosing Run
Program (while you still might prefer the quick keyboard shortcut, which is
simply Alt+F2).

• Create a shortcut on the desktop or use Kicker’s quick launcher.

The K menu functions much like the Start menu of Windows R©, however it
breaks programs up by what they do. Programs on the K menu are broken into
category menus, such as Multimedia and Office. Under these category menus
there are subcategory menus, such as Sound, Video and Graphics. Under the
subcategory menus lie program launchers, which, when clicked on, launch the
associated application.

Depending on the program, there may not be a launcher in the K menu. To
search your hard drive for more applications, click the K menu, choose Run
Command and type kappfinder. In Kappfinder, click Scan, and the hard
drive will be searched for programs. Click the checkbox next to each program
to be added to the K menu, and click Apply and Close. The K menu now will
have new program launchers under the relevant category menus.

Launchers to programs may also be placed on the desktop. To create a new
launcher, right click on the desktop, and choose Create New→ Link to Ap-
plication. On the KDesktop properties dialog box, type in the name of the
program on the General tab. You may also wish to choose a custom icon by
clicking on the gear icon. Click the Application tab and type a short sentence
about the program in the Description textbox. In the Command textbox, type

28



The KDE User Guide

the name of the program (case sensitive), and any command line options you
wish to use. Choose OK, and your new program launcher will be created on
your desktop. Simply click on the new launcher on the desktop and the asso-
ciated program will run.

To launch a program using Konsole, click the K menu and choose System
→ Terminals → Konsole. Once Konsole appears on the screen, simply type
the name of the program you wish to launch (remembering that bash, the
command language interpreter that Konsole uses by default, is case-sensitive)
and press Enter. If you are unsure about the name of a program, type the
first few letters then press the Tab key on your keyboard. By pressing Tab,
bash (through Konsole) will try to guess the name of the program you wish
to launch. If it finds more than one matching program, a list of matching pro-
grams will be printed on the screen. Type the name of the program from the
list and press Enter to launch.

Whichever way you choose, launching a program is a simple affair with KDE.
From the K menu, to Konsole, all your programs are just a few clicks or key-
presses away.

RELATED INFORMATION

• Check the Kicker handbook for more information on enabling or disabling
the K menu, adding applications to the quick launch, or on organizing the
categorization of the applications in the K menu. You can view the Kicker
handbook either via the KHelpCenter or by using Konqueror’s KIOslave by
typing help:/kicker in the Location toolbar.

4.2 Controlling Programs

Standard Toolbar layout

Keybindings

4.3 Opening and Saving Files

KDE provides a unified way to open or save files via the file dialog. In almost
every KDE program you will find a File→Open and File→ Save (and/or Save
As...) entry.
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4.3.1 The File Dialog

v1v2v3v4v5
This dialog consists of between three and five areas. The top area is where you
find the navigation and configuration functions. The main area (in the middle)
is where all your files are being displayed as icons. This is called an icon view.
The bottom area is where you can edit filename or filter expressions and say
Save or Open.

In addition to that you can add two even more sophisticated areas: the Quick
Access Navigation Panel and the Preview Panel.

v1 Next to the three navigation buttons (one directory up, back and forward)
and the new folder button there is the bookmarks menu. Here you can
mark any folder you visit often to find it quickly. The wrench icon holds
the different functions to sort your files by name, date or size and to en-
able the two extra panels mentioned above. Next to it you can type the
directory and choose (on the very right side) the encoding.v2 You’ll find the icon view in the middle of the dialog. You will find most of
the navigation functions in the context menu by clicking on the items or
the background with the right mouse button.v3 The bottom of the dialog consists of the address field holding the file name
you chose or typed in and the maybe most powerful tool: The filter. Here
you can make the icon view display only items that match the criteria
you define. Try filtering files whose names contain ‘air’ by typing *air*
into the filter field.v4 The Quick Access Panel (activate it by typing the F9 key on your keyboard
or through the wrench icon on top of the dialog) provides configurable
shortcuts to frequently used locations on your hard drive or even on the
Internet. There are several preconfigured locations such as your home di-
rectory. Try right clicking on any item to configure it or to empty space to
add a new entry. You will be shown a context menu. Here you can choose
the icon size and to add, modify or rename any entry. Choose Add En-
try and you will see a window containing anything you need: Type your
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description, enter the location (or choose it via the dialog opening by
clicking on the folder symbol), choose a symbol from a vast variety in the
symbol dialog opening when you click on the predefined icon (usually a
simple folder symbol).v5 The Preview area (activate it by typing the F11 key on your keyboard or via
the wrench icon on top of the dialog) makes it easy to preview almost any
file on your filesystem. Images will be displayed as thumbnails. Usually
also sound files (such as MP3, Ogg or Wave-Files), text files (among them
raw text, PDF and HTML) and even video files (MPG, AVI and so on)
will be previewed.

NOTE
Note that large files might take a long time to be previewed (e.g. scaled down
if they are large images). You can disable automatic previews by unselecting
Automatic Preview below the preview. You can still preview individual files:
just click Preview. You can also disable previews for files above a certain
size. Go to KDE Control Center, choose KDE components+File manager, go
to the Preview and Metafiles tab and change the Maximum Filesize value.

4.4 Configuring Programs

4.4.1 Application Configuration

KDE applications are intended to be as useful and usable as possible ‘out of the
box’, but they also offer a wide range of options which you can change to make
KDE work for you. As well as the settings which affect the whole of KDE (see
chapter 5), each application has a set of configuration options, which you can
access using the menu option Settings→ Configure Application. This is the
same for all KDE applications, which makes it easy to find the configuration
dialog for an application.

On the left of the configuration dialog is a list of sections. Clicking on one of
these sections displays the configuration page for that section on the right-hand
side of the dialog. You can change these options to fit your preferences.

When you have made the changes you want, you can click on OK to save your
changes and close the configuration dialog. If you want to see the effect of your
changes, but not close the configuration dialog, click on the Apply button. This
is useful if you aren’t sure about the change you’ve made, and might want to
change back, because the dialog is still open, ready for you to do so.

If you decide that you don’t want to keep the changes you’ve made, just click
Cancel to close the dialog without saving your changes.
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4.4.2 Configuring Keyboard Shortcuts

Most KDE applications offer keyboard shortcuts for the main actions in the ap-
plication. If you find that you don’t like the default keyboard shortcuts, or that
they conflict with the shortcuts of another application (maybe one that’s not
part of KDE), you can change them with the Settings→ Configure Shortcuts...
menu entry. This brings up the Configure Shortcuts dialog for the application.
As an example of how to use this dialog, let’s add a shortcut for the Send Link
Address... action to Konqueror, so that we can email the locations of interesting
pages to friends just by hitting a key (or two):

1. Open the Configure Shortcuts dialog in Konqueror, as described above.

2. Click on the Send Link Address... item in the main listbox (it’s near the
bottom, in the Konqueror section).

3. In the Shortcut for Selected Action panel, select Custom, since we are
going to give this action a keyboard shortcut that we have chosen.

4. A small shortcut entry dialog pops up. Just hit Ctrl+E (or whatever you
want to change the shortcut to), and the dialog disappears. The ‘key’ icon
in the Configure Shortcuts dialog now shows the new shortcut.

5. If you made a mistake, or change your mind about what to use as the
shortcut, just click on the key icon showing the current shortcut. The
shortcut entry dialog reappears, and you can press the key combination
for the shortcut you want.

4.4.3 Configuring Notifications

Something about Settings→ Configure Notifications....

4.4.4 Configuring Toolbars

Nearly every KDE application has one or more toolbars at the top of the ap-
plication window, underneath the menu. The toolbar contains icons (toolbar
buttons) that represent commonly used actions and configuration settings. The
KMail window, for instance, has a toolbar that contains buttons for New Mes-
sage, Check Mail and several others. Each of these actions is something you do
often, so that’s why they have toolbar buttons as well as menu entries (New
Message is under Message→New Message, Check Mail is File→Check Mail).

Not everybody agrees on what actions are commonly used, though, (I never
use the New Message toolbar button or the menu item, I use the keyboard
shortcut Ctrl+N). To ensure that your screen isn’t cluttered with things you
don’t need, each toolbar can be customized. Additionally, you can usually
customize which toolbars are displayed and how, as well.

32



The KDE User Guide

4.4.4.1 Customizing Toolbar Displays

The easiest thing to customize with the toolbars of any given application is
whether they are displayed at all. Most applications have a Settings→Toolbars
menu where you can select which toolbars are displayed and which are not.
Konqueror has four toolbars, Main, Extra, Location and Bookmark. It can be
convenient to turn off the Bookmark toolbar to save screen space. To do so,
click on the Settings menu, choose Toolbars, and then uncheck the Bookmark
Toolbar entry (do this just by clicking on the menu item).

If there is no Settings menu, you can also right click on the toolbar itself, and
choose the Toolbars sub-menu from the resulting context menu.

The same Toolbar context menu, accessed by right clicking on the toolbar, al-
lows you to customize other properties of the toolbar:

• Its orientation, so that instead of appearing at the top of the window under
the menu bar you can place it on the left, right or bottom of the window.

• Its orientation, so that the toolbar ‘floats’ as a separate window which you
can move independently.

• Its orientation, so that the toolbar is squashed into a little flat grip that you
can re-open by double-clicking on it (this is subtly different from making the
toolbar vanish completely, since it it easier to cause it to re-appear).

• The appearance of text alongside, underneath, or instead of the icons on the
toolbar.

• The size of the icons (if they are not supplanted by text).

4.4.4.2 Customizing the Icons on the Toolbar

The toolbar is intended for actions that you perform often, so what do you do
if there is some useless icon there, like Cut? Or what if you really want a cut
button on the toolbar, but the application doesn’t give you one? This is where
the customize toolbars dialog comes in — it give you complete control over the
actions that are available on each toolbar.
Choose Settings→ Configure Toolbars from the application’s menu, or Con-
figure Toolbars from the context menu of the toolbar itself. This displays the
configure toolbars dialog, which consists of a combobox with which you can
select which toolbar to customize, and two lists of items — one of the available
actions, and one of the actions that are already in use on the toolbar.

Often there are many many more actions available ( activate tab #12, for in-
stance) than you would ever want on the toolbar, or even that you know exist
in the application. The customize toolbar dialog can be a learning experience.
You can drag actions from one list box to the other, rearrange the items on the
toolbar , or change the icon for a selected action. This allows you to drag the
actions you don’t want off of the toolbar and into the list of available actions;
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similarly, the actions you do want can be dragged into the toolbar. Clicking OK
in the dialog immediately updates the toolbar with your new preferred actions.

There are a few special items that can end up in the listbox for the current
toolbar:

• separators, which exist in two flavors:

– line separator appears as a line between two action icons
– separator appears as a larger space between two action icons

• <Merge>, which is a special item that allows plugins and other loadable
components of the application to insert their actions into the toolbar as well.
It is generally not a good idea to remove this, since you cannot get it back.

• ActionList:, these appear in various flavors (there is a viewmode_toolbar
one in Konqueror) and again these represent lists of actions that might be
inserted by plugins.

Whenever you click on an action in the list of current actions, a description of
it is shown in the dialog. This description will warn you if it is a bad idea to
remove the action.
If you do not like to drag things around, there are four buttons in the middle
of the dialog which allow you to move the selected action from one list to the
other, and to move a selected current action up or down in the list. There must
be a way to restore the default toolbars in an application, in order to recover
from accidentally deleting an important action like <Merge>, but I don’t know
what it is.
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Part III

KDE Components
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Chapter 5

The KDE Control Center

The KDE Control Center
The KDE Control Center is the place to go to change any settings that affect
the whole of your KDE environment. You can open it using the Control Center
item in the K menu, or with its command-line name, kcontrol.

The settings are divided into several major categories, which each contain sev-
eral pages of settings. To display a settings page, expand the major category
by clicking on the + button next to it, and then click on the name of the page
you want. The settings page then appears on the right, and you can change
settings to your heart’s content. No changes take effect until you click on the
Apply button. If you decide, after making some changes, that you want to
leave the settings as they were, just click on Reset.
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If you need more help with a page, visit that page, then click on the Help tab.
You might also want to look at the KDE Control Center Handbook, which you
can open with the Help→ KDE Control Center Handbook.

5.1 Appearance & Themes

Here you will find settings that change the way your KDE desktop and appli-
cations look.

Background This section controls the color or image that is set as your desktop
background. These settings can be applied to all virtual workspaces, or
to only a specific one. There are a range of background wallpapers that
come with KDE or you can supply your own.

Colors This is where you can modify the colors for your kde applications.
There are a variety of color schemes installed with KDE by default, and
you can find others at kde-look.org. You can also create your own. Here
you can also modify the contrast and choose whether you want your KDE
colors to be applied to non-kde applications, for a more consistant overall
appearance.

Fonts Here you can control the various font settings for KDE applications. You
can also modify here anti-aliasing settings, including what range of fonts
to exclude from anti-aliasing settings.

Icons This section is where you can manage your icon themes and other set-
tings related to icons. New icon themes can be downloaded from kde-
look.org, and installed here. Conversely, you can remove icon themes by
highlighting them in the list and clicking remove. You can also set icon
sizes for various uses in KDE and effects to apply to icons.

Launch Feedback This is where you can modify what kind of cursor and/or
taskbar feedback you’d like for launching applications. You can also set
the duration of this feedback here. For example, the default setting is for
a bouncing cursor with a duration of 30 seconds, or when the application
has loaded.

Screen Saver Here you can configure options about your screensaver. You can
configure the timeout before it starts, and whether it requires a password
to unlock the screen.

Splash Screen This is where you can install, remove and test the splash screens
that display on KDE startup. More splash screens can be downloaded
from http://www.kde-look.org.

Style This section allows you to modify your widget style. A variety of styles
come with KDE, and more can be downloaded from http://www.kde-
look.org. This is also where you would enable or disable interface options
such as transparent menus, showing icons on buttons and tooltips. Some
styles have more configuration options than others.
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Theme Manager This is where you can create and manage themes that are
made up of personalized settings. They are a combination of desktop
background, colors, KDE widget styles, icons, fonts and what Screen-
saver you’d like to display . This allows you to save your favorite ‘looks’
and apply them with the click of a mouse button.

Window Decorations Here you can configure your window decorations. You
can modify the style as well as place the buttons in custom positions.
Some window decorations will have more configuration options than
others.

RELATED INFORMATION

• If KDE Control Center doesn’t have the setting you want, you may need
to edit a configuration file manually. See Section 16.1 for more information
about how to do this.

• If you enjoy modifying the appearance of your KDE desktop, you can find
plenty of themes and styles at kde-look.org.

5.2 Desktop

This is where you will find settings to configure the appearance and behavior
of your KDE desktop.

Behavior Here you can configure the behavior of your desktop. This is where
you would go to configure options such as showing or hiding desktop
icons, showing tooltips and icon layout. You can also specify if you
would like to see previews of particular filetypes on the desktop, and
which devices you’d like to see icons for.

Multiple Desktops This is where you would configure the number of virtual
desktops or workspaces you would like to have, and what you would
like them to be called. By default KDE has 4 virtual desktops, and you
can configure up to 20. You can also enable switching between virtual
desktops using the scroll button on your mouse.

Panels Here you can modify options to do with Kicker and other KDE panels.
Among the options are size, position, length and hiding. You can also
modify the appearance of the panel with transparency, background im-
ages and icon zooming. This is also where you would configure various
menu options including what applications you’d like to show in your K
menu.

Taskbar The Taskbar module allows you to configure options related to your
taskbar. You can configure whether to show windows from all desktops,
grouping of similar tasks and what actions you would like to assign to
your mouse buttons.
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Window Behavior This is where you would configure options related to the
behavior of KDE’s window manager, KWin. KWin is extremely config-
urable and has advanced features such as focus stealing prevention and
different focus policies such as focus follows mouse. You can also con-
figure what actions you would like to bind to certain keys and mouse
events.

Window-Specific Settings This is an advanced configuration dialog where you
can set options for the behavior of specific windows. There are many op-
tions here for the fine tuning of your window layout, including what
position on the screen you would like certain windows to open to, and
whether they should be shown on the taskbar or pager. You can select
windows by application, or even by their specific role within an applica-
tion.

5.3 Internet & Network

This section is where you would configure settings to do with internet and
networking under KDE.

Connection Preferences Here you can set advanced networking options such
as timeout values for server connects. Usually you would leave these
options at the defaults unless you really knew what you were doing.

Desktop Sharing Desktop Sharing allows you to invite someone to share your
session with you, or can enable you to log in remotely to your machine
from another location. You would then use a VNC client like KDE’s Re-
mote Desktop Connection application to control your desktop over the
network. This is extremely useful if you want someone to help you per-
form a task.
Here you can create and manage invitations as well as set your security
policy for uninvited connections. You can also configure whether to show
a background image and which port for the service to ’listen’ on.

File Sharing File sharing allows you to configure Samba (Microsoft R© Win-
dows R©) and NFS (UNIX R©) file sharing. To make changes in this mod-
ule you need to have the root or administrator password. This is where
you would set up whether users are allowed to share files without know-
ing the root password, and which users are allowed to do so. You can
also configure which folders you’re like to be shared, using which type
of sharing and who is allowed to view these shares.

Local Network Browsing Here you can configure options related to brows-
ing network shares in Konqueror. Konqueror is able to browse a variety
of network shares and manipulate remote files as though they were on
your local machine. You can configure it to remember your preferred
username and password for connecting to Windows R© shares (Samba).
You can also set what types of network shares you would like to be able
to browse, including FTP, NFS and SMB.
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Local Network Chat This module allows you to configure options relating to
the UNIX R© talk daemon. It is a very simple network chat program that
runs in a terminal, designed for chatting over a local area network. Some
of its features are being able to set up an ’answering machine’ that will
email to you messages left for you, and being able to forward messages
to another location.

Proxy This is where you would configure KDE to connect to a proxy server
rather than directly to the internet. Once again you would generally leave
these options at their defaults unless you really knew what you were
doing. If you do use a proxy server your network administrator will be
able to tell you what details to fill in here.

Samba The Samba Configuration module requires the root or administrator
password. It is an advanced configuration tool that allows you to con-
trol Samba’s security, shares, users and printers in an intuitive graphical
interface. This is a very powerful tool with support for configuring ev-
erything from simple file and printer sharing, to using your Samba server
as a Windows R© NT Domain Controller.

Service Discovery You can set up services browsing with ZeroConf. You can
for example browse your local network using multicast DNS.

Web Browser This module is where you would configure options relating to
Konqueror as a web browser. The usual options you would expect from
a web browser, such as cookie configuration, cache and history can be
found here as well as sections to modify keyboard shortcuts, plugins and
fonts.

Wireless Network Here you can set up different profiles for your Wireless
card, to be able to quickly switch settings if you connect to multiple net-
works. You can select a profile to be loaded on KDE startup.

5.4 KDE Components

This section is where you can modify advanced KDE options such as file asso-
ciations and default applications.

Component Chooser The component chooser allows you to select the default
applications you would like to use for various services. Here you can
define what Email Client, Embedded Text Editor, Instant Messenger, Ter-
minal Emulator, File Manager and Web Browser to use. If you prefer to
use Xterm, Vim or Mozilla, this is the place to specify those preferences.

File Associations This is where you configure everything to do with file as-
sociations. Here you can select a filetype, and choose what applications
you would like to be able to open it with. You can also select which icon
you would like to represent each filetype, and whether to show it in an
embedded or a separate viewer.
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File Manager Here you can configure the behavior of Konqueror in file man-
ager mode. Among the options are fonts and font sizes, previews over
various network protocols and context menus. Konqueror is an extremely
powerful and configurable file management tool with a plethora of op-
tions. For more information, consult the Konqueror handbook.

KDE Performance Here are settings related to the memory usage of Konqueror.
Minimize Memory Usage allows you to control whether separate instances
of Konqueror will open or whether all new Konqueror windows connect
to the same instance. This has the effect of reducing memory usage. You
can also select whether to pre-load Konqueror after KDE startup, to re-
duce start times. To be written

KDE Resources Configuration

Service Manager The Service Manager module displays a static list of services
that are started on demand, and a second list of services that can be ma-
nipulated by the user. The services in the first list cannot be modified
or changed. The services in the second list you can enable or disable a
service loading at start up, and manually start and stop services.

Session Manager Here you can configure how you would like KDE to handle
sessions. You can configure KDE to remember your previous session and
restore the applications you were using the next time you log in. You
can also specify individual applications to exclude from being restored,
or disable restoring sessions on login entirely.

Spell Checker This module allows you to configure the KDE Spell checker. It
allows you to modify what spell checker to use, what types of error to
check for and also what default dictionary to use. KDE supports the use
of both ASpell and ISpell.

Vim Component Configuration This module allows you to configure the use
of Vim as an embeddable component. You need to have a recent version
of Gvim or Kvim installed for this. You can configure the appearance of
the editor as well as which vim binary to use.

5.5 Peripherals

This section is where you would change settings related to peripheral devices
such as keyboards and joysticks.

Display Here you can modify settings to do with the size, orientation and
refresh rate of your display, and whether you would like these settings to
be applied on KDE startup. On the Power Control tab, you can configure
your power management options for this screen such as blanking.

Joystick This section allows you to configure your joystick and test that it is
working properly. You can also calibrate your joystick here, and manu-
ally specify the joystick device if it is not autodetected correctly.
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Keyboard This module allows you to configure basic keyboard settings. These
include keyboard repeat delay and rate, and what state you would prefer
numlock to be on KDE startup.

Mouse Here is where you can configure settings to do with your mouse de-
vice. You can switch the button order, reverse the scroll direction or
modify the behaviour of clickable icons. You may also preview, install
and select cursor themes. The Advanced tab allows you to fine tune your
mouse settings further.

Printers This dialog allows you to configure printers using a variety of print
systems. You can add local and remote printers, check current jobs and
look at printer properties.

5.6 Power Control

This section has a single module, Laptop Battery. Here you can configure the
appearance and behaviour of the Klaptopdaemon battery monitor. You can
select battery icons to represent different power states, and set up notification
of certain events. In the case that your battery runs down to a critical level, you
can configure the daemon to suspend or shutdown your laptop, to save you
from losing data.

5.7 Regional & Accessibility

This section is where you can configure options to do with region and locale,
and also acessibility related options for disabled persons.

Accessibility Here is where you can configure options for users who have dif-
ficulty hearing system sounds or using a keyboard. You can configure the
system bell to use a visual signal, such as flashing the screen or inverting
screen colors. You can also configure keyboard accessibility options such
as sticky keys and slow keys.

Country/Region & Language This module allows you to configure options
that are specific to your location such as language, currency and date
format. To make available more languages, install the kde-i18n packages
for your distribution.

Input Actions Here is where you would configure input actions, such as mouse
gestures and keyboard shotcuts for launching applications and running
commands.

Keyboard Layout This module is where you would configure Kxkb, a key-
board layout switching utility that uses the X Window System R© xkb ex-
tension. It allows you to switch between different layouts using a tray in-
dicator or a keyboard shortcut. You can enable/disable keyboard layouts
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through this dialog, and add more. Some of the more powerful features
are the ability to configure switching of layouts globally, per application
or per window.

Keyboard Shortcuts Here you can configure global KDE keyboard shortcuts.
There are several predefined shortcut schemes you can use if you are
more used to another windowing environment, like Windows R© or Mac R©
OS. If you prefer, you can customise your own scheme and modifier keys.

5.8 Security & Privacy

This section is where you can configure options related to security and privacy
such as the use of cryptography, enabling the KDE wallet, setting your identity
and managing caches.

Crypto This module allows you to configure SSl for use with most KDE ap-
plications, as well as manage your personal certificates and the known
certificate authorities.

KDE Wallet Here you can change your KDE Wallet Manager settings.
KDE Wallet aims to provide secure storage for passwords and web form
data. You can group different passwords in different wallets, and each
one will only be opened with a master password (which you should
never forget!). The default wallet is named "kdewallet", and you can ei-
ther create a new wallet for your local passwords or accept the default
wallet for all data in the "Automatic Wallet Selection" section.
KDE programs like Konqueror, Kmail and Kopete are fully compatible
with the KDE Wallet Manager. All of them will ask at least once for per-
mission to access to actual wallet. You can give different access levels,
such as "always allow", "allow once", etc. If you want to change that ac-
cess level, you can do it from the "Access Control" tab by deleting the
program entry and selecting a new preference the next time that applica-
tion requests access to the wallet.

Wallet Preferences To enable the KDE wallet subsystem, check the En-
able the KDE wallet subsystem box. Unchecking this box will dis-
able the KDE Wallet on your system.
By default, KDE Wallet Manager is kept opened until the user ses-
sion is closed, but you can change that in the Close Wallet section to
close it when unused for a time, when a screen saver starts or when
the last application stops using it.
As you can have several wallets, Automatic Wallet Selection allows
you start KDE with a given wallet.
KDE Wallet will appear in your system tray by default, but you can
hide it. Uncheck Show manager in the system tray to keep it always
hidden, or check Hide system tray icon when last wallet closes to
hide it only when all wallets are closed. These items are in the Wallet
Manager section.
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Access Control You can set here what policy you want for your KDE
applications, regarding to the wallet use.

Password & User Account You can change here your personal information which
will be used in mail programs and word processors. You can change your
login password by clicking the Change Password... button.

Privacy This module allows you to erase traces which KDE leaves on your
system such as command histories or browser caches.

5.9 System Administration

This module allows you to configure aspects of your system such as the boot-
loader, the kernel and helps you perform essential system tasks. Most of these
sections will require the root or Administrator password to effect changes.

Boot Manager (LILO) If you use the popular bootloader LILO this section will
allow you to configure it. You can configure the location to install the
bootloader to, set the timeout on the LILO boot screen as well as add or
modify kernel images for the boot list.

Date & Time This configuration module allows you to configure the system
date and time settings. You can set the date, time, and also the current
time zone. These settings will be applied system-wide.

Font Installer Here is where you would configure both personal and system-
wide fonts. This dialog allows you to install new fonts, delete old ones
and preview the fonts you have installed. By default, it displays personal
fonts. To modify system-wide fonts click the Administrator Mode button.

IBM Thinkpad Laptop This configuration module allows you to configure the
special keys on an IBM thinkpad laptop. You will need the ‘nvram’ mod-
ule to use these features.

Linux Kernel If you run KDE on Linux R© there is a KControl module to create
or modify configuration files for a Linux R© kernel. This configurator is
compatible with kernels previous to 2.5.

Login Manager This module allows you to configure the KDE login manager,
kdm. kdm is a powerful login manager with a large range of options.
It supports user switching, remote graphical logins and has a fully cus-
tomizable appearance. For more information, see the kdm handbook.

Paths This dialog allows you to configure the default locations where certain
important files are kept. The Desktop directory contains all the files on
your desktop. The Autostart directory contains files or links to files that
you want run when KDE starts, and the Documents directory is the de-
fault location KDE applications will open or save documents to.

Sony Vaio Laptop This configuration module allows you to configure features
specific to Sony Vaio laptops. If you have a Sony Vaio, you will have to
install the ‘sonypi’ driver to use this section.
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Chapter 6

The Base KDE Applications

Francis Giannaros What follows is a brief description of a few of the base KDE
applications. For more information on any of the applications you should
check the links recommended with each respective entry.

6.1 Fundamentals

Konqueror KDE’s file manager, web browser, FTP client and much more. Kon-
queror is the canvas for all the latest KDE technology, from KIO slaves
(which provide mechanisms for file access) to component embedding,
allowing it to be a universal viewing application, capable of displaying
various image files as well as documents.

• Website: http://konqueror.org
• View the handbook by typing help:/konqueror in Konqueror’s Loca-

tion Toolbar, or by selecting it in KHelpCenter.

Kate KDE’s advanced multi-view text editor. Kate is excellent for things such
as viewing the HTML source of a webpage to handling advanced coding
in C++, PHP and XML with its powerful syntax highlighting engine and
code folding capabilities. Kate is a very speedy application, being capable
of opening huge text files in a matter of seconds, as well as allowing you
to view a hefty amount of multiple views in order to see more instances
of the same document and/or more documents at any particular time.

• Website: http://kate.kde.org
• Kate Handbook

Konsole The X terminal emulator for KDE. Konsole, like many KDE appli-
cations, is extremely customizable; while you can create your own user
sessions, you can also of course open Linux R© console sessions, shell ses-
sions, as well as standard root and sudo sessions.
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• Website: http://konsole.kde.org
• Konsole Handbook
• User Guide chapter 13

Kicker The KDE Panel, used for handling your currently running applica-
tions, a pager allowing you to switch between desktops, quick launch
buttons to act as application launchers and much more.

• See chapter 3 for altering some of its settings.
• Kicker Handbook

kdcop A GUI front-end to the powerful DCOP (Desktop COmmunications
Protocol). DCOP provides a comprehensive protocol for interprocess
communication between KDE applications. While this is increasingly
useful to KDE programmers, it is also beneficial to the ordinary user who
would want to create a script, or, say, a SuperKaramba theme.

• In the User Guide Section 16.2 and Section 28.2.2
• Other Documentation: http://developer.kde.org/documentation/library/-

kdeqt/dcop.html

KControl The control center for the K Desktop Environment. You can alter a
myriad of different things, ranging from themes, fonts and screensavers,
to Internet, security and system administration.

• See chapter 5.
• KControl Handbook

KHelpCenter The KDE help system is used to provide access to the base UNIX R©
help pages (man or info) as well as the native KDE documentation pro-
vided by the KDE documentation team or the application authors. You
should be able to access all of the KDE application handbooks from here.

• KHelpCenter Handbook
• For information on the KDE Documentation team, how to possibly join

and help KDE, see: http://kde.org/documentation

RELATED INFORMATION

• http://kde-apps.org -- The largest directory of third-party KDE applications.

• As you may have noticed, a wealth of information is accessible from the re-
spective handbooks themselves, which can be accessed either by using the
help KIO slave in Konqueror (that is, type help:/application in the Loca-
tion toolbar), or by selecting it in the KHelpCenter.

• You can also likely find out quite a bit of information from the KDE website,
itself, at http://kde.org.
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6.2 Personal Information Management

KDE PIM (Personal Information Manager) is a sub-project of KDE, and it aims
to provide an application suite to manage personal information. It has several
components, but these can all be brought under one application -- Kontact,
which is the personal information manager. Below is an overview of a few of
its popular components; that is, a few of the applications that integrate into it.

Kontact This serves as the medium by which the rest of the applications in
KDE PIM can integrate with one another. All of the applications in KDE
PIM can be displayed inside here, and you can easily choose which ones
to display. It also contains a Summary page by which you can get a brief
overview of events and information in the other components.

• Website: http://kontact.kde.org
• View the handbook by typing help:/kontact in Konqueror’s Location

Toolbar, or by selecting it in KHelpCenter.

KMail The mail component. KMail comes with full IMAP, POP3 and SMTP
support. Signing and encrypting of emails is permitted, and there are
many comprehensive anti-spam functions available. A spell check can
easily be used, HTML emails can be viewed appropriately, and there is
an advanced search feature.

• Website: http://kmail.kde.org
• KMail Handbook

KOrganizer A fully customizable organizer which constitutes as the calen-
der component. KOrganizer provides management of events and tasks,
alarm notification, web export, network transparent handling of data,
group scheduling, import and export of calendar files, and much more.

• Website: http://korganizer.kde.org
• KOrganizer Handbook

KAddressBook The contacts component. KAddressBook enables you to man-
age your contacts efficiently and comfortably; contacts can be easily ex-
ported and imported from a plethora of different address book standards,
and it can be efficiently integrated with Kopete, KDE’s multi-protocol
instant messenger. Other features include support for all international
character sets and advanced search functions.

• Website: http://pim.kde.org/components/kaddressbook.php
• KAddressBook Handbook

KNotes A handy component which can serve to handle all your digital sticky
notes. You can have them displayed on your desktop, they can be ‘dragged
n’ dropped’ into emails, printed, or even be displayed after Kontact is
closed down.

• Website: http://pim.kde.org/components/knotes.php
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• KNotes Handbook

KNode The newsreader component. It is GNSKA (The Good Net-Keeping
Seal of Approval) compliant, has support for MIME and multiple servers.

• Website: http://knode.sourceforge.net/
• KNode Handbook

Akregator A lightweight and fast program to display news items provided by
feeds, supporting all commonly used versions of RSS and Atom feeds.
Useful features include searching in article titles, management of feeds
in folders and setting archiving preferences.

• Website: http://akregator.sourceforge.net
• Akregator Handbook

RELATED INFORMATION

• See http://kontact.kde.org and http://kdepim.kde.org for more informa-
tion.

• Kontact Handbook

6.3 Network

There are several network-related applications in KDE. Below is a description
of a few of these.

Kopete A fully-featured and advanced IM (Instant Messaging) client, which
has a number of protocols including MSN R©, Yahoo R©, and AIM R©. Kopete
can fetch display pictures, set aliases for particular persons, as well as run
multiple IM sessions at any particular time. Kopete is quite extensible,
and has a comprehensive plugin system which comes with a searchable
History of previous chats, statistics on a user’s status, as well as a note
system allowing you to create notes for each contact.

• Website: http://kopete.kde.org
• Kopete Handbook

KDict A GUI front-end to the DICT protocol. It enables you to search through
dictionary databases for a word or phrase, then displays suitable defini-
tions.

• KDict Handbook
• The DICT Development Group: http://www.dict.org/bin/Dict.

KGet A manager for your downloads which integrates with Konqueror. KGet
allows you to group your downloads, pause and resume them, as well as
several other things.
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• Website: http://kget.sourceforge.net
• KGet Handbook

RELATED INFORMATION

• Several more KDE network applications can be found in the KDE Extragear;
see Section 7.1.3, under Section 7.1.

6.4 Office

This includes all applications in the KOffice suite. See chapter 23 for a summary
of the components.

6.5 Graphics

KDE has several graphics-related applications, ranging from PDF viewers to
applications enabling you to take screenshots. Below is a delineation, as well
as some related links, for a few of them.

KColorEdit A small and handy application for editing color palettes, as well
as color choosing and naming. Colors can be chosen by giving the RGB
hex code, by choosing the color from a myriad of different colors in the
program, or even by grabbing the precise color of any particular thing on
your screen.

• KColorEdit Handbook

KPDF An advanced PDF viewer, based on xpdf, for KDE. KPDF contains a
number of ways to search through the document (standard find dialog,
thumbnail filter, etc.) and has other features such as hands-free reading.

• Website: http://kpdf.kde.org
• KPDF Handbook

KView An image viewer program which supports a number of different im-
age filetypes including JPEG, GIF, PNG, TIFF and many others. Kview
has full integration with KDE and it can be embedded into Konqueror for
viewing image files on your diskdrive as well as your FTP site or web-
server, using its URL open support. Other features include a few image
manipulations such as zoom, rotate, grayscale and flip.

• Website: http://www.ph.unimelb.edu.au/ ssk/kde/kview/
• KView Handbook

KSnapshot An application for taking screenshots. It is capable of capturing
images of the whole desktop, a single window, or a selected region. The
images can then be saved in a variety of formats, including JPG and PNG.
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• Website: http://www.ipso-facto.demon.co.uk/ksnapshot/
• KSnapshot Handbook

KolourPaint A simple and easy-to-use paint program, with features such as
basic painting (drawing diagrams and finger painting), image manipula-
tion and icon editing.

• Website: http://kolourpaint.sourceforge.net
• KolourPaint Handbook

Kooka An intuitive raster image scan program. Kooka helps you to handle
the most important scan parameters, find the correct image file format to
save and manage your scanned images.

• Website: http://kooka.kde.org
• Kooka Handbook

RELATED INFORMATION

• Several more advanced KDE graphics applications can be found in the KDE
Extragear; under the Section 7.1, see Section 7.1.2 for a list of a few of them.

6.6 Multimedia

A brief overview of a few of the multimedia-related applications below.

JuK An easy-to-use music player for KDE. JuK is playlist and meta-data fo-
cused, allowing you to quickly search through the dynamic playlist pro-
vided. Some of the features include CD cover-art fetching from Google R©
images, MusicBrainz integration for file identification over the Internet,
and multiple audio backends, including aRts, GStreamer and aKode.

• Website: http://developer.kde.org/ wheeler/juk.html
• JuK Handbook

KMix An application that allows you to change the volume of your sound
card, and it supports several sound drivers. Each mixer device is repre-
sented by a volume slider, and you have basic options such as to mute
that particular mixer device.

• KMix Handbook

Noatun A media player capable of playing WAV, Ogg Vorbis, as well as DivX
encoded AVIs and other media formats. Noatun features audio effects,
a six-band graphic equalizer, a full plugin architecture, network trans-
parency, and various look and feels.

• Website: http://noatun.kde.org
• Noatun Handbook
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RELATED INFORMATION

• Several more advanced KDE multimedia applications can be found in the
KDE Extragear; under the Section 7.1, see Section 7.1.1 for a list of a few of
them.
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Chapter 7

KDE Extragear Applications

Francis Giannaros These are applications that are directly associated with KDE,
the project, but do not appear and are not shipped with the main KDE distri-
bution. This can be down to a number of reasons, but a common case is ei-
ther down to a duplication of functionality, or because they’re simply too spe-
cialised. Perhaps the most popular occurence however is that the developers
themselves may not want it to appear in the main KDE distribution; choosing,
rather, to handle their own release schedules. Nevertheless, the applications in
Extragear are distinguished by KDE, and many are increasingly popular.

7.1 Available in the KDE Extragear

7.1.1 Multimedia

Amarok An advanced and comprehensive music player with the capability to
play MP3, WAV, and OGG audio filetypes and others. There is not room
here to mention all of Amarok’s features, but by default, Amarok can au-
tomatically fetch cover art, embed song lyrics, and display aesthetically
pleasing visualizations. Amarok remains, as much of KDE does, highly
customizable; it contains a powerful scripting interface, and the context
browser can be stylised easily using CSS. Amarok also supports several
backends, including GStreamer, xine, NMM, MAS, aKode and aRts.

• Website: http://amarok.kde.org
• View the handbook by typing help:/amarok in Konqueror’s Location

Toolbar, or by selecting it in KHelpCenter; if you do not already have
Amarok installed (and hence do not have the handbook), then you can
view it online here.
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K3b The definitive CD/DVD burning application for KDE. With K3b you can
create data, video, and audio (it comes with plugins for WAV, MP3, FLAC,
and Ogg Vorbis) CDs. Projects can be saved and loaded, CD-ripping is
supported, and you can appropriately make CD/DVD copies.

• Extragear Summary: http://extragear.kde.org/apps/k3b/
• Website: http://k3b.org
• K3b Handbook

7.1.2 Graphics

digiKam A photo management application which can conveniently organize
and import digital photos. Features include complete tagging functional-
ity, a plugin system, and a fully-featured comment system. digiKam also
makes use of KIPI (KDE Image Plugin Interface), therefore contributing
to the initiative to create a common plugin infrastructure, which allows
development of image plugins that can be shared among graphical ap-
plications in KDE (others include Gwenview, ShowImg and KimDaBa).

• Website: http://digikam.org
• digiKam Handbook

Gwenview Another advanced image viewer which can load and save all im-
age formats supported by KDE, as well as being able to display the GIMP
(*.xcf) image filetype. Gwenview can perform a few graphical manipu-
lations (rotate, mirroring) and has full support for KIO slaves (allowing
you to use it via FTP). Other features also include file management oper-
ations, such as copy, paste, move and delete.

• Website: http://gwenview.sourceforge.net/
• Gwenview Handbook

ShowImg A feature-rich image viewer, written for KDE, which can display
numerous formats, including JPEG, PNG, [animated] GIF and MNG. It
consists of a tree-view frame, a directory/preview frame, and a view
frame. The (larger) view frame can be exchanged with the (smaller) di-
rectory/preview frame. It can preview and display images from multi-
ple directories and search for identical images. ShowImg also features a
full-screen mode, zooming, sorting, drag and drop with Konqueror, and
support for images in compressed archives.

• Website: http://www.jalix.org/projects/showimg/
• ShowImg Handbook

KimDaBa KimDaBa (KDE Image Database) attempts to provide an efficient
solution for the organization of hundreds (or even thousands) of images.
Having been highly optimized for annotating images, KimDaBa can help
you locate an image in a matter of seconds.

• Website: http://ktown.kde.org/kimdaba/
• KimDaBa Handbook
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7.1.3 Network

Konversation A fully-featured IRC client which supports per channel encod-
ing, downloading and resuming file transfers, nick completion and high-
lighting, as well as tight integration with Kontact and the rest of KDE.

• Website: http://konversation.kde.org
• Konversation Handbook

KMldonkey A KDE frontend for MLDonkey, a powerful P2P file-sharing tool.
Highly configurable, real-time graphical bandwidth and network statis-
tics, and much more.

• Website: http://kmldonkey.org/
• KMldonkey Handbook

KNemo Displays for every network interface an icon in the systray. Tooltips
and an info dialog provide further information about the interface. Pas-
sive popups inform about interface changes and a traffic plotter is also
integrated.

• KDE-apps entry: http://www.kde-apps.org/content/show.php?content=12956

7.1.4 Utilities

Filelight A simple, yet ideal, application for graphically displaying where your
diskpace is being used. Filelight displays this information by represent-
ing your filesystem as a set of concentric segmented-rings.

• Website: http://www.methylblue.com/filelight/
• Filelight Handbook

Krecipes A KDE recipe tool that can manage a recipe database with an easy-to-
use interface. Full support for creating and removing ingredients as well
as units; helps with diets, can calculate the amount of calories, vitamins,
carbohydrates etc. Other advantages are its flexilibity and potential to
extend further.

• Website: http://http:/ /krecipes.sourceforge.net
• Krecipes Handbook

7.2 Related Information

RELATED INFORMATION AND LINKS
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• It should be stressed that the above is but a preview of what is available in
the KDE extragear. To view all of the applications and utilities available there
visit http://extragear.kde.org, where a briefer summary of each application
is provided.

• The handbooks for the majority of applications in extragear can be viewed
from http://docs.kde.org.

• Once again, you can find a plethora of other [third-party] KDE applications
at the popular http://kde-apps.org.
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Chapter 8

Multimedia With KDE

8.1 Removable Disks

For KDE to use any device, removable or not, the device must first be mounted.
When a device is mounted, KDE gets all the needed information about the
device: how to read it, how to write information to it, and much more.
The use of a device is controlled by the operating system and it is important
your operating system has tools for managing these devices. KDE can also
auto mount devices, working with HAL (Hardware Abstraction Layer). Your
distribution should have set up HAL automatically; if not, consult the docu-
mentation provided by your distribution.
There are several ways to find the list of media devices: use whichever one
suits you best:

• Enter media:/ or system:/media into the Konqueror location bar.

• Navigate to it by clicking on the Services tab in Konqueror’s Navigation
Panel, then selecting Storage Media.

• Select Go→ Storage Media from the Konqueror menus.

• Click the System desktop icon, then from the window that appears, click on
Storage Media.

The Storage Media location (also known as the media:/ protocol) will show all
devices which are recognized by KDE, including the hard drive and CD and
DVD drives, as well as USB and Firewire devices, provided that your distribu-
tion is set up correctly to tell KDE about them.
You can also setup KDE to display a device icon on the desktop. To start or
configure this feature in the KDE Control Center go to Desktop+Behavior and
select the Device Icons Tab. The device icon action can be used to show both
mounted and unmounted devices, or to only create an icon when media is
detected and automounted (only if automount is properly configured), by not
checking the unmounted boxes.
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8.1.1 Automount

With KDE 3.5 and newer, devices can be automounted, meaning one only has
to insert the removable disk. KDE will then open an automount prompt asking
the user ‘What do you want to do?’ with the media. To configure the list of
options prompted for devices open the KDE Control Center and navigate to
Peripherals+Storage Media Here you can add and remove programs from the
list of devices.
The automount feature will only work if dbus, hal and udev are installed and
the kernel is properly configured. To find out if they are running on your sys-
tem check the Process Table in KSysguard for: hald, dbus-deamon, and udevd.
KDE does not provide any of these components. You must check with you dis-
tribution.
RELATED INFORMATION

• HOWTO: setting up D-BUS and HAL with KDE’s media ioslave edit (A com-
munity maintained HOWTO on the KDE wiki)

• The DBus page

• http://www.freedesktop.org/wiki/Software/halHAL - Hardware Abstrac-
tion Layer

8.1.2 Mounting

If your system does not automount KDE is configured to mount and unmount
devices which the current user have permission to mount. If a device is mounted
as the root partition (i.e. /), and you login to KDE as a user, KDE can not mount
or unmount it without being given a higher permission. To check a devices
mount permission see the /etc/fstab file.

To mount and unmount devices manually in KDE one only has to right mouse
button click the device icon in media:/ or on the desktop and select Mount or
Unmount, for removable devices one can also unmount with Safely Remove.
KDE still requires the device to be setup in /etc/fstab.

8.2 Playing Music

Intro to aRts
Performance tuning, sharing devices

8.2.1 Music Players

There are several KDE music players with somewhat overlapping feature sets,
however, each is quite different in style.
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Noatun Noatun is the default KDE music player. It features a
highly configurable interface, including several styles of playlist man-
ager, and many plugins to provide different GUIs, visualizations, and
other features.
Noatun is part of the kdemultimedia package.

JuK JuK is a media manager, playlist manager, and metadata tag-
ger. It is a highly efficient way to manage all your music files, make and
maintain playlists, and maintain the metadata tags in your music.
It is equally useful as your primary music player, or managing playlists
and files for use in another application.
JuK is part of the kdemultimedia package.
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Kaboodle Kaboodle is a one shot player. That means, it will run,
play a file, and stop. Kaboodle is useful for instance if you want to
quickly listen to a single file without interupting your current playlist
from another media player.
Kaboodle is part of the kdemultimedia package.

amaroK amaroK is a popular third party application. You should
be able to find packages from your normal distribution source.

Most of the KDE based movie players such as Kaffeine and kmplayer also make
useful music players.

8.3 Audio CD Ripping in KDE

The conventional way of ripping Audio CDs to MP3 or Ogg files is to use a
standalone program such as iTunes R©, Winamp or KDE’s own KAudioCreator.
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But if we stick to conventions, where’s the fun?! So in this article, I am going
to show you how to feel elite by ripping your CDs in the, umm.. elite way. ;-)

8.3.1 Ingredients

What do we need to be cool? Vanilla KDE, without any extra ingredients, will
be able to rip your CDs. But to encode them, you’ll need to install the relevant
codecs. At the moment, Ogg Vorbis, MP3 and FLAC formats are supported.
To enable encoding to these formats, you’ll have to install libogg, lame and flac
respectively. How exactly you install these depends on your distribution: take
a look at their documentation to find out how.
Once you have your favourite codec(s) installed, open KDE Control Center
and navigate your way to Sound & Multimedia→ Audio CDs and configure
the settings on the various tabs to your liking. You can leave everything in the
default state if you so wish, but it’s helpful to take a look so you at least know
what’s on offer. Again, take a look at Sound & Multimedia→ CDDB Retrieval
and change anything that’s not to your liking. CDDB, in case you didn’t know,
stands for CD DataBase (or Compact Disc DataBase in its more free flowing
form). This functionality enables KDE to retrieve the Artist/Album/Track in-
formation about your CDs from the Internet. This metadata is also used to
write tags to the MP3 or Ogg files that you’ll be encoding your CDs to anytime
now.

8.3.2 Recipe

Without further delay, let’s get down to the business of being cool. First, pop
in the CD you want to rip (obviously!). Next, fire up a Konqueror window and
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open the Services tab on the Navigation panel. The Navigation panel sits on
the left side of the window, as shown in the screenshot below. If it’s not visible,
you can produce it out of thin air by pressing the magic F9 key.

Now click on Audio CD Browser and in a few seconds, you’ll see a lot of folders
which you can start browsing. If it’s taking some time to show anything, it’s
because it’s trying to fetch information about the CD from the CDDB database
you configured earlier.

In the screenshot below, you can see the contents of the Ogg Vorbis folder. It
shows all the songs in the Ogg format; it even shows their file size! But, you
and I both know that audio CDs don’t contain Ogg tracks. So what exactly is
happening here?
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All the folders you see under Audio CD Browser are virtual folders. They show
contents of the CD through different filters, so to speak. When you open the
Ogg Vorbis folder, you are actually seeing the contents of the CD as if it were
stored in the Ogg format. You can go through the other folders and you’ll find
MP3, flac and wav representations of the CD’s contents. You can even see the
approximate file sizes when encoded in the various formats.

So how do we rip and encode the CD? I think you can guess the answer by
now. Just decide which format you wish to rip to, open that folder, and copy
and paste those files in your target folder. That’s it! KDE will start ripping and
encoding the files on the fly! If you copy any of the files in the Full CD folder,
you’ll be ripping the entire CD as one continuous stream.

RELATED INFORMATION
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• The amaroK website at http://amarok.sf.net has the latest news and infor-
mation about amaroK.

8.4 Playing Movies

Intro to xine plugin to aRts

Alternatives (kaffeine, kmplayer)
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Chapter 9

KDE the Multiuser Desktop

9.1 About Your KDE Account

KDE stores information about your personal settings in a few different places:

• The hidden directory .kde (note the period at the beginning), located in your
home directory, contains a large number of files that store KDE settings.
Some subdirectories you may find useful are:.kde/share/config, which con-
tains configuration files for individual applications; .kde/Autostart, which
contains links to applications which should start each time you start KDE;
and .kde/share/apps/kabc, where your address book is stored.

• The environment variables KDEDIR and KDEDIRS tell KDE where its files are
stored. You will usually only need to set KDEDIR to the directory in which
KDE is installed, but sometimes you might have other KDE programs in-
stalled elsewhere: in this case, you can use the KDEDIRS environment vari-
able. Set KDEDIRS to a list of all the directories containing KDE programs, sep-
arated by commas. For example, if you have KDE programs in both /usr/l-
ocal/kde and /home/phil/kde, you can use export KDEDIR=/usr/local/kde,/home/phil/kde
if you use bash or setenv KDEDIR=/usr/local/kde,/home/phil/kde if you
use sh.

RELATED INFORMATION

• Part VI contains more information about the directories that KDE uses.

9.2 Using KDE as Root

For UNIX R© operating systems there are often different users, which in turn
might have different privileges. The conventional method is to have an or-
dinary user account, whose files are generally stored in /home/username, and

64



The KDE User Guide

then to also have a root account. The root, or Super User, account has system-
wide privileges, being able to modify any file on the system.

Although this means that it is easy to perform administrative tasks without
hassle, it also means that there are no security restrictions imposed upon it.
Thus, a small typographical error or other mistake can result in irrevocable
damage.

Some of the operating systems that run KDE come with a graphical root login
enabled. Despite this, you should never log in to KDE as root, and you should
never need to. Your system is far more open to attack, particularly if you are
browsing the Internet as root, and you dramatically increase your chances of
damaging your system.

Some Linux R© distributions have tried to stress this point so much that they
have disabled the root account altogether, and instead use the sudo model.
Nevertheless, the basic security model in sudo is the same as su, and thus they
share the same security strengths and weaknesses, essentially.

If you should ever need to run a program with Super User privileges, then it is
always recommend that you use KDE su. From Konsole or from hitting Alt+F2,
enter kdesu application, and the application will be run with the appropriate
Super User privileges.

Even if you have set up your system to use sudo, or you are on a distribution
that uses sudo, such as KubuntuTM, you should still use KDE su. The program
will be appropriately modified by the developers to use the correct settings.
You should not, however, ever use sudo application to run an application
with root permissions; it can derange permissions of certain configuration files
for a program. Running a graphical applications as root in general is not a
good idea, but using KDE su will always be your safest bet with it.

RELATED INFORMATION

• KDE su Handbook

9.3 Switching Sessions

From version 3.3 onwards, KDE provides a session management system which
allows you to switch between different user account on one computer. You can
stay logged in and e.g. let your sister, brother, wife, neigbour or whoever read
her or his emails just for a moment. Before you had to log off (therefore e.g.
close programs or save documents) and let her or him log in.

Now it’s almost as easy as switching to another virtual desktop.

SWITCHING SESSIONS: HOW IT WORKS

The Switch User Menu The K menu now bears a new entry. Rather at the
bottom of the menu you will find a Switch User submenu. It contains the
command to lock the current and start a new session which means that
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your desktop will start the screensaver and after a few seconds can log in
with KDM as always. The Start New Session entry skips the activation of
your screensaver.
Once you have running more than one session you can either choose to
press Ctrl+Alt+F7 or F8 and so on (what is usually configured by default)
or — even more comfortable — choose from the list of active sessions at
the bottom of the Switch User submenu.

Switch User with the screensaver If you have activated your screensaver and
another user wants to log in she or he can simply press the Switch User...
button and log into another session.

Switch Session in kdm If you are in kdm and want to switch to another active
session you can press the Menu button and choose Switch User which is
mainly the same as described above.
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Chapter 10

Networking with KDE

10.1 File Sharing

10.1.1 How to share files with kpf

kpf provides simple file sharing using HTTP (the Hyper Text Transfer Proto-
col,) which is the same protocol used by web sites to provide data to your web
browser. kpf is strictly a public fileserver, which means that there are no ac-
cess restrictions to shared files: whatever you select for sharing is available to
anyone.

kpf is designed to be used for sharing files with friends, not to act like a fully-
fledged web server such as Apache. kpf was primarily conceived as an easy
way to share files with others while chatting on IRC (Internet Relay Chat, or
‘chat rooms’.)

kpf runs as an applet inside Kicker. This means that it takes up little space on
your screen and its status is always visible. To start the kpf applet, right click
on Kicker and choose Add Applet to Panel... to open the Add Applet dialog.
Select Public File Server and click the Add to Panel button.
kpf employs the concept of shared folders. You may choose one or more folders
to make public, and all files in that folder (and any subfolders) will be shared.

NOTE
Please be extremely careful about which folders you share. Remember that all files
in the folder and its subfolders, including ‘hidden’ files (‘dotfiles’ to the techies) will
be made available to the world, so be careful not to share sensitive information,
such as passwords, cryptographic keys, your addressbook, documents private to
your organization, etc..
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Once kpf is running, you will see a square applet with a thin sunken bevel and
an icon depicting an hot air balloon. The balloon is visible when no folders are
being shared.

To share a folder, right click on the balloon icon and a pop-up menu will ap-
pear, containing only one item, New Server.... Selecting this entry will cause a
‘wizard’ to appear, which will ask you a few simple questions. Completing the
questions will set up a folder for sharing.

There is an alternative to using the applet directly when you want to share a
folder. kpf is integrated with Konqueror.

With Konqueror open and displaying a folder, right click on the background
and bring up the ‘Properties’ dialog. On install, kpf added a Sharing tab to
this dialog. You will be offered the option of starting kpf if it is not running.
Choosing Ok will send a signal to the kpf applet, asking it to add a new share.

For more detailed information, such as how to share different directories to
different people, see the kpf handbook.

10.2 Networking With Windows

This section is borrowed and modified from Alexander Neundorf’s README
file on LISa.
KDE features two powerful servers called the Lan Information Server (LISa)
and Restricted Lan Information Server (resLISa) which are used to identify
CIFS and other servers on your local network providing a function similar to
‘Network Neighbourhood’ in Microsoft R©Windows R©.

10.2.1 How It Works

Lisa only depends on the TCP/IP stack so samba configuration is not required
to make it work but the samba package is a dependency. To find hosts on
your local network you set a range of IP-Addresses in your configuration file
that Lisa will check. When you start the Lisa daemon it will send a ICMP, echo
request message to all the IP addresses given in the configuration file and await
a response.

NOTE
The Lisa daemon requires root privileges to open the socket, but once the socket
has been established root privileges are immediately dropped.

You can also execute Lisa using nmblookup "*".

NOTE
If you do not have the nmblookup program it can be found at http://www.samba.org
or through packages provided by your distribution
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. The samba command nmblookup "*" will send a broadcast message to the
attached network and any host that is running the smb-services will send a
reply stating that it is accepting connections.

10.2.2 resLISa

If your company network has very strict guidelines governing what ports can
and cannot be opened you will have to use ResLisa to communicate with other
hosts on your network. Because ResLisa cannot ping entire networks or ad-
dress ranges you will have to add each host by name to your confiuration
file. Currently you are able to add up to 64 hosts, and these addresses are
pingable.

NOTE
ResLisa will only provide the information over a UNIX R© domain socket, i.e. not
over the network. The name of the socket is /tmp/resLISa-YourLoginName, so
ResLisa can be safely run on the same machine by more than one user.

10.2.3 Configuration

At startup Lisa first parses the configuration file in the users home directory
under $HOME/.lisarc. If this file does not exist Lisa will then look for a system
wide confiuration located at /etc/lisarc. Now for a sample example config-
uration file:

PingAddresses = ←↩
192.168.100.0/255.255.255.0;192.168.100.10 -192.168.199.19;192.168.200.1; ←↩

PingNames = my_host1;my_host2 #Hosts by name (required for ←↩
resLISa)

AllowedAddresses = 192.168.0.0/255.255.0.0
BroadcastNetwork = 192.168.100.0/255.255.255.0
SearchUsingNmblookup = 1 #also try nmblookup
FirstWait = 30 #30 one -hundredth ’s of a ←↩

second
SecondWait = -1 #Only try once
#SecondWait = 60 #Try twice and wait 0.6 ←↩

seconds
UpdatePeriod = 300 #Update every 300 sec ’s
DeliverUnnamedHosts = 0 #Don ’t publish unnamed hosts
MaxPingsAtOnce = 256 #Send up to 256 ICMP echo ←↩

requests at once

Lisa can also be configured graphically in the KDE Control Center→ Internet
& Network→ Local Network Browsing item in the K menu. However, to use
this option Lisa must be started with the -K command line switch.

RELATED INFORMATION
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• For a full list of command line switches and further examples see the entire
Lisa manual by entering help:/lisa in Konqueror.

10.3 Shared Sessions

Sharing your desktop with krfb and pals
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Chapter 11

Graphics, Printing, and Fonts

11.1 Setting Up a Printer

Assume everything is pre-configured, how to set up a printer, refer to big man-
ual if there is trouble

11.2 Printing From Applications

Printing from KDE apps

Printing from non-kde apps

11.3 PDF Files

How to print to a pdf file

Viewing pdf files

11.4 Fonts - Installing and Configuring

Fonts are really easy to configure in KDE. Open up the Control Center (with K-
Menu→Control Center) and choose Font Installer in System Administrationin
the tree view.
There are two kinds of fonts: Personal and Global fonts. Personal fonts are
only accessible to your user, whereas global fonts are accessible to everyone.
When you open the Font Installer, you’re in Personal mode (you can see this
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in the Location bar). When you click on the Administrator Mode button, and
put the root password, you can access global mode, where you can change the
fonts for every user on this computer.

For the rest, there is no difference between those two kind of fonts. There is a
list of fonts in the center. Click on a font to see a preview. In the toolbar on the
top you have buttons to access the top directory, refresh and change the view.

If you want to, you can organise your fonts in multiple directories, so that you
can easily find them later. To install a font, click on the Add Fonts... button. A
file open dialog will appear where you can choose your font.

Alternatively, you can drag fonts from Konqueror to the list. To remove a font,
right click on it and choose Delete.

Configuration (anti-aliasing)

kfontinst and kfontview should probably get a mention too, since they don’t
seem to have any existing docs.

11.5 Creating Graphics

How to create graphics with KDE apps.. (ok, maybe not)
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Chapter 12

Customizing the Appearance
of your KDE Desktop

Juan Carlos Torres Changing the appearance of your KDE desktop can be done
quite easily and flexibly by either individually controlling different parts of the
visual appearance or by using a predefined theme. This guide explains the
various customizable parts of KDE and how to control their appearance.

12.1 Background

The desktop background, more commonly known as the wallpaper, allows you
to display certain images on your desktop. The settings for the background
are found in the KDE Control Center, or by right-clicking on the desktop and
selecting Configure Desktop....

In KDE, you have the option to use no picture, a single picture, or a slideshow
of images. If No picture is chosen to be the desktop background, the Colors op-
tions are used instead. You can also choose whether to use a single background
on all virtual desktops or to apply a different background for each desktop.
This is done by selecting All desktops or the specific desktop name from the
drop-down menu.

Other background images can be downloaded using the Get New Wallpapers
button on the right or you can visit the Wallpapers section of the kde-look.org
website.

12.2 Colors

The Colors settings of the KDE Control Center allow you to control the colors
that are used for various window elements, such as window titlebars, window
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backgrounds, text, and buttons. You can change the color of each window
element by selecting the element from the drop down list and choosing a color
for it. You can then save your changes by clicking on Save Scheme.... This
will save your settings in a Color Scheme file. Color schemes are text files,
with a .kcsrc extension, that contain entries for each window widget and its
color, in RGB format. It is also very easy to add color schemes that you have
downloaded by clicking on Import Scheme... and pointing to the .kcsrc file.
With color schemes, you can save the changes you have done in one convenient
file or easily change to a predefined color setting, without having to change
each window element separately.

Additional color schemes can be downloaded from the Color Schemes section
of kde-look.org.

12.3 Icons

An icon theme contains the images used to represent actions, files, devices, and
applications. Managing icon themes is easily done through the Icons module
in the KDE Control Center. Simply select the icon theme you want to use and
click on Apply to switch to the new theme. To install new icon themes, all you
need to do is to click on Install New Theme... and browse to the location of the
icon theme archive. There is no need to extract the contents of the archive into
a directory. In fact, the Icons module only accepts archived icon themes. To re-
move an icon theme, simply select the theme from the list and click on Remove
Theme. Note that you cannot remove the icon theme that you are currently
using. You need to switch to some other theme before the current one will be-
come removable. You also cannot remove icon themes that were installed by
the administrator (root) or by your distribution’s package manager.

Other icon themes can be found in the Icon Themes subsection of kde-look.org.
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12.4 Splash Screen

The default KDE splash screen

The splash screen is the animated image or screen that is displayed while KDE
loads after you log in. Each user can have a different splash screen. Changing
the splash screen for the current user can be done in the Splash Screen module
of the KDE Control Center. Select the splash screen you want to use and click
on Apply. You can also test what a splash screen will look like by selecting the
splash screen and clicking on Test. Installing a new splash theme is very easy.
Just click on Add... and browse to the splash screen archive you want to add.
There is no need to extract the contents of the archive. Removing splash screens
is also easily done by selecting the splash screen and clicking on Remove. Note
that you cannot remove splash screens installed by the administrator (root) or
by your distribution’s package manager.

Splash screen themes can be found on kde-look.org, in the Splash Screens sec-
tion. Take note that some splash screens require a specific KSplash engine to
be installed.
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12.5 Window Decorations

You can change the appearance of window borders, titlebars and buttons in
KDE using window decorations. Some window decorations even have the
capability to apply effects such as translucency. Window decorations must be
able to do all these without sacrificing speed and performance. This is the
reason why window decorations come in source code that must be compiled,
or as binary packages that must be installed. Basically, Window decorations
are plugins or small programs that instruct KWin, KDE’s Window Manager,
how to display window frames.

In order to add a new window decoration, you need to compile it from source
code. If a binary package for your distribution or system is provided, you
simply need to install it using your distribution’s package manager. Please re-
fer to your distribution’s manual for instructions on how to do this. Once the
window decoration has been installed, it can be accessed in the Window Dec-
orations settings in the KDE Control Center. In the Window Decoration tab, a
list of installed window decorations can be seen in the drop down box. Simply
select the decoration you want to use and click on Apply. Different window
decorations have different capabilities and settings. Play around with the dif-
ferent options available. The Buttons tab allows you to control the buttons on
the window titlebar. Enable the Use custom titlebar button positions check box
in order to rearrange, remove, or add buttons. To add buttons to the titlebar,
drag an item from the list to the titlebar preview above it. To remove a button,
drag the button from the titlebar preview to the item list. Simply drag buttons
in the titlebar preview to rearrange them.

While all window decorations need to be compiled from source code, some
window decorations can load pixmap-based theme files that do not need to
be compiled. KDE ships with a pixmap-based window decoration called the
IceWM window decoration. Another pixmap-based window decoration is
deKorator, which can be found on kde-look.org. Please refer to your distribu-
tion’s documentation on how to install these. The advantage of using pixmap-
based window decorations is it is relatively easy to make themes for them, by
using images and editing a configuration file. The tradeoff is a slight loss of
performance, while this may be unnoticeable on very fast systems.

To add an IceWM theme, select IceWM as the window decoration and click on
the Open KDE’s IceWM theme folder link in the window decoration descrip-
tion area. This will open a Konqueror window to $KDEHOME/share/apps/kwin/icewm-themes.
Extract your IceWM theme to this folder. The theme will then be added to the
list of IceWM themes. Select the theme you want to use and click on Apply.

To add a deKorator theme after you’ve installed deKorator, select deKorator
from the window decorations list and go to the Themes tab. Click on Install
New Theme and locate your deKorator theme archive. Make sure that the
version of the deKorator theme matches the deKorator version installed on
your system. Once the theme has been added, select the theme you want to
use and click on Set Theme Paths. Click on Apply for the changes to take
effect.
Some more window decorations are available at kde-look.org under the Native
KDE 3.x and the Native KDE 3.2+ subsections. Themes for the IceWM and
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deKorator window decorations have their own subsections under the Window
Decorations category.

12.6 Style

Widgets are the basic elements of a graphical user interface, such as buttons,
scrollbars, tabs, and menus. A widget style is a plugin or a small program that
instructs KDE how widgets are displayed. Since widgets are the very basic
parts of an interface, they are frequently accessed and must be able to respond
very quickly. This is why widget styles must come as source code to be com-
piled or as binary packages to be installed, just like window decorations. Please
refer to your distribution’s documentation on how to compile from source or
install binary packages.

Once a widget style has been installed, it will be added to the list of available
styles in the Style module in the KDE Control Center. The Style tab allows
you to select a widget style from the list and to configure it if the style has
a Configure... feature. Different styles have different options. A preview of
the selected style is available at the lower portion of the tab. The Effects tab
controls different visual effects for some widgets like comboboxes and tooltips.
The Toolbar tab gives some options on the general appearance of toolbars.

Additional widget styles can be found in the different KDE subsections of the
Themes/Styles of kde-look.org. Take note that styles come in source code or
binary package forms. They are not KDE theme files.

12.7 KDE Theme

KDE allows you to save the different changes you made to your desktop’s ap-
pearance in one file, using the Theme Manager in KDE Control Center. Once
you have set up your desktop the way you want, click on Create New Theme....
Enter the details you want to give your theme, such as theme name, author,
version, etc., then click OK when done. This will add your theme to the list of
available themes and save your settings in a KDE theme. A KDE theme (.kth
file) instructs KDE on what window decoration, style, or color scheme to use
for that particular theme. To add a KDE theme from an outside source, click on
Install New Theme... and locate the KDE theme file. Removing a theme is eas-
ily done by clicking on Remove Theme. If you made changes to your theme,
you have to either create a new theme name for it, or remove the previous
version first to be able to use the same theme name.
The following are the settings that are saved and indicated in a KDE Theme:

• Background

• Screen Saver

• Icon Theme
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• System Notifications

• Color Scheme

• Cursor Theme

• Window Decoration

• Konqueror background (File Management)

• Panel background

• Style

• Fonts

One very important thing to consider when using or installing a KDE Theme is
that it only indicates what settings to use for the above. A KDE Theme includes
only system notifications, desktop background, panel background, Konqueror
background, and the color scheme in its package. The other components must
be installed separately if they do not already come with KDE.

KDE Themes can be downloaded from the Theme-Manager subsection of kde-
look.org, under the Themes/Styles section.

12.8 Glossary

Background Background/wallpaper image or color for the desktop

Color Scheme (.kcsrc) Configuration file that indicates what colors to use for
certain widgets

Icons Images representing applications, files, devices, etc.

Splash Screen Animated image or screen that displays while KDE loads after
logging in

Window Decoration Plugins or small programs that instruct the window man-
ager how to display window frames

Style Plugin or a small program that instructs KDE how widgets are displayed

KDE Theme (.kth) A file that contains instructions on what settings to use for
different GUI components

Widgets Basic elements that build up a graphical user interface: buttons, scroll-
bars, menus, tabs, etc.
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Chapter 13

Konsole Introduction

Gardner Bell Extremely brief intro to managing in a shell

Emergency procedures: killing wild apps, etc

SSH, sessions, envars, other fun things

Some tips and tricks

Konsole is a terminal emulator for the X Window System. It is essentially based
on the DEC’s VT100 and many of its succesors. Konsole – also referred to as a
shell – is an essential tool on Linux R© and UNIX R© based machines for fast and
productive work.

Emergency Procedures:

On Linux R© and UNIX R©-based systems every process runs independently in
its own memory space so it can’t accidentally overwrite any other processes
memory, unless of course it has root privileges. If a process in KDE crashes
due to a bug one should not need to worry about it accessing any other active
process.

To keep track of all system processes use the top command or ps in Konsole.
Using these utilities will make it much easier to find and kill off rogue pro-
grams.

An example of using signals in Konsole, Konqueror has crashed leaving behind
a running process of nspluginviewer which is taking up 12% of your memory
and 10% of your cpu cycles. In top use the k command switch to kill the task.
You will be prompted for the PID and then the signal to send to kill it. For more
on info on what signals you can send to a running process see the full manual
on signals (type man signal in a Konsole or go to #signal in Konqueror).

SSH, sessions, envars, other fun things.

If you are using Konsole for remote administration consider using Konsole’s
‘Session’ feature. To use this click on the menu entry Settings→ Configure
Konsole. From here choose the Sessions tab and fill in the name for your new
session. This will now become your default session when you start Konsole.
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When Konsole is invoked bash specific commands and KDE specific variables
are read and executed from /.bashrc or /.bash_profile. The preferred con-
figuration file for user environments is /.bash_profile, the commands print-
env or env can be used to display all currently set variables. To set a variable
in the shell use VARNAME=value. For a full list of variables that can be set in
KDE see the wiki .
Some tips and tricks

To rename Konsole’s session use Ctrl+Alt+S and enter the new name.
If you find the need to run any KDE program with root privileges, you can
use the KDE su command with the -c switch from the command line like this:
kdesu -c -n PROGRAM , using the -n switch will prevent KDE from remem-
bering your passwords.

RELATED INFORMATION

• The Konsole Handbook has much more information about the features avail-
able in Konsole. You can read it in KHelpCenter or by entering help:/konsole
in Konqueror’s Location bar.
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Chapter 14

KDE Edutainment

The KDE Edutainment Project offers children, families, and teachers some ed-
ucational programs. You can find applications to help you improve your lan-
guage skills and train your vocabulary, like KVocTrain and KWordQuiz; or
Scientific programs, like the very advanced KStars (a planetarium) and Kig (in-
teractive geometry), which will bring you to the edge of knowledge. Have fun
learning touch-typing with KTouch. Teachers will find an easy way to make
their lessons with KEduca. You can find a complete list of KDE educational
software on the KDE-Edu website. What follows is an overview of a few of
them.
View the handbook of each application by typing help:/<appname> in Kon-
queror’s Location Toolbar, or by selecting it in KHelpCenter.

14.1 Improve your language skills

KHangMan An easy-to-use application which implements the classical hang-
man game. You can choose for the words to be from a particular topic
and even choose from a selection of difficulty levels. The program comes
in twenty-four languages, and is therefore quite ideal for learning the
spelling of basic nouns in other languages.

• Website: http://edu.kde.org/khangman
• KHangMan Handbook

KLettres An application specially designed to help the user learn the alphabet
of a new language and then to learn to read simple syllables. Ideal for
children, or any person attempting to learn and familiarize themselves
with a foreign language’s alphabet. A number of alphabets are currently
supported.

• Website: http://edu.kde.org/klettres
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• KLettres Handbook

Kanagram A simple mind-training game, in which you have to figure out the
word that has been given in the program. The letters from the word are
disordered, and from the given words you have to solve which word
the letters might make, if rearranged. Similar to the popular Countdown
game as seen on Television.

• Website: http://edu.kde.org/kanagram
• Kanagram Handbook

KVerbos A simple way to learn and study Spanish verb forms. The program
suggests a verb and a tense and the user enters the different forms. The
program corrects the user input and gives feedback. The user can edit the
list of the verbs that can be studied and the program can build regular
verb forms, and the forms of the most important verb groups, by itself.
Irregular verb forms can be entered by the user.

• Website: http://edu.kde.org/kverbos
• KVerbos Handbook

KVocTrain Another advanced vocabulary training application, using the flash
card approach. Vocabulary files can be downloaded and loaded into the
application.

• Website: http://edu.kde.org/kvoctrain
• KVocTrain Handbook

Kiten A Japanese reference and learning tool. Words from both English and
Japanese can be looked up, and filtered, using the Edict and Kanjidic dic-
tionary protocols. Other features in Kiten include a few comprehensive
search functions, a history of searches, and a learning section which con-
tains various different learning modes.

• Website: http://edu.kde.org/kiten
• Kiten Handbook

KLatin A program to help revise Latin. There are vocabulary, grammar, and
verb testing sections. In addition there is a set of revision notes that can
be used for self-guided revision.

• Website: http://edu.kde.org/klatin
• KLatin Handbook

14.2 Mathematics

Several applications to help you with Mathematics and Geometry.
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KBruch An application with several exercise types in order to enhance your
calculating with fractions. Different tasks include exercises to find the
sum of two fractions, the conversion of fractions into the respective deci-
mal, the comparison (with less than, more than) of fractions, and more.

• Website: http://edu.kde.org/kbruch
• KBruch Handbook

Kig A great application with interactive geometry. Ideal for teachers attempt-
ing to draw a graph on the computer, or students who wish to find out
more and investigate with graphs and curves. Currently many things are
supported, and you can very easily construct several things from parabo-
las and hyperbolas, to ellipses.

• Website: http://edu.kde.org/kig
• Kig Handbook

KPercentage Essentially an application to help you improve your skills in cal-
culating percentages. Different exercises are included, and there are vary-
ing difficulty levels to target persons with varying abilities.

• Website: http://edu.kde.org/kpercentage
• KPercentage Handbook

KmPlot A mathematical function plotter. It has built in a powerful parser. You
can plot different functions simultaneously and combine their function
terms to build new functions. KmPlot supports functions with parame-
ters and functions in polar coordinates. Several grid modes are possible
and plots may be printed with high precision in correct scale.

• Website: http://edu.kde.org/kmplot
• KmPlot Handbook

14.3 Science

KStars A desktop Planetarium for KDE. It provides an accurate graphical sim-
ulation of the night sky, from any location on Earth, at any date and time.
The display includes 130,000 stars, 13,000 deep-sky objects, all 8 planets,
the Sun and Moon, and thousands of comets and asteroids.

• Website: http://edu.kde.org/kstars
• KStars Handbook

Kalzium A fully-featured periodic table application. It features a full list of all
elements, and extended information about each individual element. As
well as being able to view a basic overview, other features include being
able to view its chemical data, atomic model, energies, as well as a picture
of the element.
• Website: http://edu.kde.org/kalzium
• Kalzium Handbook
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14.4 Teaching Tools

KEduca A flash card application, which allows you to make interactive form-
based tests. It also currently comes with support to add servers from
which you can fetch tests. Several languages supported.

• Website: http://edu.kde.org/keduca
• KEduca Handbook

14.5 Miscellaneous

KTouch An application for learning touch-typing. KTouch displays the key-
board on the screen, and the color of the keys changes when they need to
be depressed. Text appears on the screen, and the user is asked to type it
out. A few lectures are contained in the program by default, with various
different difficulty levels.

• Website: http://edu.kde.org/ktouch
• KTouch Handbook

KWordQuiz A flash card application, which allows you to make interactive
form-based tests. It also currently comes with support to add servers
from which you can fetch tests from. Several languages supported.

• Website: http://edu.kde.org/kwordquiz
• KWordQuiz Handbook

KTurtle An educational programming environment using the Logo program-
ming language, with several languages currently supported.

• Website: http://edu.kde.org/kturtle
• KTurtle Handbook

KGeography KGeography is a geography learning tool for KDE. You can browse
the maps by clicking in a map division to see its name and you can also
answer several types of questions where the program shows you a map
division or a capital for example and you have to guess its name.

• Website: http://kgeography.berlios.de/ and http://edu.kde.org/kgeography
• KGeography Handbook

Blinken Blinken is a Simon Says game for KDE. The player should remember
the sequence of lights in the correct order and is then presented with an
identical sequence with one extra step.

• Website: http://edu.kde.org/blinken
• Blinken Handbook
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14.6 Related Information

• The KDE-Edu website at http://edu.kde.org has news and information about
all the KDE Edutainment applications.
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Chapter 15

Accessibility

Gary Cramblitt KDEAP (the KDE Accessibility Project) aims to ensure that
KDE, as a desktop environment, is accessible to all users, including those of
us with physical disabilities. In addition to the accessibility aids in the Control
Center, KDE has several other accessibility tools, which are available in the
KDE-Accessibility package. This package may not be installed on your com-
puter; if it is not, you can download it from here:

• kdeaccessibility-1.0.0.tar.gz, or kdeaccessibility-1.0.0.tar.bz2

• MD5

• lsm file

For more information on the project, visit the KDE Accessibility Home Page.

15.1 KMouseTool

KMouseTool is a KDE program, which clicks the mouse for you, so you do not
have to. KMouseTool works with any mouse or pointing device.
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RELATED INFORMATION

• MouseTool Website: http://mousetool.com

• KMouseTool Handbook

15.2 KMagnifier

KMagnifier (or kmag, to use its UNIX R© name) is a small utility for Linux to
magnify a part of the screen. It magnifies the area of the screen around the
mouse pointer or, optionally, a user-defined area. Additionally, it can save a
magnified screenshot to disk.
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RELATED INFORMATION

• Website: http://kmag.sourceforge.net

• KMag Handbook

15.3 KMouth

KMouth is a KDE program which enables people who cannot speak to let their
computer speak, e.g. mutal people or people who have lost their voice. It has
a text-input field and speaks the sentences that you enter. It also has support
for user-defined phrasebooks.
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RELATED INFORMATION

• Website: http://www.schmi-dt.de/kmouth/index.en.html

• KMouth Handbook
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15.4 KTTS - Text-to-Speech

KTTS is a KDE application for the conversion of text into audible speech. Cur-
rently, since KDE 3.4, you can use KTTS to speak any text from the Klipper, the
KDE clipboard, any text from a plain text file (using Kate or otherwise), speak
any portion of text from a HTML page in Konqueror, and much more.

To get KTTS up-and-running you will need to start by running kttsmgr, the
KDE Text-to-Speech manager.

RELATED INFORMATION

• Website: http://accessibility.kde.org/developer/kttsd/

• KTTSD Handbook
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Chapter 16

Tinkering Under the Hood of
KDE

16.1 Hand-Editing Configuration Files

16.1.1 Introduction

In KDE, the configuration files are easy to edit with a simple editor like Kate as
the configuration files are text files.

An example of a text file:

[General]
AutoSave=1
LastFile=/var/tmp/test.txt

The user-specific configuration files are stored in .kde/share/config (replace
.kde with your $KDEHOME setting) and the global ones are in the share/config
sub-directory of KDE’s installation path. (You can find this path by running the
command kde4-config --prefix.) Their filenames typically end in rc (without an
initial period), for example kopeterc.

WARNING
Editing configuration files by hand can risk the stability of your KDE installation.
Applications usually do not check what they read from the configuration files. This
means that they can be disturbed by what they get as configuration and might even
crash.
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16.1.2 Backups

So the first rule is to make a backup of your file before modifying it. The backup
is better stored outside any .kde subdirectory (or the corresponding $KDEHO-
ME directory). Backups are anyway a good idea in case of a major failure of
KDE that would destroy important configuration files (for example your KMail
settings, which are in the file kmailrc). (Such a major failure should not happen
but it still can happen.)

16.1.3 Editing

So why would you want to touch the configuration files at all? Well, first you
need it when you want to enforce the KIOSK mode. Perhaps a developer has
asked you to add an entry to help him to solve a problem with the application.
Perhaps you want to recover from a problem without having to remove all the
.kde directory. Perhaps you want to learn more about the depths of KDE.

Anyway, whatever your reason, you want to modify by hand a configuration
file.
When planning to edit such a file, make sure that the application using it is
not running. If it is one of the basic configuration files, consider editing the file
while KDE is not running at all.

Ready? So make a backup of the file (Did I tell you this already?), start you
favorite editor (let us assume it is Kate), load the file (Be careful to load as
UTF-8, Kate displays it as ‘utf8’).

Now you have a file like:

[Group]
Key1=Value1
Key2=Value2
Key3=Value3

You can now modify it (with care!) and then save it (Be sure that it is as UTF-8
again).

Now you can test the application and if the application does not run correctly
anymore, close the application and restore the backup of the configuration file.

RELATED INFORMATION

• Part VI has more information about KDE’s directory structure, to help you
find the file you need to edit.

16.2 Scripting the Desktop

KDE provides a powerful interprocess communication system in DCOP, the
Desktop COmmunication Protocol. Using DCOP, you can control a wide range
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of functions in KDE from the command line or from a script written in your
favorite scripting language. You can also get information out of KDE applica-
tions: for example, several KDE media players provide methods to query the
player for information about the currently-playing track.

Broadly speaking, each KDE application provides one or more DCOP inter-
faces, which in turn provide methods (or, if you prefer, functions) that another
application can call. So, the first step in using DCOP is to find the appropriate
method for the task. The easiest way to do this is using the kdcop frontend to
the available DCOP methods.
Run kdcop from a Konsole or the mini-CLI (the window which pops up on
Alt+F2). The kdcop window shows the applications currently running which
provide DCOP interfaces, using a tree view. In general, finding the correct
method requires a little bit of searching through the tree view, but a useful hint
is that the interface marked ‘(default)’ usually contains the most frequently-
used functions.
To test that the function does what we expect, double-click on the setColor
entry. To set the color c, click on the color selector button, and choose a color.
Set whether the color should be color A with the checkbox. Click OK and the
background color is set.

To access the DCOP method from your favorite scripting language, you can
either use DCOP bindings, if available in the kdebindings module, or call the
dcop command-line application. For simple usage, calling the dcop command-
line application is sufficient. To call a DCOP method on the command line, we
need to specify the application and interface owning the method, the method
itself, and the arguments, in a form suitable for the shell.

We specify the application, interface and method in that order, followed by the
arguments in the same order that they are shown in kdcop. dcop has plenty of
other options: take a look at the output of dcop --help.

That’s enough theory: time for an example:
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Example 16.1 A Background Color Changing Script with DCOP
With the dcop command-line application and a little bit of Perl, we’re going to
make a simple script which slowly cycles the desktop background through the
spectrum.
Firstly, we look for the appropriate method with kdcop. For this example, we’ll
short circuit the searching, and go straight to it: the method we want is kdesk-
top→ KBackgroundIface→ setColor. The arguments and return type of the
function are shown in the style of the C++ language. For setColor, the argu-
ments are a color, c, which specifies the new background color, and a boolean
(true or false) value, isColorA, which specifies whether the color is the first or
second (this is useful for setting gradients and so on).
To use our setColor method on the command line, we use the following:

% dcop kdesktop KBackgroundIface setColor ’#ffffff ’ false

To specify the color, we used the hexadecimal RGB value, as used in HTML.
Note that it is enclosed in single quotes to protect the # from the shell.
To find the hexadecimal RGB value of a color, open any color chooser dialog in
a KDE application (for example, in KDE Control Center, Appearance & Themes
→Colors), select the color you want, and use the value given in the HTML text
box.
So, that’s all we need from DCOP; now it’s just a case of writing a script around
it. Here’s a (very!) rough implementation:

$min=49; # Minimum value of R, G, or B colour
$max=174; # Maximum value of R, G, or B colour
$step=5; # Amount to step colour by on each step
$sleeptime =15; # Interval in seconds between each step

@start = ($max , $min , $min);
@colour = @start;

while (1) {
foreach (0..5) {

my $which = $_ % 3; # Which colour (R, G or B) to change
my $updown = $_ % 2; # Whether to increase or decrease ←↩

the colour value
do {

if ($updown == 0) { $colour[$which]+=$step; }
if ($updown == 1) { $colour[$which]-=$step; }
my $dcopcall=sprintf "dcop kdesktop KBackgroundIface ←↩

setColor ’#%x%x%x’ true\n", @colour;
system($dcopcall);
sleep $sleeptime;
} while (($colour[$which] >= $min) and ($colour[$which] ←↩

<= $max));
}

}

Just run the script with no arguments, and it will cycle the background colour
through a slightly muted spectrum until it is killed. Voilà!96



The KDE User Guide

Of course, Perl isn’t the only language you can use to write scripts with DCOP—if
you prefer shell scripting, that’s available too:

Example 16.2 Setting a background from the Internet
The following script gets the main image from the ‘User Friendly’ comic strip
and sets it as the desktop wallpaper, using commonly available tools and a
little bit of DCOP:

#!/bin/sh
COMICURL=‘wget -qO - http://www.userfriendly.org/static/index ←↩

.html | \
grep Latest | sed -e "s,.*SRC=\",," -e "s,\">.*,,"‘

TMPFILE=‘mktemp /tmp/$0.XXXXXX ‘ || exit 1
wget -q -O $TMPFILE $COMICURL
dcop kdesktop KBackgroundIface setWallpaper $TMPFILE 1

The first line after the #!/bin/sh uses wget and some regular expression magic
to extract the image location from the main page’s HTML source. The second
and third lines download the image, and finally, dcop sets the downloaded
image as wallpaper.

16.3 Adding Extra Keybindings to KDE

Many modern keyboards contain extra keys that are not by default assigned to
any action.

‘Multimedia’ keys often generate a signal, and can simply be chosen as a key-
binding within an application just like choosing any other key. Some keys
however, are not detected and pressing them in a Configure Shortcuts has no
effect.
Some IBM laptops, for instance, have extra keys about the left and right arrows,
which look like page left and page right.

1. Use xev to find the code of the keys. In this case, they are 233 and 234

2. Choose key symbols. There are quite a range of these that are not used
by default, so many are free. You can find the list in /usr/X11R6/inclu-
de/X11/keysymdef.h (or its equivalent on your system).

3. Create a file in your home directory called .Xmodmap, and add to it the
following:

keycode 233 = Next_Virtual_Screen
keycode 234 = Prev_Virtual_Screen

4. Run the command xmodmap /.Xmodmap
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At this point, you should be able to run xev again and see that the keys now
generate the keysym that you assigned. You can now simply assign them to
any action as normal.

RELATED INFORMATION

• The xev manpage. You can see this by typing man:/xev into a Konqueror
window or by typing man xev into a terminal.

16.4 Adding Keybindings for New Actions

Most actions in either the desktop or in applications are readily available to
assign a keybinding to. If the action you want a shortcut for is something you
wrote yourself, or is otherwise not available, you can still assign a shortcut.

To bring together the two previous sections, perhaps you want to assign an
otherwise unused key on your keyboard to a script or dcop command. Our
example here will be to assign the two keys we added in Section 16.3 to go to
the previous or next virtual desktop, two functions for which you will need
DCOP (as discussed in Section 16.2).

This can be achieved easily using the following method:

1. Open KControl, and in the Regional & Accessibility section, select Input
Action

2. Choose New Action

3. Name the new action, e.g. Next Virtual Screen

4. Select Keyboard shortcut -> Command/URL (simple) for the Action type:

5. In the Keyboard Shortcut tab, click the button you wish to use to trigger
the command. For this example, you would press the one with the Next
Page picture on it. Next_Virtual_Screen will appear in the key image.

6. In the Command/URL Settings tab, enter the command to run in the
field: dcop kwin default nextDesktop

Repeat the above with the Prev_Virtual_Screen key and dcop kwin default
previousDesktop.
Now pressing the Prev_Virtual_Screen or Next_Virtual_Screen will switch you
to the previous or next virtual desktop, respectively.

Obviously you can assign any free key to any action.

RELATED INFORMATION

• See the KHotKeys documentation by looking it up in KHelpCenter, or typing
help:/khotkeys in a Konqueror window.

• Section 16.3
• Section 16.2
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16.5 KDebugDialog - Controlling KDE’s Debugging
Output

16.5.1 Basic Usage

KDebugDialog is not in the K menu by default. You will need to run it from the
shell or from the mini-CLI with the command kdebugdialog. KDebugDialog
pops up a window with a long list of debugging areas. Each area has a check-
box that you can check or uncheck in order to enable or disable debugging
output for that part of KDE.

The list of debugging areas is sorted numerically, not alphabetically, so kio
(127) comes before artskde (400). The numbers go up to 200000 or so, but there
are really only 400 areas. You don’t have to scroll through the entire list to find
the area you need, though. There is a line edit box at the top of the dialog where
you can enter a part of the name of the area you want. The list of entries that
is displayed is filtered to include only those debug areas that contain the text
you have entered. e.g. entering k does not filter very much at all, but entering
kont will show you just the Kontact debugging areas. As an even quicker way
of enabling or disabling debugging output, there are also select all and deselect
all buttons which will cause KDE to produce a mountain of debugging output,
or very little.

16.5.2 KDebugDialog in full mode

In full mode, which is what you get when you start kdebugdialog as kdebugdialog
--fullmode, the same list of debugging areas as in plain mode is available, but
you can select only one at a time from a drop-down box. You may then inde-
pendently set the output for various types of messages: Information, Warning,
Error and Fatal Error. For each of these types, you can choose where the mes-
sages are sent. The choices are:

File, in which case you can enter a filename. This file is written into your $HOME
directory.

Message Box. Each debugging message is displayed in an information dialog,
which you must OK to continue with the application.

Shell, the default entry. Messages are printed to stderr, and will appear either
in the shell window where the application was started, or in .xsession-erro-
rs.
Syslog. This sends each debugging message to the system’s syslog facility,
which can perform its own processing of the message.

None. This suppresses the output of this type of message.

For messages generated by fatal errors, it is generally a bad idea to choose
None or Syslog, since in both cases you most likely will not see the message
and the application that encounters the fatal error will vanish without leaving
a clue as to why it vanishes. Whether or not the application will vanish on fatal
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errors can be controlled by the checkbox abort on fatal errors, which is checked
by default — but you might expect an application to crash (in a messy fashion)
if a fatal error is encountered anyway.
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Part IV

KDE and the Internet
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Chapter 17

Setting up an Internet
Connection

Lauri Watts KDE offers a complete Internet experience, with all the programs
you’ll need to make the most of the Web, email, Usenet and many other In-
ternet technologies. But before you can enjoy KDE’s advanced features, you’ll
need to get online. Here’s how:

If you’re using ‘dialup’ (that is, connecting to the Internet with a modem con-
nected to a telephone line), you’ll want to set up the KDE dialing program,
KPPP. If that sounds complicated, don’t worry: KPPP has an advanced config-
uration wizard, which will usually take the pain out of setting up your dialup
connection. Take a look at the next two sections for more details.
If you’re using a broadband connection, or connecting via a local network,
things are easier (from the point of view of KDE). Once you’ve set up the con-
nection with the tools provided by your Linux R© or UNIX R© distribution, KDE
will use the connection automatically.

17.1 Getting online the easy way

17.1.1 A few things you should have ready before you start

If you have a fairly modern Linux R© distribution, you might find the rest of this
document superfluous. KPPP comes with a clever little wizard that in many
cases can have you up and running with an internet connection in just a few
minutes.
Whether using the wizard or not, you should know the following information
before you begin:

• Your ISP modem pool phone number.
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• Your username and password for your ISP.

• Your ISP’s DNS servers (one is sufficient, but two is better).

Other optional information you should find out to fully access your ISP’s ser-
vices are:

• The incoming mail server address (often pop.yourisp.com or mail.youris-
p.com).
Also find out if your ISP uses the POP3 protocol or IMAP.

• The outgoing (SMTP) mail server address (it could be the same as the incom-
ing mail server, or it is often called something like smtp.yourisp.com).

• The Usenet News (NNTP) server address (possibly news.yourisp.com or n-
ntp.yourisp.com).

• Any proxy servers your ISP has set up.

All this information is probably available on any paperwork you received from
your ISP when you signed up with them, or you can find it out from your ISP’s
support telephone line.

Armed with the above, and a fairly recent default installation of Linux R©, you
may well find that setting up an internet connection is as simple as running the
KPPP wizard.

17.2 The KPPP wizard

17.2.1 Starting the Wizard.

You can start the wizard from KPPP’s initial screen. Start KPPP from your K
menu, where you will find its entry in the Internet as KPPP (Internet Dial-Up
Tool.
The following dialog will appear:
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The KPPP dialer startup dialog

It will probably not have any entries to begin with, and that’s what we’re about
to do now.
Click the Configure... button to begin setting up a new Internet connection.

The wizard will offer you three choices, Wizard, Dialog Setup and Cancel

The wizard asks you what you want to do

Cancel Choose this if you really don’t want to be setting up a new account
right now. The message box will go away, and you will be left with the
dialer window as before.

Wizard If you have a fairly standard modem, and use one of the larger ISP’s
for your country, the wizard will probably be able to set you up immedi-
ately with a working Internet Connection. Try this first, before you try to
set up the connection manually.

Dialog Setup If you don’t succeed with the Wizard, or you just want to do
things yourself, choose this. The wizard currently is only useful for a
small subset of countries and Internet Providers.
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For the purposes of this chapter, we’ll assume you are choosing Wizard, and
the dialog based setup will be described in a later chapter.

17.2.2 The Rest of the Wizard

The first window you see contains just introductory text, explaining the things
you read about in the first section of this chapter. Click Next to move on.

The second window asks you to choose the country you live in. Not all coun-
tries are represented here, and if the country you live in is not listed, you will
have to click Cancel, in which case the Dialog-based setup will start for you to
continue with.
On the next window, you will be given a choice of Internet Providers that KPPP
knows about, based on your choice of location in the previous window. Again,
if your ISP is not listed here, you will have to click Cancel and do your setup
in the Dialog-based setup

You will now be asked to enter your username and password for your internet
connection. Please note, that for some ISPs this differs from your mail account
user name and password, so make sure you use the right one. Choose Next to
continue.
On the next window, you have a chance to enter any special dial prefixes you
might have - for example, if you must dial ‘0’ for an outside line, or if you have
a prefix you can dial to turn off call waiting. Choose Next to continue.

And that’s all! If you want to revisit any of your choices, you can use the Back
and Next buttons to move back and forth through the dialogs. When you’re
done with your settings, click the Finish button, and you’re all done.

If you need more details, you can read the full KPPP manual in the KDE Help
Center, or by typing help:/kppp in the Location bar in Konqueror.
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Chapter 18

Getting Started with Email

Daniel Naber and David Rugge KDE features a powerful and easy-to-use
email client called KMail, which allows you to send, receive, and organize your
email quickly and efficiently. Let us look at how to set it up. If you have any
problems with this procedure, refer to the full KMail manual.

18.1 Information you will need before you start

Many email settings can vary greatly depending on the setup of your system,
your ISP’s configuration, or your local network setup. You will need to find
out some information before you can start setting up your email:

Your email address This should be provided by your ISP or system adminis-
trator.

Your username and password for your email account The username is often
the same as the part before the ‘@’ symbol in your email address, but not
always: check with your ISP.

Your outgoing email (SMTP) server name and details Again, your ISP should
have provided you with this information. If not, you can try the form s-
mtp.your-isp-name.com.

Your incoming email (IMAP or POP) server name and details If you do not
have this information to hand, you can try imap.your-isp-name.com for
IMAP or pop.your-isp-name.com if you use POP3.

Once you have that information, you are ready to start setting up KMail. Open
KMail from the K menu (you can find it in the Internet submenu, or use one
of the methods described in Section 4.1.) Once KMail has opened, select the
menu entry Settings→ Configure KMail.... The next sections describe how to
use the dialog that appears to set up KMail.
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18.2 Setting your Identity

The settings in the Identities page are fairly straightforward. Select the default
identity and click Modify.... Fill in the Your name field with your full name
(e.g. John Doe) and, optionally, the Organization field with the appropriate
information.
Next, fill in the Email address field with your email address (e.g. john@example.net).

That is all for this dialog unless you want to use the more advanced features
(cryptography, a signature, etc.). You can find more information about these
features in the full KMail manual. Click on the OK button to close this dialog,
and move on to the next configuration page...

18.3 Setting up your Account

Click on the Network icon to move to the network configuration page. It con-
tains the settings that tell KMail how to send and receive your email messages.
You will see two tabs on the right-hand side: Sending and Receiving. You need
to set up both, so let us look at them each in turn:

18.3.1 Sending Messages

The Sending tab provides a list of ways to send messages. The first item in
the list is the default way to send messages. Using the Add... button you can
choose between two different ways of sending messages: SMTP and Sendmail.
sendmail R© here means a local software installation — this has a reputation of
being difficult to set up, so if you do not already have a working sendmail R©
configuration, choose SMTP and fill in the Name field with a descriptive name
(e.g. My Mail Account) and the Host field with the name and domain of your
mail server (e.g. smtp.provider.com). You will probably not need to change
the Port setting (the default is 25).

A description of the other options can be found in the full KMail manual. Click
on OK to close this dialog, and then click on the Receiving tab.

18.3.2 Receiving Messages

To set up an account so you can receive mail, press the Add... button in the
Receiving tab. You will then be prompted for the type of your email account;
most users should select POP3 or IMAP. If you wish to use a different system,
consult the KMail manual.
You will then be presented with the Add account window. First, fill in the
Name field to name your account. You can choose any name you like. Lo-
gin, Password, and Host should be filled in with the information you gathered
earlier. You should not usually need to change the Port setting.
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You are now ready to send and receive mail. For IMAP, just open your folders
in the folder tree in KMail’s main window. KMail then connects to your server
and displays the messages it finds. For POP3 use File→ Check Mail.

18.4 Testing your Setup

First, you should send yourself a message to test your configuration. To send a
message, either hit Ctrl+N, select the New Message icon or select the Message
→New Message... menu item. The composer window will appear. Fill in the
To: field with your email address and type something in the Subject field. Send
the message by selecting Message→ Send.

To check your email, select File→ Check Mail. In the lower-right corner of
the main window, a progress bar will indicate how many messages are being
downloaded. If you receive the message you just sent, then congratulations! If,
however, you receive any error messages while testing your setup, make sure
that your network connection is working and recheck your settings at Settings
→ Configure KMail....

RELATED INFORMATION

• The KMail Handbook has full descriptions of advanced email settings and
so on. You can read it in the KHelpCenter or by entering help:/kmail in
Konqueror’s Location bar.

• The KMail website at http://kmail.kde.org contains latest news, tips and
tricks, and plenty more.
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Chapter 19

Konqueror

Intro to the browser

19.1 Internet Shortcuts

Internet shortcuts are a really useful feature of Konqueror: once you get used
to them, you’ll wonder how you ever lived without them.

To see what internet shortcuts are, open up Konqueror and type gg:kde in the
Location bar.
You will go to Google, searching for KDE.

They are many such shortcuts like ggl: (Google I’m feeling lucky), bug: (bugs.kde.org)
and so on.
To get a full list, click on Settings in the Konqueror menu, and select Web Short-
cuts. Here you will find a full list of all the shortcuts. You can create new ones,
change existing ones, or delete unused shortcuts. You can also disable web
shortcuts if you don’t like them. If you set the Default search engine, you don’t
have to type the shortcut anymore. For instance if you set it to Google, you can
just type kde in the Location bar, and it will search Google for ‘KDE’.

In Keyword delimiter you can choose if you want to separate a shortcut with a
colon (gg: kde) or a space (gg kde).

A nice tip with Internet shortcuts is that you can use them from the Run Com-
mand dialog. Just open it (through the K menu or with Alt+F2) and type your
shortcut, e.g. gg: kde, and press Enter. It will automatically open Konqueror
with a Google search for KDE.
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19.2 Fine Tuning your Browsing Experience

Example 19.1 Using your own style for webpages
Webpages come in every possible set of colors and fonts, and sometimes this
doesn’t give the best result. For example, if you have visual difficulties, it
may be impossible to read certain combinations of background and text col-
ors. Konqueror provides a way to choose your own colors and apply them to
all webpages. Here’s how:

1. Open Konqueror and go to Settings→ Configure Konqueror....

2. In the configuration dialog that appears, select the Stylesheets page on
the left hand side.

3. On this page, choose Use accessibility stylesheet defined in "Customize"
tab, then go to the Customize tab, and choose the settings you prefer.

4. Close all Konqueror windows (you may need to restart KDE to be sure)
and when you re-open them, your settings should be applied.
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Chapter 20

Usenet News

Usenet newsgroups are forums in which you can post messages to discuss var-
ious topics: almost any subject you like (and many you don’t!) can be found
there. Although usenet has become less popular than it once was, because of
the increasing use of web forums, etc., it is still a useful tool. KDE provides a
powerful usenet news reader called KNode.

You can find KNode in the K Menu under the Internet entry: the menu entry
KNode (News Reader) launches the program.

The main window of KNode should now be displayed on your desktop as
shown; on the first start, the settings dialog will be invoked.

KNode after first start
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20.1 Personal settings

The first page of the settings dialog is for personal settings:

Entering personal information

Name In the field Name, enter your name. This name will later appear in the
newsgroups as sender, and can be seen by anyone.
Filling out the field Name is mandatory.

Email address The email address you enter here will be used as sender in
news articles, i.e. as actual address of the author, in conjunction with the
real name (set in the field Name).
Filling out the Email Address field is mandatory.

20.2 Configuring the news account

Now we must tell KNode about where we get the news from or where to send
the articles to later on. In the list on the right, there is an Accounts entry; click
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on it and choose the Newsgroup servers tab, because we first want to configure
the news account: the list of accounts is still empty.

To create a new account click on Add.... The following dialog appears:

The New Account dialog

Name The Name field can be filled in as you like; the text you enter will later
be visible in the folder view. You could, for example, enter the name
of your Internet Provider; for our example we enter the name My News
Account.
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Server The next field is labelled Server. Unlike the field Name, what you enter
here is important. The name of the news server is fixed and you should be
able to get it from your Internet service provider; if you do not know the
name of the news server, you should get it now: without this information
you cannot read any news. If your Internet service provider doesn’t own
a news server you can use a public one (universities often provide public
news servers.)
For our example configuration we enter the name news.server.com; you
will, of course, enter the real name of your news server.

Port You probably will not need to change this from the default in most cases.

20.3 Setting up the mail account

Sometimes you need to answer to the author of an article directly, without post-
ing to the newsgroup; for example, when you want to make a very personal
comment or want to correct an error. If you want to do this, select the Mail
Server (SMTP) tab. The following dialog box appears:

Setting up the mail account
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Server The name (address) of your mail server as provided by your Internet
service provider or system administrator; all you have to do here is enter
the mail server’s name in the Server field.
In our example we enter mail.server.com

Port Again, you probably will not need to change the Port setting.

RELATED INFORMATION

• The comp.windows.x.kde newsgroup is the main user support group for
KDE on usenet. You can find other resources for getting help with KDE
in Section 2.2.

• Gmane provides a usenet frontend to many mailing lists, including most of
the KDE lists, so you can read them with KNode.
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Chapter 21

Introduction to messaging

Peter Nuttall and Tom Albers The default way to send instant messages in KDE
is to use the IM client, Kopete. This is a multi-protocol IM client, meaning that
it handles several different protocols including MSN, Jabber, AOL and IRC. It
also has useful features including support for KAddressBook, meta-contacts,
encryption support and lots more.
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Kopete, the KDE IM client.

21.1 How to get started

Start up Kopete from the menu (it can normally be found in the Internet folder)
When it starts up you should see a window with Kopete at the top, menus and
a tool bar below, and then your contacts below. You should add some accounts
by clicking on the Settings menu and selecting the Configure Kopete option.
By selecting the Accounts option you should see a list of your accounts (ini-
tially empty) and options to add new accounts and to edit or remove existing
accounts. By clicking on the add new account button, you can add a new ac-
count using the wizard. When you have added an account, you can connect to
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this account by clicking on the relevant icon at the bottom of your main Kopete
window. This should make your contacts appear in the contacts window.

21.2 Meta-contacts

Meta contacts are one of the features of Kopete that make sense once you figure
out what they are. Until you do, they annoy you. They are basically a way
of taking a contact on one network (such as MSN) and linking it to another
contact on a different network. This is useful for when people have accounts
on different networks as you can chat to them without needing to know which
account they are signed on to. This also lets you assign names to your meta-
contacts that don’t change when people change their names on their account,
this is useful if you have contacts who insist upon setting their MSN nick to
something like ‘=EF=81=8A’.

You can do other useful things with meta-contacts like link them to entries in
your address book. See Section 21.4

21.3 IRC

Internet Relay Chat (IRC) has been around far longer than most IM systems,
and is still widely used. It is mainly designed for group (many-to-many) com-
munication in discussion forums called channels, but also allows one-to-one
communication.
The #kde channel is under Freenode, the IRC server, which provides an in-
teractive environment for coordination and support of peer-directed projects,
including -- and placing particular stress upon -- those relating to free software
and open source projects, such as KDE.

While Kopete has a IRC plugin, and handles both channels and nicks well,
long time IRC users might prefer a client designed just for that role, which
is what Konversation is. It supports features such as granting and taking op
status, banning, easy nick changing, special channel support for passwords
and invites, and other things that the power IRC users expect. It also is far
better at handling large channels such as #debian. If you have used another
power-IRC client before, you should have no trouble using Konversation.

21.4 Linking email and messaging

Did it happen to you? You received an email and the first thing you would like
to do is to give a reaction on it, but not by email. So you switch to your instant
messaging client and/or IRC client and look if that person is online via MSN,
Jabber or IRC. Well KDE 3.3 has made that a lot easier. A step-by-step manual:

118



The KDE User Guide

The requirements are KMail, KAddressBook and Kopete (Konversation should
do as well). Make sure KMail is configured and fully functional for email,
and Kopete is well configured for IRC, Jabber and/or MSN and/or any other
protocol.

If an email comes in from a contact you know, the first thing you have to do
is to add it to your address book. This can be achieved by right clicking the
address and choosing the entry Add to Address Book.

If you know the nickname which the user uses on, for example, IRC, go to
Kopete. Go to File→ Add contact. In the wizard, select the checkbox at the
bottom called Use the KDE address book for this contact and choose Next.
Select the right Address Book entry for that contact and press Next. Now you
can set the display name and the group it belongs to for Kopete. In the next
screen select which protocol should be used if you have set up more than one
protocol. You can select more than one protocol. After that, depending on the
protocol, there will be some other questions, which you can answer as you like.

Although we did specify to choose from the address book, Kopete has not au-
tomatically linked your contact to the address book. So select the contact and
choose Edit→ Properties. On the General tab check the box labeled Has ad-
dress book entry. Press ... and select the contact. Close these two windows.

Now go to your addressbook, if you select the contact you will see that it shows
an extra field Presence, followed by the current status. This status will auto-
matically update as soon as the contact goes away, offline, online, and so on.
Now go to KMail, select another email and return to the original email (in other
words: reload the current email). You can now see behind the email address
the current state of your contact.

If you want to chat with this person, just right click the address in KMail and
choose Chat With.... Your Instant Messenger will start a conversation with the
contact.
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Part V

Office

120



The KDE User Guide

Raphael Langerhorst
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Chapter 22

Introduction to KOffice

22.1 Overview

The KDE project has also created a fully featured office suite called KOffice
which adheres to standards and fits very well into the KDE desktop. This sec-
tion was written with version 1.4 of KOffice in mind.
KOffice is a highly integrated office suite that builds directly on the KDE tech-
nology. This has many advantages in terms of integration, features, perfor-
mance, familiar look and feel and so on. All technologies like DCOP, KIO,
KParts are directly available.

In particular the KParts technology is extended for the KOffice components to
allow very flexible embedding of documents inside documents.

Because much technology is already present inside KDE itself, KOffice is a very
lightweight office suite, which results in fast application startup and low mem-
ory consumption. This makes KOffice a very suitable office suite for older
hardware as well, which can save lots of costs in some cases.
KOffice is also a very feature complete office suite. It is not limited to word pro-
cessing, spreadsheets or presentations, but has also components for image ma-
nipulation, flow charts, business report generation, database management and
project management. Because of the flexible component integration smaller
utilities like the diagram and chart engine as well as the formula editor are
available as stand alone tools.
As you can see KOffice brings a lot of features that can enrich your office expe-
rience. Its straight forward and KDE like approach in look and feel as well as
familiar usability makes KOffice quite useful for daily office work.

22.2 Features

This list gives a general outline of the KOffice features. The KOffice office suite
is too large to list every detail.
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KOFFICE FEATURES:

• Fully builds on KDE which makes these technologies available at low costs.

• Fully integrates into KDE which is vital for business environments.

• KDE technologies include document location abstraction, DCOP scripting,
parts and plugins,...

• Full Component embedding.

• Low memory footprint, fast startup, lightweight.

• Feature complete: many components are offered.

• Intuitive, good looking and easy to learn user interface.

• Adheres to standards: OASIS OpenDocument file format.

22.3 OASIS OpenDocument file format

It is important for an office suite to use standards where possible, especially for
the file format. The OASIS OpenDocument file format specification is an open
standard for office applications. This format is spreading more and more, it is
also the same file format OpenOffice.org uses, which means that file exchange
with any user of this office suite is easily possible.

Adhering to official standards is always a good thing. For business environ-
ments it is even vital to exactly know about their documents.

KOffice has more components to offer than what is covered by the OASIS spec-
ification. Still, all components covered by the specifications actually use the
OASIS OpenDocument file format.
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Chapter 23

KOffice Components
Overview

Keep in mind that all these components can integrate very well into each other.
So basically a spreadsheet can contain anything from charts to presentations,
reports and even text documents. Likewise almost any component can contain
almost any other.

KWord The textprocessing component, but it includes many aspects of a desk-
top publishing application. This creates a rather unique mixture of fea-
tures that makes interesting layouts easily possible.

• Website: http://www.koffice.org/kword/
• KWord Handbook

KSpread The spreadsheet component. KSpread is a scriptable spreadsheet
program which provides both table-oriented sheets and support for com-
plex mathematical formulas and statistics. Features include Hyperlinks,
cell data validity checking with configurable warnings/actions, scripting
and specific cell customization.

• Website: http://www.koffice.org/kspread/
• KSpread Handbook

KPresenter The presentation component. It can be used to create on-screen
presentations or to design and print transparencies. Features include em-
bedding images and clip-art, easy working with objects, and the ability
to make HTML or XML slideshows.

• Website: http://www.koffice.org/kpresenter/
• KPresenter Handbook

Kivio The flowcharting and diagramming component. Additional stencil sets
can be used for custom needs, there is a plugin framework for additional
functionality, and even UML diagrams are possible.
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• Website: http://www.koffice.org/kivio/
• Kivio Handbook

Karbon14 A vector-drawing application.

Krita The painting and image manipulation component. Krita contains both
ease-of-use, fun features like guided painting, as well as high-end fea-
tures like support for 16-bit images, CMYK and even OpenEXR HDR
images.

• Website: http://www.koffice.org/krita/
• Krita Handbook

Kugar The appropriate component for creating business reports, which is ac-
complished with an advanced designer that it has. Features include re-
port printing in postscript, full control of fonts, colors, text alignment and
wrapping, as well as open report definition files (with the layout stored
as XML).

• Website: http://www.koffice.org/kugar/
• Kugar Handbook

KPlato The component for project management, allowing for the planning
and scheduling of various projects.

• Website: http://www.koffice.org/kplato/

Kexi The data management component. It can be used for creating database
schemas, inserting data, performing queries, and processing data. Forms
can be created to provide a custom interface to your data. All database
objects -- tables, queries and forms -- are stored in the database, making
it easy to share data and database design.

• Website: http://www.koffice.org/kexi/ and http://kexi-project.org.
• Kexi Handbook

KChart The chart drawing component; it is used to embed charts into one
of the other KOffice components. It’s easy to use, highly customizable
allowing all of the parameters to be changed, and has a flexible layout.

• Website: http://www.koffice.org/kchart/
• KChart Handbook

KFormula A formula editor which provides the basic input facilities and sup-
port functionality that appears in other KOffice applications. Some of its
features include intelligent cursor management, multi-level undo sup-
port and advanced syntax highlighting.

• Website: http://www.koffice.org/kformula/
• KFormula Handbook

RELATED INFORMATION

• Main website: http://www.koffice.org.

• KOffice Handbook
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Chapter 24

Further Information

24.1 Application Manuals

Each Koffice component comes with its own manual. These manuals offer all
the latest information about the various components KOffice has to offer and
should be read to learn more about KOffice. The application manuals can be
accessed by using the documentation KIO Slave in Konqueror (that is, typing
help:/application into the Location toolbar) or by selecting the respective
handbook from the KHelpCenter. The website is also a good place to find out
more; it is at http://www.koffice.org.

24.2 Internet Resources

The primary site on the internet is http://www.koffice.org

You will also find information about the user and developer mailing lists as
well as additional developer resources.

The Kexi project has even an additional website, which can be found at http://www.kexi-
project.org

24.3 Plugin development

KOffice can easily be extended with plugins. Plugin development is not very
difficult and can be used to optimize your everyday workflow. Such capabil-
ities are probably very interesting in business environments to make KOffice
meet individual requirements. You can either take a look at existing plugins or
read a general introduction at the developer’s site. The general KDE TechBase
is available at http://techbase.kde.org.
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Chapter 25

KDE Internals

25.1 Overview

to be written

25.2 Directory Layout

KDE defines a filesystem hierarchy which is used by the KDE environment
itself as well as all KDE applications. In general KDE stores all its files in a
directory tree with a fixed structure.

By default KDE uses two directory trees:

• One at the system level (for example /opt/kde3).

• One at the user level in the user’s home directory (usually /.kde)

As a system administrator you can create additional trees. Such additional
trees can be used for profiles

SuSE R© Linux R© for example uses:

• $HOME/.kde

• /opt/kde3. (This is SuSE R©-specific; other distributions may use /usr or /u-
sr/kde3)

• /etc/opt/kde3. (This was added by SuSE R©).
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If you have the KIOSK Admin tool v0.7 or later installed you can check which
directory trees are used with the following command: kiosktool-kdedirs
--check

KDE and KDE applications look up files by scanning all the KDE directory
trees. The directory trees are checked in order of precedence. When a file is
present in multiple directory trees, the file from the last tree takes precedence.
Normally, the tree located in the user’s home directory has the highest prece-
dence. This is also the directory tree to which changes are written.

For information about the text/plainMIME type the following files are searched:

• $HOME/.kde/share/mimelnk/text/plain.desktop

• /opt/kde3/share/mimelnk/text/plain.desktop

• /etc/opt/kde3/share/mimelnk/text/plain.desktop

If a user makes a change, the change is written to $HOME/.kde/share/mimelnk/text/plain.desktop

For configuration files the story is slightly different. If there are multiple con-
figuration files found in the directory trees with the same name, their content is
combined. The precedence order of the directory trees plays a role here. When
two files define the same configuration key, the file with the highest precedence
determines which value is used for the key.

For example, if the following two files exist, with these contents:

$HOME/.kde/share/config/foobar
Color=red
Shape=circle

Color=blue
Position=10,10

The files will be merged to result in:

Color=red
Shape=circle
Position=10,10

25.3 Specifying Directories

Environment Variable: KDEHOME, Example Setting(s): /.kde, Comment:
Environment Variable: KDEROOTHOME, Example Setting(s): /root/.kde, Comment:
Different variable to prevent root writing to $KDEHOME of the user after run-
ning su.
Environment Variable: KDEDIR, Example Setting(s): /opt/kde3, /usr, /usr/kde3,
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Comment: Vendor dependent. Used by KDE 2. If not set, falls back to compiled-
in default.
Environment Variable: KDEDIRS, Example Setting(s): /opt/kde3, /usr, /usr/kde3,
Comment: New in KDE3. Can list multiple locations separated by a colon. If
not set, falls back to $KDEDIR

Don’t need to be set, defaults work just fine.

Running KDE2 next to KDE3? Point $KDEDIR to KDE 2 and $KDEDIRS to KDE 3.

A staff member at a university could have the following settings:

KDEHOME=’~/.kde3 ’
KDEROOTHOME=’/root/.kde3 ’
KDEDIRS=’/opt/kde_staff:/opt/kde3 ’

25.4 User Profiles

In the previous example /opt/kde_staff contained additional settings and ap-
plications for staff members. ‘User Profiles’ allow you to add this directory
only for certain users and not for others. Add the following to /etc/kderc:

[Directories -staff]
prefixes=/opt/kde_staff

This creates a profile named ‘staff’ that adds the /opt/kde_staff directory tree.
(Note that SuSE R© Linux R© uses /etc/kde3rc instead of /etc/kderc. Now that
we have a named profile it can be assigned to users.

To map profiles to users a mapping file needs to be specified in /etc/kderc:

[Directories]
userProfileMapFile=/etc/kde -user -profile

It is now possible to assign a profile based on either the user name or based on
the UNIX R© group the user is part of.

To assign the staff profile to all users that are a member of the UNIX R© group
staff_members add the following to /etc/kde-user-profile:

[General]
groups=staff_members
[Groups]
staff_members=staff

It is also possible to assign a profile to a single user:

[Users]
bastian=staff
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25.5 Directory Layout Revisited

Each directory tree used by KDE has a fixed directory structure. Directories
that are not relevant for a certain tree, or simply not used can be left out though.
For example, directories used for temporary files are usually only found under
$KDEHOME but not in any other directory tree.

25.6 Architecture-specific Directories

Architecture (OS and CPU type) specific directories:

/etc/opt/kde3/share/config/foobarbin Used for KDE executables.

lib Used for KDE libraries.

lib/kde3 This directory contains components, plugins, and other runtime
loadable objects for use by KDE 3.x applications.

25.7 Shared Directories

Shared: Not architecture specific, can be shared between different archs.

share/applnk .desktop files for KDE-menu (old)

share/applications .desktop files for KDE-menu (since KDE 3.2)

share/apps Contains application-specific data files. Each application has a
sub-directory here for storing additional data files.

share/config Configuration files. Configuration files are normally named
after the application they belong to plus the letters ‘rc’. A special case is
kdeglobals. This file is read by all KDE applications.

share/config/session This directory is used by session management and
is normally only available under $KDEHOME. At the end of a session KDE
applications store their state here. The file names consist of the name of
the application followed by a number. The session manager ksmserver
stores references to these numbers when saving a session in ksmserverrc.

share/doc/HTML This directory contains documentation for KDE applica-
tions. Documentation is categorized by language and the application
it belongs to. Normally at least two files can be found in a directory:
index.docbook, which contains the documentation in the unformatted
DocBook format, and index.cache.bz2, which contains the same doc-
umentation formatted as bzip2-compressed HTML. The HTML version
is used by KHelpCenter. If the HTML version is missing, KHelpCenter
will regenerate it from the DocBook version but this is a time-consuming
process.
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share/icons Under this directory icons are stored. Icons are categorized by
theme, dimension and usage category.

share/mimelnk In this directory,.desktop files that describe MIME types are
stored. KDE uses MIME types to identify the type of a file.

share/services This directory contains .desktop files that describe ser-
vices. Services are like applications but are usually launched by other
applications instead of the user. Services do not appear in the KDE menu.

share/servicetypes This directory contains .desktop files that describe
servicetypes. A servicetype usually represents a certain programming
interface. Applications and Services include in their >.desktop files the
servicetypes that they provide.

share/sounds This directory contains sound files.

share/templates This directory contains templates for creating files of var-
ious types. A template consists of a .desktop file that describes the file
and that includes a reference to a file in the .source sub-directory. The
templates in this directory appear in the Create New menu available on
the desktop and in the file browser. When a user selects a template from
the menu its source file is copied.

share/wallpapers This directory contains images that can be used as back-
ground picture

25.8 Host-specific Directories

There are three host-specific directories that are usually symlinked to other
locations. If the directories do not already exist, the following symlinks and
directories will be created using the lnusertemp utility:

$KDEHOME/socket-$HOSTNAME Usually /tmp/ksocket-$USER/, this is used
for various UNIX R© sockets.

$KDEHOME/tmp-$HOSTNAME Usually /tmp/kde-$USER/, this is used for tem-
porary files.

$KDEHOME/cache-$HOSTNAME Usually /var/tmp/kdecache-$USER/, this is
used for cached files.

Since both /tmp and /var/tmp are world writable, there is a possibility that
one of the above directories already exists but is owned by another user. In
that case the lnusertemp utility will create a new directory with an alternative
name and link to that instead.
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25.9 Configuration Files

KDE uses a simple text-based file format for all its configuration files. It con-
sists of key-value pairs that are placed in groups. All KDE configuration files
use UTF-8 encoding for text outside the ASCII range.

The start of a group is indicated by a group name that is placed in square brack-
ets. All the key-value entries that follow belong to the group. The group ends
when either another group starts or when the end of the file is reached. En-
tries at the top of the file that are not preceded by a group name belong to the
default group.

The following example shows a configuration file that consists of two groups.
The first group contains the keys LargeCursor and SingleClick, the second
group contains the keys Show hidden files and Sort by:

[KDE]
LargeCursor=false
SingleClick=true

[KFileDialog Settings]
Show hidden files=false
Sort by=Name

Entries in a group consist of a key and value separated by an equals sign. The
key can contain spaces and may be followed by options placed in square brack-
ets. The part after the equals sign is the value of the entry. Any white space
surrounding the equals sign is ignored, as is any trailing white space. Put more
concisely, the format is:

entry=value

If a value is supposed to include a space at the begin or end then this can be
achieved by using a backslash followed by an ‘s’.

There are several other backslash codes; here is a complete list:

• \s can be used as space

• \t can be used to include a tab

• \r for a carriage return character

• \n for a linefeed character (new line)

• \\ to include the backslash itself

In the following example the value of the Caption entry starts with two spaces
while the Description entry contains three lines of text. Linefeeds in backslash
notation are used to separate the different lines.

134



The KDE User Guide

[Preview Image]
Caption=\s My Caption
Description=This is\na very long\ndescription.

Empty lines in configuration files are ignored, as are lines that start with a hash
mark (‘#’). The hash mark can be used to add comments to configuration files.
It should be noted that when a KDE application updates a configuration file
the comments are not preserved.

There can be multiple configuration files with the same name in the share/-
config sub-directory of the various KDE directory trees. In this case the in-
formation of all these configuration files is combined on a key-by-key basis. If
the same key within a certain group is defined in more than one place, the key
value read from the directory tree with the highest precedence will be used.
Configuration files under $KDEHOME always have the highest precedence. If a
key in a certain group is defined multiple times in a single file, the value of the
last entry is used.

If $HOME/.kde/share/config/foobar contains:

[MyGroup]
Color=red
Shape=circle

and /etc/opt/kde3/share/config/foobar contains

[MyGroup]
Color=blue
Position=10,10

the result will be:

[MyGroup]
Color=red
Shape=circle
Position=10,10

If $HOME/.kde/share/config/foobar contains

[MyGroup]
Color=red
Shape=circle
[MyGroup]
Color=green

and /opt/kde_staff/share/config/foobar contains

[MyGroup]
Color=purple
Position=20,20
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and /etc/opt/kde3/share/config/foobar contains

[MyGroup]
Color=blue
Position=10,10

the result will be:

[MyGroup]
Color=green
Shape=circle
Position=20,20

To prevent users being able to override default settings, settings can be marked
immutable. Settings can be made immutable individually, per group or per file.
An individual entry can be locked down by adding [$i] behind the key, e.g.:

Color[$i]=blue

A group of entries can be locked down by placing [$i] behind the group name,
e.g.:

[MyGroup][$i]

To lock down the entire file, start the file with [$i] on a single line, i.e.:

[$i]

If $HOME/.kde/share/config/foobar contains:

[MyGroup]
Color=red
Shape=circle

and /etc/opt/kde3/share/config/foobar contains:

[MyGroup][$i]
Color=blue
Position=10,10

the result will be:

[MyGroup]
Color=blue
Position=10,10

If $HOME/.kde/share/config/foobar contains:

[MyGroup]
Color=red
Shape=circle
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and /opt/kde_staff/share/config/foobar contains

[MyGroup]
Color=purple
Shape=rectangle

and /etc/opt/kde3/share/config/foobar contains

[MyGroup][$i]
Color=blue
Position=10,10

the result will be

[MyGroup]
Color=purple
Shape=rectangle
Position=10,10

So-called ‘Shell Expansion’ can be used to provide more dynamic default val-
ues. With shell expansion the value of a configuration key can be constructed
from the value of an environment variable or from the output of a shell com-
mand. To enable shell expansion for a configuration entry, the key must be
followed by [$e]. Normally the expanded form is written into the user’s con-
figuration file after first use. To prevent that, it is recommend to lock the con-
figuration entry down by using [$ie]. The user can’t change it then of course.

In the following example the value for the Host entry is determined by the
output of the hostname program. This setting is also locked down to ensure
that the value is always determined dynamically.

The value for the Email entry is determined by filling in the values of the $USER
and $HOST environment variables. When joe is logged in on joes_host this
will result in a value equal to joe@joes_host. The setting is not locked down.

[Mail Settings]
Host[$ie]=$(hostname)
Email[$e]=${USER}@${HOST}

Most configuration entries can be indexed with a language code. In this case,
the language that the user has selected for use on the desktop is used to look
up the key value. If the default language (American English) has been selected
or if there is no index that corresponds to the selected language, the key entry
without index is used.
In the following example the value of the Caption entry depends on the lan-
guage. If the user has selected French as language (language code fr) the value
of the entry will be ‘Ma Légende’. In all other cases the value ‘My Caption’ will
be used.

[Preview Image]
Caption=My Caption
Caption[fr]=Ma Légende
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In this example the value of the Caption entry depends on the language. If the
user has selected French as language (language code fr) the value of the entry
will be ‘Ma Légende.’ In all other cases the value ‘My Caption’ will be used.

[Preview Image]
Caption=My Caption
Caption[fr]=Ma Légende

In general the entries that can appear in a configuration file are not docu-
mented. With KDE 3.2 a start has been made to change this. In $KDEDI-
R/share/config.kcfg, files can be found that provide a formal description of
the possible entries in a configuration file. These are used by the new KDE
Configuration Editor when available.

Here is an example XML configuration file:

<?xml version ="1.0" encoding="UTF -8"?>
<!DOCTYPE kcfg SYSTEM "http://www.kde.org/standards/kcfg/1.0/ ←↩

kcfg.dtd">
<kcfg >

<kcfgfile name="korganizerrc"/>
<group name="General">

<entry type="Bool" key="Auto Save">
<label >Enable automatic saving of calendar </ ←↩

label >
<default >true </default >

</entry >
<entry type="Int" key="Auto Save Interval">

<default >10</default >
</entry >

</group >
</kcfg >

It has the same effect as:

[General]
Auto Save=false
Auto Save Interval=25

25.10 KDE Startup Sequence

25.10.1 kdm

Always runs as root! Uses $KDEDIR/share/config/kdmrc and /etc/X11/xdm-
/Xservers. The latter contains entries like:

:0 local /usr/X11R6/bin/X :0 vt07
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Relevant startup files are also:

[X-*-Core] section in kdmrc
Setup - /etc/X11/xdm/Xsetup
User enters username & password
Startup - /etc/X11/xdm/Xstartup - prepare as root
Session - /etc/X11/xdm/Xsession - starts session as user
= For a KDE session: kde or startkde
= If present /.xsession or /.xinitrc
Reset - /etc/X11/xdm/Xreset - after session finished

25.10.2 The KDE Startup Script: startkde

The KDE startup sequence starts with the startkde script. In most cases this
script gets called from the display manager (kdm) once the user has been au-
thenticated. There are two very important lines in the startkde script:

LD_BIND_NOW=true kdeinit4 +kcminit_startup and kwrapper4 ←↩
ksmserver $KDEWM

The first line starts the kdeinit4 master process. The kdeinit4 master process
is used to start all other KDE processes. It show up in the output of ps au-
x as kdeinit4: Running.... The arguments after kdeinit4 are the names of
additional processes to be started. The + indicates that kdeinit4 needs to wait
till the process has finished. kdeinit4 also starts klauncher and kded.

The second of the two lines asks kdeinit4 to start the ksmserver session man-
ager process. The session manager determines the lifetime of the session. When
this process exits, the user is logged out.

25.11 Background Processes

All KDE background services are user-specific: unlike system daemons they
are not shared between users. As well as being unique per user they are also
unique per X-server display. The processes are:

dcopserver Desktop communication

kded Generic service daemon.
Triggers Sycoca database updates when needed

kcminit Initialization service
See Section 25.11.2 for more information.

klauncher Program launch (this is not the Alt+F2dialog!)
See Section 25.11.3 for more information.
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knotify User notifications.
See Section 25.11.4 for more information.

ksmserver Session management
See Section 25.12 for more information.

25.11.1 kdeinit

kdeinit is used to start all other KDE programs. kdeinit can start normal bi-
nary program files as well as kdeinit loadable modules (KLMs). KLMs work
just like binary program files but can be started more efficiently. KLMs live in
$KDEDIR/lib/kde3

The drawback is that programs started this way appear as kdeinit in the
output of top and ps. Use top -c or ps aux to see the actual program name:

%ps aux

waba 23184 0.2 2.1 23428 11124 ? S 21:41 0:00 ←↩
kdeinit4: Running...

waba 23189 0.2 2.4 25136 12496 ? S 21:41 0:00 ←↩
kdeinit4: klauncher

waba 23192 0.7 2.8 25596 14772 ? S 21:41 0:00 ←↩
kdeinit4: kded

waba 23203 0.8 3.4 31516 17892 ? S 21:41 0:00 ←↩
kdeinit4: knotify

kdeinit: Running... indicates the master kdeinit process. The other pro-
cesses listed are programs started as KLMs.

When kdeinit starts for the first time it will launch klauncher, and kded, as
well as any additional programs specified on its command line in the startkde
script, normally kcminit_startup.

25.11.2 kcminit

kcminit executes initialization services during startup. Initialization services
are specified in the .desktop files of applications or services via the X-KDE-Init
line:

[Desktop Entry]
Encoding=UTF -8
Exec=kcmshell4 energy
Icon=energy_star
Type=Application
X-KDE -Library=energy
X-KDE -Init=energy
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Initialization services are typically used for initializing hardware based on user-
specified settings.

kcminit --list can be used to show all initialization services and kcminit
service can be used to execute a single service explicitly. This can be useful
when investigating startup problems.

25.11.3 klauncher

klauncher is a daemon which is responsible for service activation within KDE.
It operates in close connection with the kdeinit master process to start new pro-
cesses. KDE applications communicate with klauncher over DCOP in order to
start new applications or services.

Best known from the error message: KLauncher could not be reached vi-
a DBus which either indicates a serious problem with the dcopserver or that
klauncher crashed.
klauncher can be restarted by restarting kdeinit from a console window. Make
sure that $HOME, $DISPLAY and the various $KDEDIR(S) are set correctly when
doing so!

25.11.4 knotify

The primary task of knotify is to relay sound notifications to the sound server,
it also provides alternative notification methods.

25.12 KSMServer

ksmserver is KDE’s session manager. On startup the session manager launches
auto-start applications and restores applications from the previous session.
The applications to auto-start are indicated by .desktop files in the $KDEDI-
R/share/autostart directory. Whether or not to auto-start an application can
be made conditional upon some configuration entry determined by the X-KD-
E-autostart-condition entry in the .desktop file.

The ktip.desktop file for example contains:

X-KDE -autostart -condition=ktiprc:TipOfDay:RunOnStart:true

This means that the ktiprc configuration file is checked for a RunOnStart entry
in the [TipOfDay] section. If no such entry is found, true is assumed, which
means that ktip is one of the applications that is auto-started by default.

Some of the applications auto-started by ksmserver are:

kdesktop The KDE desktop

141



The KDE User Guide

Kicker The KDE panel

ktip A tip of the day program

kwrited A utility to receive system messages sent to the user

Klipper A clipboard utility that docks in the panel

kalarm A utility that warns about upcoming events and appointments

kdesktop in its turn automatically starts applications stored in $KDEHOME/Autostart.
kdesktop will automatically open any files stored in this directory including
documents, binary files or applications in the form of .desktop files.

The KDE session manager also restores one of the previous sessions. A session
contains a collection of applications as well as application-specific information
that reflects the state of the applications at the time the session was saved.
Sessions are stored in the ksmserverrc configuration file which contains ref-
erences to application-specific state information. The application-specific state
information is saved in $KDEHOME/share/config/session. The state informa-
tion of KWin contains the location of the application windows of all the other
applications in the session.

25.13 Environment variables

Some important environment variables used by KDE:

$KDEDIR Has to be set if KDEDIRS is not set and has to point to the root of the
KDE installation tree. Allows KDE to find its data like icons, menus and
libraries.

$KDEDIRS Overrides KDEDIR and allows you to specify multiple directories
where KDE searches for its data. Useful if you want or have to install
some programs to a different prefix than the rest of KDE.

$KDEHOME If not set, KDE uses /.kde as the directory where personal data is
stored.

$KDEROOTHOME If not set, KDE uses root/.kde as the directory for root’s
personal data. Was introduced to prevent KDE from accidently overwrit-
ing user data with root permissions when the user runs a KDE program
after switching with su to root.

$KDEWM If the KDEWM environment variable has been set, then it will be used as
KDE’s window manager within the startkde script instead of KWin.

$KDE_LANG Overrides the KDE language configuration, e.g. KDE_LANG=fr kprogram
& starts a program with French translation if the necessary files are in-
stalled.

$KDE_MULTIHEAD Set this variable to true to indicate that KDE is running on
a multi-head system.
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$KDE_FORK_SLAVES (Since KDE 3.2.3) Set this variable to spawn KIO-slaves
directly from the application process itself. By default KIO-slaves are
spawned using klauncher/kdeinit. This option is useful if the KIO-slave
should run in the same environment as the application. This can be the
case with Clearcase.

$KDE_HOME_READONLY Set this variable to indicate that your home directory
is mounted as read-only.

$KDE_NO_IPV6 (Since KDE 3.2.3) - Set this variable to disable IPv6 support
and IPv6 DNS lookups.

$KDE_IS_PRELINKED (Since KDE 3.2) - Set this variable to indicate that you
have prelinked your KDE binaries and libraries. This will turn off kdeinit.

$KDE_UTF8_FILENAMES If this environment variable is set, KDE assumes all
filenames are in UTF-8 encoding regardless of the current C locale.

$KDE_FULL_SESSION (Since KDE 3.2) Automatically set to true by KDE startup,
it is used by e.g. Konqueror to know if it should consider remaining in
memory for future re-use when being closed. If not set, Konqueror will
exit after being closed (e.g. KDE su does that, it’s also useful for debug-
ging).

$KDESYCOCA Allows you to specify the path and the name of the generated
KDE system configuration cache file.

$KDETMP Allows to specify another path than /tmp where KDE stores its tem-
porary files.

$KDEVARTMP Allows to specify another path than /var/tmp where KDE stores
its variable files.

$XDG_DATA_HOME (Since KDE 3.2) Defines the base directory relative to which
user-specific data files should be stored. Default is $HOME/.local/share

$XDG_DATA_DIRS (Since KDE 3.2) Defines the preference-ordered set of base
directories to search for data files in addition to the $XDG_DATA_HOME base
directory. Default is /usr/local/share/:/usr/share/
KDE adds locations from $KDEDIRS and profiles as well. Used for .de-
sktop and .directory menu files. .desktop files under $XDG_DATA_DI-
RS/applications. .directory files under $XDG_DATA_DIRS/desktop-
directories

$XDG_CONFIG_HOME (KDE 3.2) - Defines the base directory relative to which
user specific configuration files should be stored. Default is $HOME/.config.

$XDG_CONFIG_DIRS (KDE 3.2) - Defines the preference-ordered set of base
directories to search for configuration files in addition to the $XDG_CONF-
IG_HOME base directory. The default is /etc/xdg KDE adds locations from
$KDEDIRS and profiles as well. Used by .menu descriptions in $XDG_CONF-
IG_DIRS/menus.
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25.14 The kdeinit Mystery

kdeinit is used to start all other KDE programs. kdeinit can start normal bi-
nary program f iles as well as kdeinit loadable modules (KLMs). KLMs work
just like binary program files but can be started more efficiently. KLMs live in
$KDEDIR/lib/kde3

The drawback is that programs started this way appear as kdeinit in the
output of top and ps. Use top -c or ps aux to see the actual program name:

% ps aux | grep bastian

bastian 26061 0.0 2.2 24284 11492 ? S 21:27 ←↩
0:00 kdeinit: Running...

bastian 26064 0.0 2.2 24036 11524 ? S 21:27 ←↩
0:00 kdeinit: dcopserver

bastian 26066 0.1 2.5 26056 12988 ? S 21:27 ←↩
0:00 kdeinit: klauncher

bastian 26069 0.4 3.2 27356 16744 ? S 21:27 ←↩
0:00 kdeinit: kded

bastian 26161 0.2 2.7 25344 14096 ? S 21:27 ←↩
0:00 kdeinit: ksmserver

bastian 26179 1.1 3.4 29716 17812 ? S 21:27 ←↩
0:00 kdeinit: kicker

bastian 26192 0.4 3.0 26776 15452 ? S 21:27 ←↩
0:00 kdeinit: klipper

bastian 26195 1.0 3.5 29200 18368 ? S 21:27 ←↩
0:00 kdeinit: kdesktop

As you might have noticed, this has another side effect, making it difficult to
kill a process that is causing trouble:

% killall kdesktop
kdesktop: no process killed

You might be tempted to try killall kdeinit, but killing all kdeinit pro-
cesses will have the effect of shutting down all of KDE. In effect, total destruc-
tion!
There are two simple solutions to this:

% kdekillall kdesktop
or good old
% kill 26195

kdekillall is part of the KDE SDK package.
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Chapter 26

Customizing KDE

26.1 Desktop Icons

KDE uses several types of icons:

• Documents

• Links to Websites (using .desktop file)

• Links to Applications (using .desktop file)

• Devices - Disks, Partitions & Peripherals:

– Explicit using .desktop file
– Automatic via devices:// io-slave

• Vendor-specific (e.g. SuSE R©’s My Computer)

26.1.1 Websites

Links to Websites using .desktop file: Create New→ File→ Link to Location
(URL). Change Icon using Properties dialogs. The resulting .desktop file:

[Desktop Entry]
Encoding=UTF -8
Icon=/opt/kde3/share/apps/kdesktop/pics/ksslogo.png
Type=Link
URL=http://www.kde.org/
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26.1.2 Applications

Links to Applications using .desktop file: Create New→ File→ Link to Appli-
cation. You must provide details yourself. Drag from KDE Menu: Either copy
or link (creates symlink), much easier

[Desktop Entry] v1
Encoding=UTF -8
GenericName=IRC Client v2
GenericName[af]=Irc Kliët
GenericName[de]=IRC Programm
...
GenericName[zu]=Umthengi we IRC v3
SwallowExec= v4
Name=KSirc
Name[af]=Ksirc
Name[de]=KSirc
...

v1 Boiler platev2 Translated generic description, not used on desktopv3 Legacy, can be removedv4 Translated name as it appears on desktop

Desktop Icons

...
Name[zu]=Ksirc
MimeType= v1
Exec=ksirc %i %m v2
Icon=ksirc v3
TerminalOptions= v4
Path= v5
Type=Application v6
Terminal=0 v7
X-KDE -StartupNotify=true v8
X-DCOP -ServiceType=Multi v9
Categories=Qt;KDE;Network v10

v1 Supported MIME types, not used on desktopv2 The command line to executev3 The icon, from icon theme or full pathv4 Only used if terminal is needed
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v5 Working directory for commandv6 More boiler platev7 Use true if terminal is needed, text applicationv8 Show bouncy cursor, disable if it doesn’t work.v9 Has app started ok? Remove if it doesn’t workv10 Categories for KDE Menu, not used on desktop

26.1.3 The Exec option in .desktop files

Following the command, you can have several place holders which will be
replaced with the actual values when the actual program is run:

%f A single file name; used when dropping file on icon, or with file associa-
tions.

%F A list of files; use for applications that can open several local files at once.

%u A single URL: if the app can handle e.g. FTP or HTTP URLs itself, other-
wise KDE.

%U A list of URLs; will download the file first and pass a local file to the app
(!!)

%d The folder of the file to open; useful if app needs to have file in current
working directory.

%D A list of folders, not very practical.

%i The icon; --icon option; KDE app will use icon from Icon= line in taskbar.

%m The mini-icon; legacy.

%c The caption; --caption option; KDE app will use name from Name= line in
taskbar.

Examples: Exec line: ksirc %i, Command executed: ksirc --icon ksirc
Exec line: cd %d; kedit $(basename %f), Command executed: cd /tmp; kedit
file.txt

26.1.4 Devices

Links to Devices using .desktop file: o Create New -> Device
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26.1.5 Where to Define

Many places to define Desktop Icons:

• /Desktop: copied from /etc/skel/Desktop

• $KDEDIR/apps/kdesktop/Desktop (merged)

• $KDEDIR/apps/kdesktop/DesktopLinks (copied)

• Device Icons (dynamically merged)

• Distribution Specific SUSE Linux copies certain icons in startkde.theme from
/opt/kde3/share/config/SuSE/default/

26.2 KDE Menu

26.2.1 How it Works

In KDE 3.2 a common menu format is introduced at http://freedesktop.org/-
Standards/menu-spec/

Before KDE 3.2:

• Directory structure under share/applnk

• Directory structure represents menu structure

• Each .desktop file represents a single application

It was difficult to rearrange the structure in KDE 3.2 so the new menu format:

• Defines structure in a single .menu file

• Is based on categories

• is shared between GNOME and KDE

• Supports applnk style menus as well

Example from applications.menu:

<Menu >
<Name >Office </Name >
<Directory >suse -office.directory </Directory >
<Include >

<Filename >Acrobat Reader.desktop </Filename >
<Filename >kde -kpresenter.desktop </Filename >
<Filename >kde -kword.desktop </Filename >

</Include >
<Menu >
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Menu entry with 3 applications:

• /usr/share/applications/Acrobat Reader.desktop

• /opt/kde3/share/applications/kde/kpresenter.desktop

• /opt/kde3/share/applications/kde/kword.desktop

26.2.2 Stored Where?

.menu files describing the menu structure. The files are stored in $KDEDIR/etc/xdg/menus
and /etc/xdg/menus. These store the system-wide menu structure and are con-
trolled by $XDG_CONFIG_DIRS. $HOME/.config/menus stores user-specific changes
to the menu structure and is controlled by $XDG_CONFIG_HOME. For more infor-
mation, see http://www.freedesktop.org/Standards/basedir-spec.

.desktop files describe the applications and are stored in: $KDEDIR/share/applications,
/usr/share/applications, /usr/local/share/applications. These are the
system-wide application .desktop files which are controlled by $XDG_DATA_-
DIRS.
$HOME/.local/applications contains user-specific .desktop files and user-specific
changes. It is controlled by $XDG_DATA_HOME. For more information, see http://www.freedesktop.org/-
Standards/basedir-spec

.directory files describing the sub-menus are stored in: $KDEDIR/share/desktop-directories,
/usr/share/desktop-directories, /usr/local/share/desktop-directories.
These are the system-wide menu .directory files, controlled by $XDG_DATA_D-
IRS. The user-specific changes are stored in $HOME/.local/desktop-directories.
These are controlled by $XDG_DATA_HOME. For more information, see http://www.freedesktop.org/-
Standards/basedir-spec

Example from applications.menu:

<Menu >
<Name >Art </Name >
<Directory >suse -edutainment -art. ←↩

directory </Directory >
<Include >

<Category >X-SuSE -Art </ ←↩
Category >

</Include >
</Menu >

Art is the internal name for this menu. suse-edutainment-art.directory de-
fines the name and icon for this menu, and the menu includes all applications
that have X-SuSE-Art listed as a category, e.g.:

Categories=Qt;KDE;Education;X-SuSE -Art

suse-edutainment-art.directory defines the name and icon for this menu:
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[Desktop Entry]
Name=Art and Culture
Icon=kcmsystem

26.2.3 Common Pitfalls

Applications not in the menu do not exist with regard to other applications or
file associations: If you remove an application from the menu, KDE assumes
you don’t want to use it.

When applications are unwanted in the menu, either place them in .hidden
menu or a dedicated menu with

NoDisplay=true

in the .directory file

26.2.4 Essential Menus

$KDEDIR/etc/xdg/menus/applications-merged/ contains kde-essential.me-
nu which includes some essential menus that are normally not shown in the
KDE menu itself:

• Control Center has a hidden Settings menu whose contents are defined by
kde-settings.menu and whose icon and name are defined by kde-setting-
s.directory

• Info Center has a hidden Information menu whose contents are defined by
kde-information.menu and whose icon and name are defined by kde-info-
rmation.directory.

• Screensavers contains a hidden System/Screensavers menu, whose contents
are defined by kde-screensavers.menu and whose icon and name are de-
fined by kde-system-screensavers.directory. $KDEDIR/share/desktop-directories/kde-system-screensavers.directory
contains:

NoDisplay=true

26.2.5 Old-Style Menus

KDE continues to support old-style menus that are defined by the directory
structures in $KDEDIR/share/applnk (system wide) and $HOME/.kde/share/applnk
(user specific). This is observed unless the .desktop file has a Categories= line.
In that case the categories determine the location in the menu.
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26.2.6 KSycoca

KSycoca caches menu structure and information about all available applica-
tions. You can rebuild the database with kbuildsycoca4. The database
which is built lives in /var/tmp/kdecache-${USER}/ksycoca. It is automati-
cally updated by KDED, checked during KDE login, and KDED watches for
changes while logged in.

To disable watching for changes (since it may hurt over NFS) add the following
to kdedrc:

[General]
CheckSycoca=false

To force regeneration, run touch $KDEDIR/share/services/update_ksycoca.

26.2.7 KMenuEdit

KMenuEdit is aimed at a single user setup. Changes to menu structure are
saved to /.config/menus/applications-kmenuedit.menu, changes to appli-
cations are saved in /.local/share/applications/ and changes to sub-menus
(icon, name) are saved in /.local/share/desktop-directories/. The KIOSK
Admin Tool uses KMenuEdit and copies the above changes to profile- or system-
wide locations.

26.3 KDE Panel

The KDE panel is also known as Kicker. It is modular and consists of the fol-
lowing components:

• Applets

• Application buttons

• Special Buttons

By default, the panel contains the following applets:

• Pager - shows the virtual desktops

• Taskbar

• System Tray

• Clock

and the following special buttons:

• KDE menu
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• Desktop Button

Various application buttons are also added, space permitting:

• Home Button

• Browser Button

• KMail Button

26.4 File Associations

File associations associate a file type with an application or applications. The
type of a file is established by determining its MIME type. MIME types known
by KDE are stored in $KDEDIR/share/mimelnk and each application’s .desktop
file contains a list of MIME types supported by that application.

kview.desktop:

MimeType=image/gif;image/x-xpm;image/x-xbm;image/jpeg;
image/x-bmp;image/png;image/x-ico;image/x-portable -bitmap;
image/x-portable -pixmap;image/x-portable -greymap;
image/tiff;image/jp2

kuickshow.desktop:

MimeType=image/gif;image/x-xpm;image/x-xbm;image/jpeg;
image/png;image/tiff;image/x-bmp;image/x-psd;image/x-eim;
image/x-portable -bitmap;image/x-portable -pixmap;
image/x-portable -greymap

Both can open image/gif Which one is used to open a .gif file?

The application with highest preference!. kview.desktop contains

InitialPreference=3

whereas kuickshow.desktop contains

InitialPreference=6

Therefore, KuickShow will be used to open .gif files.

How can we make KView default?
A user can change file association in the KDE Control Center. These changes
are stored in $HOME/.kde/share/config/profilerc. To use the same settings
for multiple users, store these settings in user profile directory or the global
KDE config directory to use as default for multiple users.
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Chapter 27

Locking Down KDE

27.1 How It Works - The Basics

KDE’s lock down features are centered around the following options:

• Make configuration options immutable

• Restriction of specific actions

• Restrict access to certain URLs
• Restrict access to certain configuration modules

27.2 Immutable Configuration Options

Locking Down KDE Immutable options allow system administrator to provide
default settings that can not be changed by the user.

Pre-existing configuration options of the user will be ignored once a configura-
tion option is made immutable.

Options can be controlled either on a per entry basis, per group of entries or on
a file by file basis.

If a file or group is immutable, all configuration options for that file or group
are immutable, even those options for which the system administrator has no
default provided.

NOTE
The support in applications for immutable options may vary from application to ap-
plication. Although the user will not be able to make permanent changes to im-
mutable configuration options, the user may still be presented with an user interface
option to make such change.
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27.3 Action Restrictions

KDE applications are built around the action-concept. Actions can be activated
in various ways, typically via the menu-bar, one of the toolbars or a keyboard
shortcut. Save Document is an example of an action. If you know the internal
action name it is possible to restrict an action. When an action is restricted
it will no longer appear in the menu-bar or toolbar. The internal name for
the Save Document action is action/file_save. The lock down framework
also provides a set of more abstract restrictions which can be used to disable
functionality not covered by a single action. An example is the shell_access
restriction which disables all functionality that would offer the user access to a
UNIX R© shell.

Example 27.1 Restrict User Access to Shells
In order to prevent the user access to a command shell we can restrict the she-
ll_access action by adding the following to kdeglobals:

[KDE Action Restrictions]
shell_access=false

Since this affects the KDE menu and the available applications, we must force
an update of the sycoca database:

touch $KDEDIR/share/services/update_ksycoca

Now re-login to KDE and check the following points:

• The K menu

• In Konqueror, Tools→Open Terminal

• The Alt+F2 run command

Full documentation about available actions can be found on http://www.kde.org/-
areas/sysadmin/ .

A few of the more interesting actions are listed below:

action/options_configure The Configure option from the Settings menu

action/help_report_bug The Report Bug option from the Help menu.

action/kdesktop_rmb right mouse button mouse button menu on the desk-
top.

action/kicker_rmb right mouse button mouse button menu on the panel.

user/root Hide all actions or applications that require root access.

shell_access Hides all actions or applications that provide shell access.

154

http://www.kde.org/areas/sysadmin/
http://www.kde.org/areas/sysadmin/


The KDE User Guide

print/system Disables the option to select the printing system (backend).

lock_screen Whether the user will be able to lock the screen

start_new_session Whether the user may start a second X session (see
also kdm)

opengl_screensavers Whether OpenGL screensavers are allowed to be
used.

manipulatescreen_screensavers Permit screensavers that do not hide
the entire screen

27.4 URL Restrictions

There are three types of restrictions that can be applied to URLs:

list To control whether a directory listing is allowed.

open To control whether certain URLs can be opened

Redirect To control whether one URL can open another URL, either automat-
ically or via a hyperlink.

Rules are checked in the order in which they are defined. The last rule that is
applicable to a URL defines whether the URL may be accessed.

The following rules disable opening http and https URLs outside .ourcompan-
y.com:

[KDE URL Restrictions]
rule_count=2
rule_1=open ,,,,http ,,,false v1 v2
rule_2=open ,,,,http ,*.ourcompany.com ,,true v3
v1 The first four commas skip over the selection criteria with respect to the

originating URL. This part is only needed with redirect type rules.v2 rule_1 forbids the opening of any http or https URLv3 rule_2 allows the opening of any http and https URL in the .ourcompany.-
com domain. Note the wildcard * is only allowed at the start of a domain.

The following rules makes that the user can no longer browse directories on
the local file system that are outside his $HOME directory:

[KDE URL Restrictions]
rule_count=2
rule_1=list ,,,,file ,,,false v1
rule_2=list ,,,,file ,,$HOME ,true v2
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v1 rule_1 forbids the listing of any local directoryv2 rule_2 allows listing directories under the users own $HOME directory.

$HOME and $TMP are special values to indicate the users home directory and the
KDE temporary directory of the user, e.g. /tmp/kde-bastian

The following rules makes that the user can no longer open local files that are
outside his $HOME directory:

[KDE URL Restrictions]
rule_count=3
rule_1=open ,,,,file ,,,false v1
rule_2=open ,,,,file ,,$HOME ,true v2
rule_3=open ,,,,file ,,$TMP ,true v3
v1 rule_1 forbids the opening of any local filev2 rule_2 allows opening files under the users own $HOME directory.v3 rule_3 allows opening files in the KDE temporary directory of the user. This

is needed by certain KDE applications that first download a file or docu-
ment to the temporary directory and then open it in an application.

The redirection option controls whether documents from a certain location can
refer, either automatically or manually via a hyperlink, to a certain other lo-
cation. A set of default rules is present as a general security measure. For
example documents located on the Internet may not refer to locally stored doc-
uments.
For example, if we want to give the intranet-server www.mycompany.com the pos-
sibility to refer to local files we could add the following rule:

[KDE URL Restrictions]
rule_count=1
rule_1=redirect ,http ,www.mycompany.com ,,file ,,,true

Instead of listing a protocol by name, it is also possible to specify a whole group
of protocols. For that the following groups have been defined:

:local Protocols that access locally stored information, examples are file:/, man:/,
fonts:/, floppy:/

:internet Common internet protocols such as http and ftp

Information about protocols is stored in *.protocol files stored in $KDEDI-
R/share/services.
The Class= entry defines the group a protocol is part of: grep Class= $KDED-
IR/share/services/*.protocol

General rules:
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• The :local protocols may refer to any other protocol

• It’s always allowed to refer to an :internet protocol

• Not all protocols are part of a group, fish:/ for example.

27.5 Configuration Modules

KDE has configuration modules to configure various aspects of the KDE envi-
ronment. Configuration modules appear in the Control Center, in the Config-
uration dialog of an application or in both.

The proxy configuration module appears in the Control Center but also as part
of the Configure Konqueror dialog in Konqueror

Individual configuration modules can be started with kcmshell4 module

To start the Proxy module use:

• kcmshell4 kde-proxy.desktop

• kcmshell4 proxy

NOTE
Not all applications use configuration modules, often the configuration dialog is an
integral part of the application itself.

All configuration modules are strictly speaking part of the KDE menu.

• The modules that are visible in the Control Center normally have a .deskto-
p file in $KDEDIR/share/applications/kde and are sorted under the hidden
Settings-Modules menu by the kde-settings.menu, included from kde-ess-
ential.menu

kbuildsycoca4 --menutest 2> /dev/null | grep Settings - ←↩
Modules

• Application specific modules normally have a .desktop file under $KDEDI-
R/share/applnk/.hidden which corresponds to the hidden .hidden menu,
included as a result of <KDELegacyDirs/>

kbuildsycoca4 --menutest 2> /dev/null | grep .hidden

• In KDE 3.3 it is possible to edit the Control Center with kcontroledit. kcon-
troledit works just like kmenuedit, changes for current user only. Use kiosk-
tool to make changes for everyone.
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Individual configuration modules can be disables by adding the following to
kdeglobals:

[KDE Control Module Restrictions]
module -id=false

For example, to disable the proxy module use

[KDE Control Module Restrictions]
kde -proxy.desktop=false

Check the Control Center and the Configure Konqueror dialog if the proxy
configuration is still there.

158



The KDE User Guide

Chapter 28

The Lazy Admin

28.1 Remote Desktop Sharing

Remote desktop sharing allows remote users to view and optionally control the
desktop of the current user. The remote user needs to be sent an invitation, and
it is possible to create a password protected standing invitation. This is ideal for
tech support teams or administrators to gain access to users desktops in order
to troubleshoot or remedy a problem or guide a user through a procedure.

Remote desktop sharing involves two applications: Desktop Sharing (KDE re-
mote frame buffer, a VNC server) and Remote Desktop Connection (KDE re-
mote desktop connection; a VNC client.)

Desktop Sharing can be used by any user to create and manage invitations.
Invitations create a one time password that allows the recipient to connect to
your desktop. By default it is valid for only one successful connection, and
expires after one hour if not used.

Incoming connections are handled by the kinetd kded module. You can use
the command dcop kded kinetd services to see if it is running. Desktop
Sharing waits for connections on port 5900 by default. When an incoming con-
nection is made, a dialog will appear to ask for confirmation by the current
user.

28.2 KDE DIY - Building Your Own Tools

28.2.1 DCOP

Desktop COmmunication Protocol, DCOP, is a lightweight mechanism for inter-
process communication. DCOP allows the user to interact with programs that
are currently running. KDE supplies two programs to utilitize DCOP: dcop, a
command-line program, and kdcop, a GUI program.
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A few notes about using dcop:

• dcop [options] [application [object [function [arg1] [arg2] ... ] ] ]

• Applications that can open more than one window at a time will be listed as
<application>-PID

• All the arguments are case-sensitve. setFullScreen and setfullscreen are two
different functions.

• The regular expression token * can be used in the application and object ar-
guments.

% dcop kon*
konqueror -16006
konsole -8954

Some example commands and their output are below:

% dcop konsole*
konsole -8954

One Konsole is running with a PID of 8954.

% dcop konsole -8954
KBookmarkManager -.../share/apps/kfile/bookmarks.xml
KBookmarkManager -.../share/apps/konqueror/bookmarks.xml
KBookmarkNotifier
KDebug
MainApplication -Interface
konsole (default)
konsole -mainwindow#1
ksycoca
session -1
session -2
session -3
session -4

Here you see that there are four sessions running.

% dcop konsole -8954 konsole
QCStringList interfaces()
QCStringList functions()
int sessionCount()
QString currentSession()
QString newSession()
QString newSession(QString type)
QString sessionId(int position)
void activateSession(QString sessionId)
void nextSession()
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void prevSession()
void moveSessionLeft()
void moveSessionRight()
bool fullScreen()
void setFullScreen(bool on)
ASYNC reparseConfiguration()

Here are the options for the main Konsole program.

% dcop konsole -8954 session -1
QCStringList interfaces()
QCStringList functions()
bool closeSession()
bool sendSignal(int signal)
void clearHistory()
void renameSession(QString name)
QString sessionName()
int sessionPID()
QString schema()
void setSchema(QString schema)
QString encoding()
void setEncoding(QString encoding)
QString keytab()
void setKeytab(QString keyboard)
QSize size()
void setSize(QSize size)

Here are the options for the first session, session-1.

% dcop konsole -8954 konsole setFullScreen true

This sets Konsole to full screen.
When there is more than one application/object, which one should you use?
Got a reference?

% echo $KONSOLE_DCOP
DCOPRef(konsole -7547,konsole)

% dcop $KONSOLE_DCOP newSession
session -6

% dcopstart konsole
konsole -9058

#!/bin/sh
konsole=$(dcopstart konsole -script)
session=$(dcop $konsole konsole currentSession)
dcop $konsole $session renameSession Local
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session=$(dcop $konsole konsole newSession)
dcop $konsole $session renameSession Remote

session=$(dcop $konsole konsole newSession)
dcop $konsole $session renameSession Code
dcop $konsole $session sendSession ’cd /my/work/directory ’

28.2.2 KDialog

KDE DIY - Building Your Own Tools You can use KDE dialogs from your own
scripts, to combine the power of UNIX R© shell scripting with the ease of use of
KDE.

kdialog --msgbox ’You have new mail!’

kdialog --title ’New Mail ’ --msgbox ’You have new mail!’

The KDialog part can be replaced via --caption option

kdialog --title ’New Mail ’ --msgbox ’You have new mail!’ -- ←↩
dontagain myfile:mykey

Saves whether to show again in $KDEHOME/share/config/myfile (by writing
into this file the following lines:

[Notification Messages]
mykey=false

Instead of --msgbox you can also use --sorry and --error, as appropriate. For
instance, you might use kdialog --sorry ’The network can not be reache-
d’ or kdialog --error ’Mail box can not be opened’.

It is also possible to create message boxes that accept a yes or no answer.

kdialog --yesno ’Do you want to connect
to the Internet?’ echo $?

Return Value Meaning
0 Yes, OK, Continue
1 No
2 Cancel

Make sure to store the result in a variable if you do not use it directly, the next
command will fill $? with a new value You can use --dontagain here as well, it
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will remember the users choice and returns it the next times without showing
the dialog any more.

Further variations are:

--warningyesno like --yesno but with a different icon

--warningcontinuecancel With Continue and Cancel buttons.

--warningyesnocancel With Yes, No and Cancel button. For example:

kdialog --warningyesnocancel ’Do you want
to save the changes?’

kdialog --inputbox "Enter your name:" "YourName"

The result is printed to stdout, to put it in a variable you can use name=$(kdialog
--inputbox "Enter your name:" "YourName"). The last argument is optional,
it is used to pre-fill the dialog.

password=$(kdialog --password "Enter your password:")

The --dontagain option does not work with --inputbox or --password

There are two dialogs that let the user make a choice from a list:

--menu Lets the user select a single item from a list.

--checklist Lets the user select one or more items from a list.

city=$(kdialog --menu "Select a city" a London b Madrid c ←↩
Paris d Berlin)

$city will a, b, c or d.

city=$(kdialog --checklist "Select cities" a London off b ←↩
Madrid on c Paris on d Berlin off)

Madrid and Paris will be pre-selected. The result with Madrid and Paris se-
lected will be "b" "c".
If you add the --separate-output option, it will put b and c each on a line of
its own, making the result easier to process.

file=$(kdialog --getopenfilename $HOME)
file=$(kdialog --getopenfilename $HOME "*.png *.jpg|Image ←↩

Files")
file=$(kdialog --getsavefilename $HOME/SaveMe.png)
file=$(kdialog --getexistingdirectory $HOME)
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Chapter 29

Sharing data with Kontact via
IMAP

Marco Menardi

29.1 Introduction

For my small office, I was looking for a long time for a PIM solution that let
me share data, so my secretary and I can share contacts, appointments and so
on. Being a KDE user, I’ve heard about the Kroupware project and wait its
completion. But when I saw how complicated is the architecture and setup
of the Kolab server 1.0 (the server side of the project), I gave up, waiting for
an easier to deploy Kolab 2.0. In any case, the Kolab stuff was clearly too
much for my needs. Fortunately in the KDE wiki I’ve found some piece of IRC
conversation where they were talking about sharing data without the Kolab
infrastructure... mmm so interesting!

For small offices and needs, you can have Kontact use shared data without the
need of installing the Kolab server or another groupware backend. It can work
with just an IMAP server, that can be easily set up.

My scenario is a server with Debian unstable and KDE 3.4. I access Kontact
and other fabulous GNU/Linux apps from windows using Cygwin/X, while
waiting Wine project to be able to run the last Windows programs I need (and
that are not available under GNU/Linux). I want to share contacts, events,
todo, notes with my secretary.

29.2 What is IMAP

This definition is from the ComputerUser.com High-Tech Dictionary:
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Internet Message Access Protocol. A protocol that allows a user to
perform certain electronic mail functions on a remote server rather
than on a local computer. Through IMAP the user can create, delete,
or rename mailboxes; get new messages; delete messages; and per-
form search functions on mail. A separate protocol is required for
sending mail. Also called Internet Mail Access Protocol.

So it can be considered a data storage. To use it you you need an IMAP server,
such as Cyrus, Courier or UW.

29.3 Kolab or IMAP?

Kolab brings the ability to share data between different clients. It makes possi-
ble for your secretary to use Outlook and you use Kontact, for instance.

You will have a configuration interface which does user management, mail
account setup, a central LDAP config data and addressbook server, spam and
virus filtering, vacation scripts, free busy list handling, resource handling (rooms,
cars), groups, distribution lists, automatic invitation handling, etc.

But that can cause initial setup troubles. For a newbie like me it means: a long
long frustrating nightmare, and too much complexity to manage once working.
So no, thanks, I’ll go to simple IMAP.

29.4 How to set up IMAP server Cyrus

My choice is Cyrus, that is part of the Kolab set of software, so if l will go for
Kolab in the future, at least I’m acquainted with it.

Let’s start the installation and the setup!

Become root.

# apt -get install cyrus21 -imapd cyrus21 -common cyrus21 -admin ←↩
cyrus21 -client sasl -bin sasl2 -bin

Installing cyrus21 -imapd...The installer asks something I’ve ←↩
not understood about an search address... I just pressed ←↩
Enter.

The installer also created the user cyrus that is in the (automatically created)
group sasl, that is the ‘owner’ of all cyrus files. At the end with ps -A you can
find the new processes: cyrmaster and notifyd.

The real problem in setting up Cyrus is the authentication, just because it’s not
trivial and I’m a newbie, with limited knowledge about what I’m doing.

Cyrus can use different SASL (Simple Authentication and Security Layer) mech-
anisms, the default being sasldb (it stores usernames and passwords in the
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SASL secrets file sasldb), but also getpwent, kerberos4, kerberos5, PAM, rimap,
shadow and LDAP are supported.

Since I don’t want to define users/passwords different than the ones that access
my Linux R© box I choose then ‘shadow’ mechanism so Cyrus will use Linux R©
passwords for authenticate.

To do so we have to tell sasl to use saslauthd as password authentication
method, and then setup saslauthd to use ‘shadow’ (or ‘getpwent’) as the au-
thentication mechanism.
OK, let’s start!

As root, change the Linux password of cyrus user:

# passwd cyrus

Enter the password you like (and you will remember) we will use for this ex-
ample ‘cyrus’ as the cyrus administrator password.

# vi /etc/imapd.conf

sasl_pwcheck_method: saslauthd instead of the default auxprop

remove the # remark from the line:

#admins: cyrus

this way you can administer cyrus logging in as cyrus user (what a fantasy I
have!)

# vi /etc/default/saslauthd

Uncomment the line:

# START=yes

(otherwise the saslauthd will not start at boot time, even if referenced in some
/etc/rcx.d!)

and instead of MECHANISMS="pam" put MECHANISMS="shadow" this way at the
boot a saslauthd -a shadow will be executed.
Once exited from your editor, restart sasl and cyrus.

To test IMAP:

su cyrus
$ imtest -m login -p imap localhost

You are prompted for the cyrus (user) password, so enter it.

If the user cyrus is correctly authenticated, the following lines will appear:
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S: L01 OK User logged in
Authenticated.

To exit type . logout (i.e. dot space ‘logout’)

Now add a user named groupware and set a password for it, using your usual
system tools. It should be in an unprivileged group such as nobody and does
not require a login shell or a home directory.

Now I have to create the user and an IMAP in cyrus also:

# cyradm --user cyrus localhost
after entering the password for the admin user cyrus , you get ←↩

the prompt localhost >
localhost > cm user.groupware
localhost > lm lists the mailbox only just created
user.groupware (\HasNoChildren))
localhost > quit

You can type help for a list of available commands.

You can check what has happened with:

# ls -l /var/spool/cyrus/mail/g/user/groupware
total 12
-rw------- 1 cyrus mail 4 Oct 29 20:55 cyrus.cache
-rw------- 1 cyrus mail 155 Oct 29 20:55 cyrus.header
-rw------- 1 cyrus mail 76 Oct 29 20:55 cyrus.index

Now you should be able to connect with an IMAP client as the groupware user
and see the INBOX.

NOTE
In the IMAP protocol, selecting the mailbox INBOX is a magic word, a sort of ‘alias’
for the above directory structure. The client sees INBOX, and the IMAP server maps
it in the /var/spool/cyrus/mail/... folder and file structure.

29.5 How to setup Kontact clients

I connect to my GNU/Linux office server PC (a sort of "black box" without
monitor and keyboard) from 2 Windows R© 2000 PC with Cygwin/X, using
them as a X-Window server (in the near future I hope to replace both with
2 mini-itx thin clients using the LTSP). With this setup every user runs Kontact
on the same machine where Cyrus is installed and running (localhost).

To have Kontact work with IMAP, there are these steps to complete:
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1. Create an IMAP account on the Cyrus for fake groupware user (already
previously done!)

2. Create/configure an IMAP account in KMail for login as that user

3. Use kresources to make Kontact components work with data taken from
IMAP source

4. Enable groupware functionality and make related subfolders of that IMAP
INBOX (if not already)

5. Enjoy Kontact and shared data through Cyrus IMAP

So login to KDE with the first ‘real user’ account you want to provide group-
ware functionality to.

Let’s create the IMAP account in KMail.
Run Kontact and select Mail (the KMail component). From the menu choose
Settings→ Configure KMail +Accounts+Receiving tab, press the Add... but-
ton. You will then be prompted for the type of your email account, and select
disconnected IMAP (not just IMAP). Then in the General tab enter the follow-
ing data:

Account Name: office_gwdata A name that will be used for the ‘local’ folder
that points to this IMAP account.

Login: groupware The Cyrus user we have chosen as ‘owner’ of all of the office
data

Password: The password of the groupware user.

Host: localhost Remember for our example, the Kontact client runs on the
same computer as the IMAP server

Port: 143 The default

Check store IMAP password so you will not be asked for it next time you run
Kontact. Check the Enable interval mail checking and set a value in minutes.

Note that we have checked the disconnected IMAP type account. This has the
effect that a copy of the groupware data is stored ‘locally’ to the client (under
the home folder), and it is synchronized every time the client connects. This
seems very inefficient, since your data is duplicated many times (i.e. if you
have 10 users that use Kontact, you have 10+1 times the data), but it is the
only way to make things run fast, because at every connection Kontact has to
fetch all data and have KOrganizer and KAddressBook interpret it. If you use
‘disconnected IMAP’ data is cached locally, and only the ‘delta’ (i.e. the data
that has changed) is sent.

On the other end, if your users run KOrganizer on the same PC that runs the
IMAP server, it seems reasonable to use IMAP (that is called ‘online IMAP’) to
save space, since transfer speed should not be an issue. But unfortunately this
does not work because Kontact does not update automatically the Calendar
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folder in ‘online IMAP’, so you are not updated when someone adds events
(you must manually switch to KMail application and click on the Calendar
folder). In addition, at start up when it does read Calendar folders, you may
see a tremendous flicker and slow data updates.

Now we have to tell Kontact to use IMAP as the data source for its vari-
ous components. From the K menu, choose Run command, run kcmshell4
kresources. In the combo box select Contacts, then press the Add... button,
and choose Addressbook on IMAP Server via KMail. Then select that new line
and press Use as Standard button. Do the same for Calendar and Notes.

Now we have to enable the KMail (and as a consequence, the whole Kontact)
groupware functionality:

1. Choose from the menu Settings→ Configure KMail+Misc+Groupware

2. Check Enable IMAP resource functionality

3. Choose English as Language of the groupware folders (this is in case you
already have the folders in the IMAP server created by a different pro-
gram in a different language).

4. Now move to Resource folder are in account and select the Inbox sub-
folder of the office_gwdata folder.Leave Hide groupware folders unchecked
for now, so we can see that happens. You can return here and check it
once everything is clear.

5. When you press OK you are prompted with: KMail will now create t-
he required folders for the IMAP resource as subfolders of Inb-
ox If you do not want this, press No, and the IMAP resource will be
disabled. Press Yes (this happens only the first time with the first ‘real
user’). You will immediately see that in the KMail folder tree, under of-

fice_gwdata+Inbox these subfolders are created:

Calendar
Contacts
Notes
Tasks
Journal

if you now do a:

# ls -l /var/spool/cyrus/mail/g/user/groupware/
drwx ------ 2 cyrus mail 144 Oct 31 16:36 Calendar
drwx ------ 2 cyrus mail 144 Oct 31 16:36 Contacts
drwx ------ 2 cyrus mail 144 Oct 31 16:36 Journal
drwx ------ 2 cyrus mail 144 Oct 31 16:36 Notes
drwx ------ 2 cyrus mail 144 Oct 31 16:36 Tasks
-rw------- 1 cyrus mail 4 Oct 31 15:28 cyrus.cache
-rw------- 1 cyrus mail 155 Oct 29 20:55 cyrus.header
-rw------- 1 cyrus mail 76 Oct 31 15:28 cyrus.index

As you see, the office_gwdata Inbox is stored not local to the Kontact
current user home, but in the IMAP groupware user’s folders.
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Now Kontact is ready to work and store data there. In the calendar applica-
tion, if KMail IMAP account was of type ‘disconnected’, the resource window
should display the item Imap resource with 3 subitems, that are paths to local
home files. Instead, the Contacts application does not show subitems below
the Imap resource.

You can now login to KDE with a different username and set up his/her Kon-
tact client in a very similar manner:

1. Open Kontact and in the Mail component add an IMAP account speci-
fying as host the computer where Cyrus server runs (in my case: 192.-
168.1.3).Remember to check the Enable interval mail checking and set
a value in minutes. When you confirm, you are not prompted for the
subfolder creation (since they are found in the IMAP server), and you see
them in the folder tree.

2. Activate the groupware functionality to be able to save data in the IMAP
server.

Beware that in ‘disconnected IMAP’, data are transmitted from a client to IMAP
server only when the clients connects to check for new mail. So if you have
your Kontact clients with an interval mail checking of, for instance, 5 minutes,
in the worst case you have a 10 minutes delay between the event being written
and its appearance to the other users.

29.6 How to have Read Only Access

NOTE
Beware that I’ve been confirmed that Notes IMAP implementation in Kontact prior
to version 1.01 is broken, so this setup will not work for them, so you want to use
them, you need to use the previous setup.

In the previous setup, we have the same ‘fake’ user, named groupware, that is
used by all the ‘real’ Kontact users (i.e. tony, rohn, amanda, etc.) through the
IMAP account with its login and password. But this way every real user has
the same read/write permissions of the others, since everyone connects as the
user groupware to the IMAP server.

To limit access to some users (typically, providing read-only access), we can
use the ACL (Access Control Lists).

Select in KMail a subfolder of office_gwdata inbox, for instance Calendar, and
right click the mouse. Select PropertiesAccess Control tab. Here you can enter
the users you want give access to this folder and what they can do.

Just to experiment trying to exchange events, we give ‘All’ permission to the
user mary
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At cyrus level (in the PC that runs IMAP server cyrus, with cyrus tools), we
first need to add the user mary, so it’s an IMAP recognized user, and create an
IMAP folder for her.
Then we login to GNU/Linux as mary and enter Kontact. As previously shown,
we will setup an IMAP account in KMail with the same data but the one of the
user (instead of the fake user groupware and its password, we will use mary
and her password).

In KMail folder tree, this time you will see this structure: office_gwdata→ user
→ groupware→ Calendar and Tasks. Check the mail (File→ Check Mail) and
you will also have an ‘inbox’ folder under ‘office_gwdata’.

Now enable KMail groupware functionality, and in Resource folders are sub-
folders of put the inbox that is subfolder of office_gwdata.

Now you have two branches of folder under ‘office_gwdata’:

1. ‘inbox’ with Calendar, Contacts, Notes, Tasks and Journal, that are saved
on mary IMAP folders on the IMAP server

2. ‘user’, with the subfolder ‘groupware’ and the subfolders to which mary
has access to (in this example, Calendar and Tasks)

right mouse button click on the ‘user’ ‘Calendar’ and check if it’s of type Cal-
endar (if not, set it to be), and also if ‘user’‘Tasks’ is of type Tasks.

Now in Calendar you have two available IMAP resources to write against, so
if you create a new event, you are prompted which one use (or if you left the
local resources available, you have 3!).

You have go to the lower left small window in Calendar, the one that shows
available resources, and uncheck the ones that don’t point to .groupware.directory
path (see the tail part of each resource path).

29.7 Credits

I’m a newbie, and for this howto I’ve only provided my time and my will. For
the knowledge I have really to thank some guys in freenode channels for their
competence, patience and helpfulness.

SPECIAL THANKS TO:

• For the Cyrus IMAP part in #cyrus channel:

– [protagonist] Andy Morgan morgan@orst.edu
– [plixed] Okke Timm okke.timm@web.de

• For the Kontact part in #kontact channel:

– [till] Till Adam adam@kde.org
– [dfaure] David Faure faure@kde.org
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– [mdouhan] Matt Douhan matt@fruitsalad.org

Thank a lot guys!

Ah, and there is also me, [markit] Marco Menardi mmenaz@mail.com

29.8 Further Reading

REFERENCE

• KDE: http://www.kde.org

• Kontact website: http://www.kontact.org

• Kroupware project: http://www.kroupware.org

• KDE Community Wiki: http://wiki.kde.org

• Wine project: http://www.winehq.org

• Cygwin/X project http://x.cygwin.com

• LTSP project: http://www.ltsp.org
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Part VII

More Tools
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Chapter 30

Application Guide for
Migrates

Francis Giannaros KDE has many applications, often prefixed with (or con-
taining) the letter k. The names are generally self-explanatory, but it can still be
difficult sometimes to find the appropriate packages. Migrates from operating
systems such as Microsoft Windows R© or Apple Macintosh R©might have some
difficulty in locating an application for a particular job. Below is a table with
an expansion on the K menu and the respective Win/Mac equivalent.

RELATED INFORMATION

• Many more KDE applications are available from the KDE extragear (see
chapter 7 for more information) or from http://kde-apps.org.

• Reference: http://kudos.berlios.de/kf/kf1.html#pkgtablestock
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K menu Location KDE Ap-
plication

Window-
s R©
Equival-
ent

Macinto-
sh R©
Equival-
ent

Notes

File Manager
Konquer-
or (Home

Folder)

Windows
Explorer

Integrate-
d file

manager,
content

viewer/-
player

and web
browser

System and User
Settings KControl Control

Center

Office

Office
Suite:

1. W-
ord
Pr-
oce-
ssi-
ng

2. Sp-
rea-
ds-
he-
ets

3. Sli-
de
Pre-
sen-
tati-
ons

4. Flo-
wc-
hart
&
Di-
agr-
am
Edi-
ting

5. Sca-
lab-
le
Gr-
ap-
hics

6. Im-
age
Ma-
nip-
ula-
tion

7. Re-
po-
rt
Ge-
ner-
ator

8. Ch-
art

9. Da-
tab-
ase
Cr-
eat-
ion

10. For-
mu-
la
Edi-
tor

1. K-
W-
ord

2. KS-
pre-
ad

3. KP-
res-
ent-
er

4. Ki-
vio

5. Ka-
rbo-
n14

6. Kri-
ta

7. Ku-
gar

8. KC-
hart

9. Ke-
xi

10. KF-
or-
mu-
la

1. MS
W-
ord

2. MS
Ex-
cel

3. MS
Po-
we-
rp-
oint

4. Ad-
obe
Ill-
ust-
rat-
or

5. Ad-
obe
Ph-
oto-
sh-
op

6. Re-
po-
rt
Ge-
ner-
ator

7. Ch-
art

8. MS
Ac-
cess

Personal
Informat-
ion
Manage-
ment:

1. Ma-
il

2. Ad-
dre-
ss
Bo-
ok

3. Per-
so-
nal
Or-
ga-
niz-
er

4. Ne-
ws
Re-
ad-
er

5. Po-
p--
up
No-
tes

6. RSS
Re-
ad-
er

1. K-
Ma-
il

2. KA-
dd-
res-
sB-
ook

3. KO-
rga-
niz-
er

4. K-
No-
de

5. K-
No-
tes

6. Ak-
reg-
ator

MS
Outlook

The
Personal
Informat-
ion
Manager
is
Kontact;
all other
KDE PIM
applicati-
ons
integrate
into it.

Internet

Web
Browser

Konquer-
or

MS
Internet
Explorer

Safari

Integrate-
d file
manager,
web
browser,
FTP
manager,
and
univerval
viewing
applicati-
on.

Instant
Messagi-
ng

Kopete

• AIM

• MSN

• ICQ

• Jabber

• Novell
Group-
Wise

• Yahoo

• IRC

• SMS

MSN Me-
ssenger

Compre-
hensive
multi-ne-
twork
compati-
ble
instant
messagi-
ng
software

Chat
(IRC) KSirc mIRC

Multime-
dia

Music/-
Audio JuK

Window-
s R©
Media
Player

CD/DV-
D
Burner

K3b Nero

Video
Player Noatun

Window-
s R©
Media
Player

Audio
CD
Ripper

KAudio-
Creator

Sound
Controls KMix

System

System
Info
Center

KInfoCe-
nter

Terminal Konsole CMD
User
Manager KUser User

Manager

Package
Manager

KPackag-
e

Add/Re-
move
Programs

Utilities
Archiver Ark WinZip
Password
Manager KWallet

Text
Editor Kate Notepad

Table 30.2: Sample Table
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Chapter 31

Dictionary for Migrators

Tables of terminology differences
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Chapter 32

The Standard Menu Entries

Philip Rodrigues One of the main ways that you’ll control programs in KDE
is via the program’s menus. They provide access to nearly everything you’ll
need to do with that program. So that you can more easily remember where
things are in the menus, and to help you learn new programs more easily, the
menus have a standard layout. This means that once you know how to open a
file in one program, you know how to open a file in any KDE program. Let’s
take a look at the standard menus:
THE FILE MENU

New (Ctrl+N) This entry will start a new, blank document that’s appropriate
to the program you’re using. For example, in Kate (the KDE Advanced
Text Editor) this entry creates a new text file.

Open... (Ctrl+O) The Open... menu entry displays the KDE ‘Open File’ dialog
box, where you can choose a file to open in the program you’re using.
The ‘Open File’ dialog is also standardized, so it’s the same for all KDE
programs. You can find out more about using this dialog somewhere else
in this guide .
You probably noticed that this menu entry had an ellipsis (...) after the
name of the entry. This means that clicking on the entry will open a di-
alog box of some kind. If you make any changes in the dialog box that
appears, they won’t take effect until you click on the OK button in the di-
alog. You can always ignore any changes you made, and close the dialog,
by clicking on the Cancel button.

Save (Ctrl+S) This menu entry will save any changes you’ve made to the file
that you are currently working on. If this is the first time that you’ve
saved the file, the KDE ‘Save File’ dialog will appear, and ask you for a
name and location for the file.

Save As... The Save As... menu entry will save the file you’re working on with
a different name. The ‘Save File’ dialog appears, and you can choose a
name and location as usual. Note that after you save the file with Save

177



The KDE User Guide

As.., you will be working on the new file. If you save changes, they will
be saved under the new filename. To make this a bit clearer, let’s take an
example:

1. You are working on a file called hello.txt that contains the text
‘Hello World!’

2. You use the Save As... menu entry to save the file with the new name
newhello.txt.

3. You add the text ‘Nice to see you!’ to the file, and use the Save menu
entry to save these changes.

Now, the file newhello.txt contains the text ‘Hello World! Nice to see
you!’, while the file hello.txt contains only the text ‘Hello World!’.

Print... (Ctrl+P) This menu entry displays the KDE ‘Print’ dialog, ready to
print the current document. You can find more information about the
options available in this dialog in Section 11.2.

Close (Ctrl+W) This menu entry closes the current document. If you have
made any changes since you last saved the document, you will be asked
whether you want to save those changes. You can choose to Save or Dis-
card those changes. If you didn’t really want to close the file, just click
Cancel.

Quit (Ctrl+Q) Use this entry to close the program you’re using. If you have
unsaved changes in any files, you will be asked whether you want to save
them.

THE EDIT MENU

Undo (Ctrl+Z) Use this entry to remove the effect of the last action you per-
formed in the application. For example, if you deleted a line of text, the
Undo menu entry will replace that line.

Redo (Ctrl+Shift+Z) Use this menu entry to perform the last action that you
removed with the Undo menu entry. For example, if, as in the example
above, you had replaced a deleted line of text with Undo, the Redo entry
would redo the action of deleting the line.

Cut (Ctrl+X) This menu entry cuts the contents of the current selection to the
clipboard. See Section 3.4 for more information.

Copy (Ctrl+C) This menu entry copies the contents of the current selection to
the clipboard. See Section 3.4 for more information.

Paste (Ctrl+V) This menu entry inserts the contents of the clipboard in the
current document. The clipboard contents are inserted where the cursor
is currently positioned.

Select All (Ctrl+A) Use this item to select the whole of the current document.

Find... (Ctrl+F) This menu entry displays the Find Text dialog, which you can
use to search for a particular word or phrase in the current document.
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Find Next (F3) Use this item to find the next occurrence of the most recent text
you searched for using Find....

THE SETTINGS MENU

Configure Shortcuts... In the dialog displayed by this menu entry, you can
change the keyboard shortcuts used by the application. See Section 4.4.2.

Configure Toolbars... In the dialog displayed by this menu entry, you can change
which buttons appear on the application’s toolbars. See Section 4.4.4.

Configure Notifications... In the dialog displayed by this menu entry, you can
change the notifications (sounds, error messages, etc.) used by the appli-
cation. See Section 4.4.3.

Configure Application In the dialog displayed by this menu entry, you can
change settings relating to how the application works in general.

Help→ KApp Handbook (F1) Invokes the KDE Help system starting at the
KApp help pages. (this document).

Help→What’s This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KApp will open a
help window (if one exists for the particular item) explaining the item’s
function.

Help→ Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help→ Switch Application Language... Opens a dialog where you can edit
the Primary language and Fallback language for this application.

Help→About KApp This will display version and author information.

Help→About KDE This displays the KDE version and other basic informa-
tion.
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Chapter 33

Glossary of Terms

KDE/GUI/UNIX terms that are worth explaining.
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Chapter 34

Troubleshooting Problems

Problems that aren’t
Frozen apps (how to kill them)

Things won’t open

That scary crash dialog

Reporting Bugs

More Resources

34.1 Networking and X

Misconfigured networking can often be the cause of KDE applications launch-
ing slowly, or in the worst case not launching at all. Your X-Server has a very
powerful client/server interface and is very network aware.

X uses the hostname to create both a unique key for authorization, and to figure
out where (via $DISPLAY) to send the actual windows it’s drawing on screen. If
your computer doesn’t know its own name, it will spend inordinate amounts
of time trying to look itself up, a fate you can avoid by simply teaching your
computer what its own name is.

Check your /etc/hosts file and ensure there is an entry for localhost that looks
something like this at the top of the file (after any comments).

127.0.0.1 localhost

You also should add your computer’s fully qualified domain name, short name,
and its usual IP address if it has a static IP. If your IP address is assigned dy-
namically using DHCP you can simply use the address for the loopback device.

181



The KDE User Guide

127.0.0.1 hal.btl hal (for dhcp)
192.168.0.1 hal.btl hal (static)

Make sure that your firewall is not so restrictive that it stops packets to the
loopback device. For example in iptables if the default rule on the INPUT chain
for this device is set to anything other than >ACCEPT this will cause perfor-
mance problems in X. To check this, you can type in:

%iptables -save | grep lo
-A INPUT -i lo -j ACCEPT

The rule -A INPUT -i lo -j ACCEPT should always work, unless there are
other misconfigured rules (Such as a DROP on the OUTPUT chain)

34.2 When An Application Will Not Open

Sometimes when you start an application, it does not open the expected win-
dow. Here are some questions to answer and steps to help you figure out what
is wrong.

Did the application ever start, when launched in the same manner? If it did,
for instance you have clicked an icon on your desktop that previously
worked, then it is unlikely to be a problem with the launcher itself.
If, however, you normally start your application from an icon on Kicker
and this time started it with a desktop icon, then it could simply be that
the launcher itself is wrong.

But I can see the launch notification spinning cursor and taskbar entry. Foo
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Chapter 35

Contributing to KDE

Some basic information to get encourage people to contribute to KDE, infor-
mation about what’s available, and how to get started.
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Appendix B

Index

A
Accessibility, 86
AltF4, 14
AltTab, 11, 13
Applets, 25
aRts, 57
Audio, 57

B
Background, 6

C
Clipboard, 26

History, 27
Closing Windows, 14
Configuration, 31, 36
Copying Files, 23
Customization, 31, 36
Cut, 26

D
Desktop, 6

E
Email

getting started, 106
IMAP server, 106
POP3 server, 106
sending, 107
SMTP server, 106
testing, 108

F
File Management, 18
File sharing, 67
Focus (windows), 11
Fonts, 71

installing, 72
previewing, 72

G
gg:, 109

H
Hiding Windows, 13

I
icandy for KDE, 10
Internet Shortcuts, 109

J
JuK, 58

K
Kaboodle, 59
KControl, 36
KDE Control Center, 36
KDE News Resource, 10
KDE User Mailing List, 9
KDE wiki, 10
kde-linux Mailing List, 9
kdm, 7
Keybindings, 32
KHelpCenter, 8
Kicker, 24
Klipper, 27
KMail, 106
Konqueror

File Management, 18
Handbook, 18

L
login, 7
logout, 7

M
Magnifier, 87
Mailing Lists, 9
Maximizing Windows, 13
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Horizontally, 13
Vertically, 13

Minimize, 13
Mouse

clicking automatically, 86
Moving Files, 23
Moving Windows, 11
Multiple Desktops, 17
Music, 57

N
Navigation Panel, 21
Noatun, 58
Notifications, 32

P
Pager, 25
Panel, 7, 24
Paste, 26
Previews, 19

R
Raising Windows, 11
Recycle Bin, 23
Resizing Windows, 12

S
Selection, 26
Shade, 13
Shared Folders, 67
Shortcuts, 32
Sidebar, 21
Sound, 57
Sounds, 32
Speech, 88
startkde, 7
startx, 7
Sticky Windows, 18

T
Tooltips, 8
Trash, 23

U
User Manual, 8

Handbook, 8

V
Virtual Desktops, 17

W
Wallpaper, 6
Web shortcuts, 109
What’s This?, 9
Window Management, 10
Window Menu, 12
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